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Preface
Notice
The company reserves the right to revise this publication or to change its contents without notice. Information
contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or
any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear
in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse)
of this publication.
This publication and any accompanying software may not, in whole or in part, be reproduced, translated, trans-
mitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators
of this publication, except for copies kept by the user for backup purposes.
Brand and product names mentioned in this publication may or may not be copyrights and/or registered trade-
marks of their respective companies. They are mentioned for identification purposes only and are not intended
as an endorsement of that product or its manufacturer.
©July 2015

Trademarks

Intel and Intel Core are trademarks/registered trademarks of Intel Corporation.
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R&TTE Directive
This device is in compliance with the essential requirements and other relevant provisions of the R&TTE Direc-
tive 1999/5/EC.

This device will be sold in the following EEA countries: Austria, Italy, Belgium, Liechtenstein, Denmark, Lux-
embourg, Finland, Netherlands, France, Norway, Germany, Portugal, Greece, Spain, Iceland, Sweden, Ireland,
United Kingdom, Cyprus, Czech Republic, Estonia, Hungary, Latvia, Lithuania, Malta, Slovakia, Poland, Slov-
enia.

ErP Off Mode Power Consumption Statement:
The figures below note the power consumption of this computer in compliance with European Commission (EC)
regulations on power consumption in off mode:

• Off Mode < 0.5W
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CE Marking
This device has been tested to and conforms to the regulatory requirements of the European Union and has at-
tained CE Marking. The CE Mark is a conformity marking consisting of the letters “CE”. The CE Mark applies
to products regulated by certain European health, safety and environmental protection legislation. The CE Mark
is obligatory for products it applies to: the manufacturer affixes the marking in order to be allowed to sell his
product in the European market.

This product conforms to the essential requirements of the R&TTE directive 1999/5/EC in order to attain CE
Marking. A notified body has determined that this device has properly demonstrated that the requirements of the
directive have been met and has issued a favorable certificate of expert opinion. As such the device will bear the
notified body number 0560 after the CE mark.

The CE Marking is not a quality mark. Foremost, it refers to the safety rather than to the quality of a product.
Secondly, CE Marking is mandatory for the product it applies to, whereas most quality markings are voluntary.
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FCC Statement
(Federal Communications Commission)
You are cautioned that changes or modifications not expressly approved by the party responsible for compliance
could void the user's authority to operate the equipment.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in
a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not in-
stalled and used in accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning the equipment
off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

• Re orient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the service representative or an experienced radio/TV technician for help.

Operation is subject to the following two conditions:

1. This device may not cause interference.

And

2. This device must accept any interference, including interference that may cause undesired operation of the 
device.
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FCC RF Radiation Exposure Statement:

1. This Transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

2. This equipment complies with FCC RF radiation exposure limits set forth for an uncontrolled environment. This 
equipment should be installed and operated with a minimum distance of 20 centimeters between the radiator 
and your body.


Warning

Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not ex-
pressly approved by the manufacturer for compliance with the above standards could void your authority to operate the
equipment.
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IMPORTANT SAFETY INSTRUCTIONS
Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and injury
to persons when using any electrical equipment:

1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet 
basement or near a swimming pool.

2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There 
may be a remote risk of electrical shock from lightning.

3. Do not use the telephone to report a gas leak in the vicinity of the leak.
4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may 

explode. Check with local codes for possible special disposal instructions.
5. This product is intended to be supplied by a Listed Power Unit:

For Model A - Design II and Model B Designs I & II Computers:
• Full Range AC/DC Adapter - AC Input 100 - 240V, 50 - 60Hz, DC Output 19.5V, 9.23A or 19V, 9.5A (180W) mini-

mum.

For Model A - Design I & V Computers:
• Full Range AC/DC Adapter - AC Input 100 - 240V, 50 - 60Hz, DC Output 19.5V, 9.23A or 19V, 9.5A (180W) mini-

mum.
OR
• Full Range AC/DC Adapter - AC in 100 - 240V, 50 - 60Hz, DC Output 19.5V, 7.7A (150W) minimum.

For Model A Design III & IV Computers and Model B - Design III Computers:
• Full Range AC/DC Adapter - AC in 100 - 240V, 50 - 60Hz, DC Output 19.5V, 7.7A (150W) minimum.
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Instructions for Care and Operation
The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:

1. Don’t drop it, or expose it to shock. If the computer falls, the case and the components could be damaged.

2. Keep it dry, and don’t overheat it. Keep the computer and power supply away from any kind of heating ele-
ment. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly dam-
aged.

Do not expose the computer 
to any shock or vibration.

Do not place it on an unstable 
surface.

Do not place anything heavy 
on the computer.

Do not expose it to excessive 
heat or direct sunlight.

Do not leave it in a place where 
foreign matter or moisture may 

affect the system.

Don’t use or store the computer 
in a humid environment.

Do not place the computer on 
any surface that will block the 

Vents/Fan Intakes.
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3. Avoid interference. Keep the computer away from high capacity transformers, electric motors, and other 
strong magnetic fields. These can hinder proper performance and damage your data.

4. Follow the proper working procedures for the computer. Shut the computer down properly and don’t forget 
to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.

5. Take care when using peripheral devices.

Do not turn off the power until 
you properly shut down all pro-
grams.

Do not turn off any peripheral 
devices when the computer is 
on.

Do not disassemble the com-
puter by yourself.

Perform routine maintenance 
on your computer.

Use only approved brands of 
peripherals.

Unplug the power cord before 
attaching peripheral devices.
VIII
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Servicing
Do not attempt to service the computer yourself. Doing so may violate your warranty and may expose you and
the computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from
the power supply. Then refer servicing to qualified service personnel under any of the following conditions:

• When the power cord or AC/DC adapter is damaged or frayed.
• If the computer has been exposed to rain or other liquids.
• If the computer does not work normally when you follow the operating instructions.
• If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
• If there is an unusual odor, heat or smoke coming from your computer.


Bottom Cover Removal Warning

Users should not remove any cover(s) and /or screw(s) for the purposes of device upgrade as this may violate the terms of
your warranty. If you need to replace/remove the hard disk/RAM/optical device etc., for any reason, please contact your dis-
tributor/supplier for further information.

Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and
screw(s) before restoring power to the system.

Also note the following when the cover is removed:

• Hazardous moving parts.
• Keep away from moving fan blades.
IX
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Power Safety
The computer has specific power requirements:

• Only use a power adapter approved for use with this computer.
• Your AC/DC adapter may be designed for international travel but it still requires a 

steady, uninterrupted power supply. If you are unsure of your local power specifica-
tions, consult your service representative or local power company.

• The power adapter may have either a 2-prong or a 3-prong grounded plug. The third 
prong is an important safety feature; do not defeat its purpose. If you do not have access 
to a compatible outlet, have a qualified electrician install one.

• When you want to unplug the power cord, be sure to disconnect it by the plug head, not 
by its wire.

• Make sure the socket and any extension cord(s) you use can support the total current 
load of all the connected devices.

• Before cleaning the computer, make sure it is disconnected from any external power 
supplies (i.e. AC/DC adapter or car adapter).

Do not plug in the power 
cord if you are wet.

Do not use the power cord if 
it is broken.

Do not place heavy objects 
on the power cord.


Power Safety Warning 

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and disconnect-
ed all peripherals and
cables (including tele-
phone lines and power
cord). 

You must also remove
your battery in order to
prevent accidentally
turning the machine on.
Before removing the
battery disconnect the
AC/DC adapter from
the computer.
X
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Polymer Battery Precautions
Note the following information which is specific to polymer batteries only, and where applicable, this overrides
the general battery precaution information overleaf.

• Polymer batteries may experience a slight expansion or swelling, however this is part of the battery’s safety mecha-
nism and is not a cause for concern.

• Use proper handling procedures when using polymer batteries. Do not use polymer batteries in high ambient tempera-
ture environments, and do not store unused batteries for extended periods.

See also the general battery precautionary information overleaf for further information.
XI
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General Battery Precautions
• Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.
• Do not remove any batteries from the computer while it is powered on.
• Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even 

if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly 
result in fire.

• If you do not use the battery for an extended period, then remove the battery from the computer for storage.
• Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.
• Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qual-

ified service personnel.
• Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries 

may explode or leak if exposed to fire, or improperly handled or discarded.
• Keep the battery away from metal appliances.
• Affix tape to the battery contacts before disposing of the battery.
• Do not touch the battery contacts with your hands or metal objects.


Battery Disposal & Caution

The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life,
under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with
your local solid waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the
manufacturer. Discard used battery according to the manufacturer’s instructions.
XII
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Cleaning
Do not apply cleaner directly to the computer; use a soft clean cloth. 
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Cleaning Instructions
(For Computer Models Supplied with Light Blue Cleaning Cloth)
Some computer models in this series come supplied with a light blue cleaning cloth. To clean the computer case
with this cloth follow the instructions below:

1. Power off the computer and peripherals.
2. Disconnect the AC/DC adapter from the computer.
3. Use a little water to dampen the cloth slightly.
4. Clean the computer case with the cloth.
5. Dry the computer with a dry cloth, or allow it time to dry before turning on.
6. Reconnect the AC/DC adapter and turn the computer on.
XIII
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Travel Considerations
As you get ready for your trip, run through this list to make sure the system is ready to go:

1. Check that the battery pack and any spares are fully charged.
2. Power off the computer and peripherals.
3. Close the display panel and make sure it’s latched.
4. Disconnect the AC/DC adapter and cables. Stow them in the carrying bag. 
5. The AC/DC adapter uses voltages from 100 to 240 volts so you won’t need a second voltage adapter. However, 

check with your travel agent to see if you need any socket adapters.
6. Put the notebook in its carrying bag and secure it with the bag’s straps.
7. If you’re taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters 

and/or cables.
8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both hard-

ware and software. Make sure your “papers” are handy.


Power Off Before Traveling

Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a
notebook which is powered on in a travel bag may cause the Vents/Fan Intakes to be blocked. To prevent your computer
from overheating make sure nothing blocks the Vent/Fan Intakes while the computer is in use.
XIV
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Packing
As you get ready for your trip, run through this list to make sure the system is ready to go:

1. Check that the battery pack and any spares are fully charged.
2. Power off the computer and peripherals.
3. Close the display panel and make sure it’s latched.
4. Disconnect the AC/DC adapter and cables. Stow them in the carrying bag. 
5. The AC/DC adapter uses voltages from 100 to 240 volts so you won’t need a second voltage adapter. However, 

check with your travel agent to see if you need any socket adapters.
6. Put the notebook in its carrying bag and secure it with the bag’s straps.
7. If you’re taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters 

and/or cables.
8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both 

hardware and software. Make sure your documents are prepared.


Power Off Before Traveling

Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a
notebook which is powered on in a travel bag may cause the vent(s)/fan intake(s)/outlet(s) to be blocked. To prevent your
computer from overheating make sure nothing blocks the vent(s)/fan intake(s)/outlet(s) while the computer is in use.
XV
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On the Road
In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting,
keep these points in mind:

Hand-carry the notebook - For security, don’t let it out of your sight. In some areas, computer theft is very
common. Don’t check it with “normal” luggage. Baggage handlers may not be sufficiently careful. Avoid knock-
ing the computer against hard objects.

Beware of Electromagnetic fields - Devices such as metal detectors & X-ray machines can damage the com-
puter, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and
disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). Note:
Some airports also scan luggage with these devices.

Fly safely - Most airlines have regulations about the use of computers and other electronic devices in flight.
These restrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make
sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

Get power where you can - If an electrical outlet is available, use the AC/DC adapter and keep your battery(ies)
charged.

Keep it dry - If you move quickly from a cold to a warm location, water vapor can condense inside the computer.
Wait a few minutes before turning it on so that any moisture can evaporate.
XVI
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Developing Good Work Habits
Developing good work habits is important if you need to work in front of the computer for long periods of time.
Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or
other joints. The following are some tips to reduce the strain:

• Adjust the height of the chair and/or desk so that the keyboard is at or slightly below the 
level of your elbow. Keep your forearms, wrists, and hands in a relaxed position.

• Your knees should be slightly higher than your hips. Place your feet flat on the floor or on 
a footrest if necessary.

• Use a chair with a back and adjust it to support your lower back comfortably.
• Sit straight so that your knees, hips and elbows form approximately 90-degree angles 

when you are working.
• Take periodic breaks if you are using the computer for long periods of time.

Remember to:
• Alter your posture frequently.
• Stretch and exercise your body several times a day.
• Take periodic breaks when you work at the computer for long periods of time. Frequent 

and short breaks are better than fewer and longer breaks.
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Lighting
Proper lighting and a comfortable viewing angle can reduce eye strain and shoulder and neck muscle fatigue.

• Position the display to avoid glare or reflections from overhead lighting or outside sources of light.
• Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
• Position the display directly in front of you at a comfortable viewing distance.
• Adjust the display-viewing angle to find the best position.

LCD Screen Care
To prevent image persistence on LCD monitors (caused by the continuous display of graphics on the screen for
an extended period of time) take the following precautions:

• Set the Windows Power Plans to turn the screen off after a few minutes of screen idle time.
• Use a rotating, moving or blank screen saver (this prevents an image from being displayed too long).
• Rotate desktop background images every few days.
• Turn the monitor off when the system is not in use.

LCD Electro-Plated Logos
Note that in computers featuring a raised LCD electro-plated logo, the logo is covered by a protective adhesive.
Due to general wear and tear, this adhesive may deteriorate over time and the exposed logo may develop sharp
edges. Be careful when handling the computer in this case, and avoid touching the raised LCD electro-plated
logo. Avoid placing any other items in the carrying bag which may rub against the top of the computer during
transport. If any such wear and tear develops contact your distributor/supplier.
XVIII



Preface
Contents
Notice .............................................................................................................................................................I
ErP Off Mode Power Consumption Statement: ........................................................................................... II
FCC Statement ............................................................................................................................................IV
FCC RF Radiation Exposure Statement: .....................................................................................................V
Instructions for Care and Operation ......................................................................................................... VII
Servicing .....................................................................................................................................................IX
Power Safety ................................................................................................................................................X
Polymer Battery Precautions ......................................................................................................................XI
General Battery Precautions ..................................................................................................................... XII
Cleaning ...................................................................................................................................................XIII
Cleaning Instructions ...............................................................................................................................XIII
Travel Considerations ..............................................................................................................................XIV

Quick Start Guide
Overview ....................................................................................................................................................1-1
Advanced Users .........................................................................................................................................1-2
Beginners and Not-So-Advanced Users ....................................................................................................1-2
Warning Boxes ..........................................................................................................................................1-2
Not Included ..............................................................................................................................................1-3
System Software ........................................................................................................................................1-4
System Startup ...........................................................................................................................................1-5
XIX



Preface
Model Differences .....................................................................................................................................1-6
LCD Panel Open - Model A ......................................................................................................................1-8
LCD Panel Open - Model A - Designs IV & V .........................................................................................1-9
LCD Panel Open - Model B ....................................................................................................................1-10
LED Indicators .........................................................................................................................................1-11
Illuminated LED Keyboard .....................................................................................................................1-12
Control Center .........................................................................................................................................1-13
Flexikey® Application ............................................................................................................................1-14
Flexikey® Application Features: .............................................................................................................1-15
Keyboard Shortcuts .................................................................................................................................1-16
Function Keys & Visual Indicators .........................................................................................................1-17
Front & Rear Views - Model A ...............................................................................................................1-18
Front & Rear Views - Model B ...............................................................................................................1-19
Right View - Model A .............................................................................................................................1-20
Right View - Model B .............................................................................................................................1-22
Left View - Model A ...............................................................................................................................1-23
Left View - Model B ................................................................................................................................1-24
Bottom View - Model A - Design I .........................................................................................................1-25
Bottom View - Model A - Design II & Design III ..................................................................................1-26
Bottom View - Model A - Design IV & Design V ..................................................................................1-27
Bottom View - Model B ..........................................................................................................................1-28
Windows 8.1 Control Panel .....................................................................................................................1-29
XX



Preface
Windows 8.1 Start Screen & Desktop .....................................................................................................1-32
Apps & Tiles ............................................................................................................................................1-33
Desktop Application ................................................................................................................................1-34
The Charms Bar .......................................................................................................................................1-35
Windows 8.1 Taskbar ..............................................................................................................................1-37
Video Features .........................................................................................................................................1-38
Microsoft Hybrid Graphics ......................................................................................................................1-38
Configuring External Displays ................................................................................................................1-42
Power Options .........................................................................................................................................1-43
Running Apps ..........................................................................................................................................1-44

Storage Devices, Mouse, & Audio
Overview ....................................................................................................................................................2-1
Hard Disk Drive/Solid State Drive ............................................................................................................2-2
Multi-in-1 Card Reader ..............................................................................................................................2-3
Audio Features ...........................................................................................................................................2-4
Setup for Audio Recording ........................................................................................................................2-5
Setup for 5.1Surround Sound ....................................................................................................................2-6
Touchpad and Buttons/Mouse ...................................................................................................................2-8
Touchpad Configuration ............................................................................................................................2-9
Gestures and Device Settings ..................................................................................................................2-10
XXI



Preface
Power Management
Overview ....................................................................................................................................................3-1
The Power Sources ....................................................................................................................................3-2
AC/DC Adapter .........................................................................................................................................3-2
Battery ........................................................................................................................................................3-2
Turning On the Computer ..........................................................................................................................3-3
Shutting the Computer Down ....................................................................................................................3-4
Power Plans ...............................................................................................................................................3-5
Power-Saving States ..................................................................................................................................3-7
Sleep ..........................................................................................................................................................3-7
Hibernate ....................................................................................................................................................3-8
Shut down ..................................................................................................................................................3-8
Configuring the Power Buttons .................................................................................................................3-9
Resuming Operation ................................................................................................................................3-11
Power Conservation Modes .....................................................................................................................3-12
Battery Information .................................................................................................................................3-14
Battery Power ..........................................................................................................................................3-14
Conserving Battery Power .......................................................................................................................3-15
Battery Life ..............................................................................................................................................3-16
New Battery .............................................................................................................................................3-16
Recharging the Battery with the AC/DC Adapter ...................................................................................3-16
Proper handling of the Battery Pack ........................................................................................................3-17
XXII



Preface
Battery FAQ .............................................................................................................................................3-18

Drivers & Utilities
What to Install ............................................................................................................................................4-1
Module Driver Installation ........................................................................................................................4-1
Driver Installation ......................................................................................................................................4-2
Updating/Reinstalling Individual Drivers ..................................................................................................4-5
User Account Control ................................................................................................................................4-6
Windows Security Message .......................................................................................................................4-6
New Hardware Found ................................................................................................................................4-6
Driver Installation Procedure .....................................................................................................................4-7
Chipset .......................................................................................................................................................4-7
Video (VGA) .............................................................................................................................................4-7
NVIDIA Video (VGA) ..............................................................................................................................4-7
LAN ...........................................................................................................................................................4-7
Card Reader ...............................................................................................................................................4-7
Touchpad ...................................................................................................................................................4-8
Hot Key ......................................................................................................................................................4-8
Airplane .....................................................................................................................................................4-8
MEI Driver .................................................................................................................................................4-8
Audio .........................................................................................................................................................4-8
Optional Drivers ......................................................................................................................................4-10
XXIII



Preface
BIOS Utilities
Overview ....................................................................................................................................................5-1
The Power-On Self Test (POST) ...............................................................................................................5-2
Failing the POST .......................................................................................................................................5-3
Fatal Errors ................................................................................................................................................5-3
Non-Fatal Errors ........................................................................................................................................5-3
The Setup Utility ........................................................................................................................................5-4
Entering Setup ...........................................................................................................................................5-4
Setup Screens .............................................................................................................................................5-5
Main Menu .................................................................................................................................................5-6
System Time & Date (Main Menu) ...........................................................................................................5-6
SATA Port # (Main Menu) ........................................................................................................................5-7
OffBoard SATA Controller Configuration (Main Menu) .........................................................................5-7
System/Extended Memory (Main Menu) ..................................................................................................5-7
MB Series / BIOS Revision / KBC/EC firmware Revision/Mac Address (Main Menu) ..........................5-7
Advanced Menu .........................................................................................................................................5-8
Advanced Chipset Control (Advanced Menu) ..........................................................................................5-8
Combo Slot 
(Advanced Menu > Advanced Chipset Control) .......................................................................................5-9
Intel(R) Rapid Start Technology (Advanced Menu) ...............................................................................5-10
Intel(R) Rapid Storage Technology (Advanced Menu) ...........................................................................5-10
SATA Mode (Advanced Menu) ..............................................................................................................5-10
XXIV



Preface
Boot Logo (Advanced Menu) ..................................................................................................................5-11
Power On Boot Beep (Advanced Menu) .................................................................................................5-11
Battery Low Alarm Beep (Advanced Menu) ...........................................................................................5-11
Security Menu ..........................................................................................................................................5-12
Set Supervisor Password (Security Menu) ..............................................................................................5-12
Set User Password (Security Menu) ........................................................................................................5-13
Password on boot: (Security Menu) ........................................................................................................5-13
Secure Boot Control (Security Menu) .....................................................................................................5-14
TPM Configuration (Security Menu) ......................................................................................................5-15
Boot Menu ...............................................................................................................................................5-16
Boot Option Priorities (Boot Menu) ........................................................................................................5-17
UEFI Boot (Boot Menu) ..........................................................................................................................5-17
Exit Menu ................................................................................................................................................5-18

Modules
Overview ....................................................................................................................................................6-1
Setting Up SATA RAID or AHCI Mode ..................................................................................................6-2
AHCI Mode ...............................................................................................................................................6-2
RAID ..........................................................................................................................................................6-2
Intel® Rapid Storage Technology Application .........................................................................................6-2
SATA RAID Setup Procedure (Windows 8.1) ..........................................................................................6-4
IRST Driver Installation ............................................................................................................................6-9
XXV



Preface
Deleting a RAID (Windows 8.1) .............................................................................................................6-10
PC Camera Module ..................................................................................................................................6-11
PC Camera Audio Setup ..........................................................................................................................6-12
Camera App .............................................................................................................................................6-13
Camera Options .......................................................................................................................................6-14
Taking Pictures/Capturing Video ............................................................................................................6-15
Camera Roll .............................................................................................................................................6-16
Wireless LAN Module .............................................................................................................................6-20
3rd Party 802.11b/g/n Driver Installation ................................................................................................6-21
Intel® WLAN Driver Installation ............................................................................................................6-21
Qualcomm Atheros WLAN Combo Driver Installation ..........................................................................6-22
WLAN Configuration in Windows .........................................................................................................6-23
Bluetooth & WLAN Combo Module ......................................................................................................6-26
3rd Party Bluetooth (V4.0) Combo Driver Installation ...........................................................................6-27
Intel Bluetooth Combo Driver Installation ..............................................................................................6-27
Qualcomm Atheros Bluetooth Combo Driver Installation ......................................................................6-28
Bluetooth Configuration in Windows ......................................................................................................6-29
Intel® Rapid Storage Technology ...........................................................................................................6-32
IRST Driver Installation ..........................................................................................................................6-32
Intel® Rapid Storage Technology for RAID Systems ............................................................................6-33
RAID Volume Data Verification and Repair ..........................................................................................6-35
Replacing and Reverting Recovery and Master Volumes .......................................................................6-35
XXVI



Preface
Intel® Smart Response Technology ........................................................................................................6-38
Enabling Intel Smart Response Technology ............................................................................................6-39
Intel® Rapid Start Technology Driver ....................................................................................................6-42
Intel® Rapid Start Technology Configuration ........................................................................................6-43
Intel® Rapid Start Technology Driver Installation .................................................................................6-49
Sound Blaster Audio ................................................................................................................................6-50
Sound Blaster X-Fi MB-3 Audio AP Installation ....................................................................................6-50
Fingerprint Reader Module ......................................................................................................................6-60
Fingerprint Reader Driver Installation .....................................................................................................6-61
Fingerprint Module Configuration ..........................................................................................................6-62
Trusted Platform Module .........................................................................................................................6-64
Enabling & Managing TPM ....................................................................................................................6-65
TPM Management in Windows ...............................................................................................................6-66
TPM Actions ............................................................................................................................................6-68
3G/4G Module .........................................................................................................................................6-70
3G/4G Configuration in Windows ...........................................................................................................6-72
Wireless Display ......................................................................................................................................6-75
Wireless Display Configuration ..............................................................................................................6-76

Troubleshooting
Overview ....................................................................................................................................................7-1
Basic Hints and Tips ..................................................................................................................................7-2
XXVII



Preface
Backup and General Maintenance .............................................................................................................7-3
Viruses .......................................................................................................................................................7-4
Upgrading and Adding New Hardware/Software ......................................................................................7-5
Problems and Possible Solutions ...............................................................................................................7-7

Interface (Ports & Jacks)
Overview ...................................................................................................................................................A-1
Ports and Jacks ..........................................................................................................................................A-2
Card Reader ..............................................................................................................................................A-2
DC-In Jack ................................................................................................................................................A-2
e-SATA / USB 3.0 Combo Port ...............................................................................................................A-3
HDMI-Out Port .........................................................................................................................................A-3
Headphone-Out Jack .................................................................................................................................A-4
Microphone-In Jack ..................................................................................................................................A-4
Mini DisplayPort ......................................................................................................................................A-4
RJ-45 LAN Jack .......................................................................................................................................A-4
S/PDIF-Out Jack .......................................................................................................................................A-4
Security Lock Slot ....................................................................................................................................A-4
USB 3.0 Port .............................................................................................................................................A-5
Powered USB 3.0 Port ..............................................................................................................................A-5

Control Center & Flexikey®
Overview ...................................................................................................................................................B-1
XXVIII



Preface
Control Center ..........................................................................................................................................B-1
Flexikey® .................................................................................................................................................B-1
Power Modes ............................................................................................................................................B-3
Control Center Menus ...............................................................................................................................B-4
Power Status (System Program)   .............................................................................................................B-5
Brightness (System Program)  ..................................................................................................................B-5
Volume (System Program) .......................................................................................................................B-5
Fan Speed (System Program) ...................................................................................................................B-5
This system supports Energy Star power      .............................................................................................B-6
Sleep Button (System Program)  ..............................................................................................................B-6
Display Switch (System Program)  ...........................................................................................................B-6
Display Utility (System Program for High Definition displays only)  .....................................................B-6
Time Zone (System Program)  .................................................................................................................B-6
Desktop Background (System Program)  .................................................................................................B-6
Backlight Keyboard (Device) ...................................................................................................................B-7
TouchPad/Camera (Device)  .....................................................................................................................B-7
Caps Lock/Scroll Lock/ Number Lock/Airplane Mode ...........................................................................B-7
Left Windows Key (Gaming)  ..................................................................................................................B-7
Headphone (Gaming)  ...............................................................................................................................B-7
Flexikey® (Gaming) .................................................................................................................................B-7
Display Utility (System Program for High Definition displays only) ......................................................B-8
Flexikey® Application ...........................................................................................................................B-11
XXIX



Preface
Language Interface .................................................................................................................................B-12
Keyboard Settings - Express Key ...........................................................................................................B-16
Enabling Time Record ............................................................................................................................B-18
Keyboard Settings - Launch App ...........................................................................................................B-20
Keyboard Settings - Express Text ..........................................................................................................B-22
Keyboard Settings - Disable ...................................................................................................................B-24
Mouse Settings - Express Key ................................................................................................................B-25
Enabling Time Record for Mouse Settings ............................................................................................B-26
Mouse Settings - Launch App ................................................................................................................B-27
Mouse Settings - Express Text ...............................................................................................................B-29
Mouse Settings - Disable ........................................................................................................................B-31
Statistics ..................................................................................................................................................B-32

Video Driver Controls
Overview ...................................................................................................................................................C-1
Microsoft Hybrid Graphics .......................................................................................................................C-2
Video Driver Installation ..........................................................................................................................C-4
Video (VGA) ............................................................................................................................................C-4
NVIDIA Video (VGA) .............................................................................................................................C-4
Intel® Iris(TM) Graphics Control Panel ..................................................................................................C-5
Display Devices & Options ....................................................................................................................C-20
Attaching Other Displays .......................................................................................................................C-21
XXX



Preface
Attaching Other Displays - Devices (Charms Bar) ................................................................................C-24
Configuring an External Display In Windows .......................................................................................C-25
HDMI Audio Configuration ...................................................................................................................C-27
NVIDIA Control Panel ...........................................................................................................................C-30
Customization Options ...........................................................................................................................C-32
Set PhysX® Configuration .....................................................................................................................C-36

Specifications
Processor ...................................................................................................................................................D-2
Core Logic ................................................................................................................................................D-2
Display ......................................................................................................................................................D-2
Memory .....................................................................................................................................................D-2
Video Adapter Options .............................................................................................................................D-2
Storage ......................................................................................................................................................D-3
Audio ........................................................................................................................................................D-3
Keyboard & Pointing Device ....................................................................................................................D-4
Indicators ..................................................................................................................................................D-4
Interface ....................................................................................................................................................D-4
Card Reader ..............................................................................................................................................D-4
Slots ..........................................................................................................................................................D-4
Communication .........................................................................................................................................D-4
Operating System ......................................................................................................................................D-5
XXXI



Preface
BIOS .........................................................................................................................................................D-5
Features .....................................................................................................................................................D-5
Security .....................................................................................................................................................D-5
Power Management ..................................................................................................................................D-5
Power ........................................................................................................................................................D-5
Environmental Spec ..................................................................................................................................D-5
Physical Dimensions & Weight ................................................................................................................D-5

Windows 10
Overview ................................................................................................................................................... E-1
Windows 10 Start Menu ........................................................................................................................... E-2
Right-Clicking the Windows Logo In Start Menu ................................................................................... E-3
Start Menu Apps & Tiles .......................................................................................................................... E-4
Windows 10 Control Panel ....................................................................................................................... E-6
Settings ..................................................................................................................................................... E-7
Windows 10 Taskbar ................................................................................................................................ E-8
Video Features .......................................................................................................................................... E-9
Power Options ........................................................................................................................................ E-12
Windows 10 Drivers & Utilities ............................................................................................................. E-15
Driver Installation (Windows 10) ........................................................................................................... E-15
Driver Installation Procedure .................................................................................................................. E-17
Chipset .................................................................................................................................................... E-17
XXXII



Preface
Video (VGA) .......................................................................................................................................... E-17
NVIDIA Video (VGA) ........................................................................................................................... E-17
LAN ........................................................................................................................................................ E-17
Card Reader ............................................................................................................................................ E-17
Touchpad ................................................................................................................................................ E-18
Control Center ........................................................................................................................................ E-18
Airplane .................................................................................................................................................. E-18
MEI Driver .............................................................................................................................................. E-18
Audio ...................................................................................................................................................... E-18
Optional Drivers ..................................................................................................................................... E-19
Wireless LAN Module ............................................................................................................................ E-20
3rd Party WLAN Driver Installation ...................................................................................................... E-21
Intel® WLAN Driver Installation ........................................................................................................... E-21
Qualcomm Atheros WLAN Combo Driver Installation ......................................................................... E-22
Bluetooth & WLAN Combo Module ..................................................................................................... E-23
3rd Party Bluetooth Combo Driver Installation ...................................................................................... E-24
Intel Bluetooth Combo Driver Installation ............................................................................................. E-24
Qualcomm Atheros Bluetooth Combo Driver Installation ..................................................................... E-25
Bluetooth Configuration ......................................................................................................................... E-25
Intel® Rapid Storage Technology .......................................................................................................... E-26
IRST Driver Installation ......................................................................................................................... E-26
Sound Blaster Audio ............................................................................................................................... E-27
XXXIII



Preface
Sound Blaster X-Fi MB-3 Audio AP Installation ................................................................................... E-27
Fingerprint Reader Module ..................................................................................................................... E-28
Fingerprint Reader Driver Installation .................................................................................................... E-28
Fingerprint Module Configuration ......................................................................................................... E-29
PC Camera .............................................................................................................................................. E-30
Trusted Platform Module ........................................................................................................................ E-31
TPM Management in Windows .............................................................................................................. E-31
3G/4G Module ........................................................................................................................................ E-32
3G/4G Configuration in Windows 10 ..................................................................................................... E-33
XXXIV



Quick Start Guide 1
Chapter 1: Quick Start Guide

Overview
This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the
computer and to getting your system started. The remainder of the manual covers the following:

• Chapter 2 A guide to using some of the main features of the computer e.g. the storage devices (hard disk and 
card reader), TouchPad & Mouse and Audio Features.

• Chapter 3 The computer’s power management options.
• Chapter 4 The installation of the drivers and utilities essential to the operation or improvement of some of the 

computer’s subsystems.
• Chapter 5 An outline of the computer’s built-in software or BIOS (Basic Input Output System).
• Chapter 6 A quick guide to the computer’s PC Camera, Wireless LAN, Fingerprint, Bluetooth & WLAN 

Combo, Sound Blaster Audio and Intel modules (some of which may be optional depending on 
your purchase configuration).

• Chapter 7 A troubleshooting guide.
• Appendix A Definitions of the interface, ports/jacks which allow your computer to communicate with external 

devices.
• Appendix B Information on the Control Center. and Flexikey® Application.
• Appendix C Information on the Video driver controls.
• Appendix D The computer’s specification.
• Appendix E A quick guide to Windows 10 (including driver installation information).
Overview 1 - 1
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Advanced Users
If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful
to refer to “Drivers & Utilities” on page 4 - 1 and “BIOS Utilities” on page 5 - 1 in the User’s Manual. You
may also find the notes marked with a  of interest to you.

Beginners and Not-So-Advanced Users
If you are new to computers (or do not have an advanced knowledge of them) then
the information contained in this Quick Start Guide should be enough to get you up
and running. Eventually you should try to look through all the documentation (more
detailed descriptions of the functions, setup and system controls are covered in the
remainder of the User’s Manual), but do not worry if you do not understand every-
thing the first time. Keep this manual nearby and refer to it to learn as you go. You
may find it useful to refer to the notes marked with a  as indicated in the margin.
For a more detailed description of any of the interface ports and jacks see “Interface
(Ports & Jacks)” on page A - 1.

Warning Boxes
No matter what your level please pay careful attention to the warning and safety information indicated by the
 symbol. Also please note the safety and handling instructions as indicated in the Preface.


Notes

Check the light colored
boxes with the mark
above to find detailed
information about the
computer’s features. 
1 - 2 Overview
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Not Included
Operating Systems (e.g. Windows 8.1) and applications (e.g. word processing, spreadsheet and database pro-
grams) have their own manuals, so please consult the appropriate manuals.


Drivers

If you are installing new system software, or are re-configuring your computer for a different system, you will need to install
the appropriate drivers. Drivers are programs which act as an interface between the computer and a hardware component
e.g. a wireless network module. It is very important that you install the drivers in the order listed in Table 4 - 1, on page 4
- 4. You will be unable to use most advanced controls until the necessary drivers and utilities are properly installed. If your
system hasn’t been properly configured (your service representative may have already done that for you), refer to “Drivers
& Utilities” on page 4 - 1 for installation instructions.

Ports and Jacks

See “Ports and Jacks” on page A - 2 for a description of the interface (ports & jacks) which allow your computer to com-
municate with external devices, connect to the internet etc.
Overview 1 - 3
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System Software
Your computer may already come with system software pre-installed. Where this is not the case, or where you
are re-configuring your computer for a different system, you will find the Windows 8.1 operating system is sup-
ported.


Windows OS

Note that the information included on the following pages is for Windows 8.1 only.

In order to run Windows 8/8.1 (64 bit) your computer requires a minimum 2GB of system memory (RAM).
1 - 4 Overview
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System Startup
1. Remove all packing materials, and place the computer on a stable surface, and securely attach any peripherals 

you want to use with the notebook (e.g. keyboard and mouse) to their ports.
2. Attach the AC/DC adapter to the DC-In jack at the rear of the computer, then plug the AC power cord into an 

outlet, and connect the AC power cord to the AC/DC adapter (make sure you use the adapter when first 
setting up the computer, as to safeguard the computer during shipping, the battery will be locked to not power 
the system until first connected to the AC/DC adapter).

3. Use one hand to raise the lid/LCD to a comfortable viewing angle (it is preferable not to exceed 135 degrees); use 
the other hand to support the base of the computer (Note: Never lift the computer by the lid/LCD).

4. Press the power button on the top of the computer for about 2 - 3 seconds to turn the computer “on” (note that 
the power LED on the front of the computer will turn from orange to green when the computer powers on).

Figure 1 - 1 - Computer with AC/DC Adapter Plugged-In/Opening the Lid/LCD

135°


Shutdown

Note that you should always
shut your computer down by
choosing the Shut Down
command in Windows (see
page 1 - 43). This will help
prevent hard disk or system
problems.
System Startup 1 - 5
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Model Differences
This notebook series includes two different model types, which include different design styles, that mainly differ as
indicated in the table below and overleaf. Note that your model may appear slightly different from those pictured in
this manual.

Table 1 - 1 - Model Differences

Feature
Model A

Design I Design II Design III Design IV Design V

Display Type
15.6" (39.62cm) QFHD (3840 * 2160) / WQHD+ 
(2880 * 1620) / FHD (1920 * 1080) 3.5mm 16:9 

Backlit Panel

15.6" (39.62cm) QFHD (3840 * 2160) / FHD 
(1920 * 1080) 3.5mm 16:9 Backlit Panel

15.6" (39.62cm) 
QFHD (3840 * 2160) 

/ WQHD+ (2880 * 
1620) / FHD (1920 * 
1080) 3.5mm 16:9 

Backlit Panel

Video 
Adapter

NVIDIA® GeForce GTX 
970M

NVIDIA® GeForce GTX 
980M

NVIDIA® GeForce GTX 965M
NVIDIA® GeForce 

GTX 970M

Storage See “Storage” on page  A - 3 for the details of storage options for each model

3G/4G Module LTE/HSPA+ M.2 3042 3G or 4G Module Card (optional) with USB Interface

Subwoofer 
Speaker

Not Supported

Dimensions & 
Weight

See “Physical Dimensions & Weight” on page  A - 5 for the details of the dimensions and weight for each model and 
design (note the Model A Design IV & V pictures in Figure 1 - 3 on page 1 - 9, Figure 1 - 8 on page 1 - 18 & Figure 1 - 17 

on page 1 - 27)
1 - 6 Model Differences
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Table 1 - 2 - Model Differences

Feature
Model B

Design I Design II Design III

Display Type
17.3" (43.94cm) FHD (1920 * 1080) 6.0mm, 

16:9 Backlit Panel

Video Adapter NVIDIA® GeForce GTX 970M NVIDIA® GeForce GTX 980M NVIDIA® GeForce GTX 965M

Storage See “Storage” on page  A - 3 for the details of storage options for each model

3G/4G Module Not Supported

Subwoofer Speaker One Built-In Subwoofer Speaker

Dimensions & Weight
See “Physical Dimensions & Weight” on page  A - 5 for the details of the dimensions and weight for each 

model and design
Model Differences 1 - 7
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LCD Panel Open - Model AFigure 1 - 2 
LCD Panel Open 

Model A

1. Built-In PC Camera
2. PC Camera LED
3. Built-In Array 

Microphone
4. LCD
5. Speakers
6. Power Button
7. Illuminated LED 

Keyboard
8. TouchPad & Buttons
9. Fingerprint Reader 

Sensor (Optional)

8

Note that the Touchpad/
Clickpad and Buttons has a
valid operational area indi-
cated within the dotted lines
above.

4

1

9

5

8

6

7

2

5

3 
Wireless Device 

Operation Aboard 
Aircraft

The use of any portable elec-
tronic transmission devices
(e.g. WLAN, Bluetooth or
3G/4G) aboard aircraft is
usually prohibited. Make
sure any wireless modules
are OFF (i.e. the system is in
Airplane Mode) if you are
using the computer aboard
aircraft.

Use Fn + F11 Airplane
Mode key combination to
toggle Airplane Mode On/
Off, and check the LED indi-
cator for the power status.

3
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LCD Panel Open - Model A - Designs IV & V Figure 1 - 3 
LCD Panel Open 

Model A Designs IV & V

1. Built-In PC Camera
2. PC Camera LED
3. Built-In Array 

Microphone
4. LCD
5. Speakers
6. Power Button
7. Illuminated LED 

Keyboard
8. TouchPad & Buttons
9. Fingerprint Reader 

Sensor (Optional)

8

Note that the Touchpad/
Clickpad and Buttons has a
valid operational area indicat-
ed within the dotted lines
above.

4

1

9

5

8

6

7

2

5

3 
Wireless Device 

Operation Aboard 
Aircraft

The use of any portable elec-
tronic transmission devices
(e.g. WLAN, Bluetooth or
3G/4G) aboard aircraft is
usually prohibited. Make
sure any wireless modules
are OFF (i.e. the system is in
Airplane Mode) if you are
using the computer aboard
aircraft.

Use Fn + F11 Airplane
Mode key combination to
toggle Airplane Mode On/
Off, and check the LED indi-
cator for the power status.

3

LCD Panel Open - Model A - Designs IV & V 1 - 9
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LCD Panel Open - Model BFigure 1 - 4 
LCD Panel Open 

Model B

1. Built-In PC Camera
2. PC Camera LED
3. Built-In Array 

Microphone
4. LCD
5. Speakers
6. Power Button
7. Illuminated LED 

Keyboard
8. TouchPad & Buttons
9. Fingerprint Reader 

Sensor (Optional)

8

Note that the Touchpad/
Clickpad and Buttons has a
valid operational area indi-
cated within the dotted lines
above.

4

1

9

5

8

6

7

2

5

3 
Wireless Device 

Operation Aboard 
Aircraft

The use of any portable elec-
tronic transmission devices
(e.g. WLAN, Bluetooth or
3G/4G) aboard aircraft is
usually prohibited. Make
sure any wireless modules
are OFF (i.e. the system is in
Airplane Mode) if you are
using the computer aboard
aircraft.

Use Fn + F11 Airplane
Mode key combination to
toggle Airplane Mode On/
Off, and check the LED indi-
cator for the power status.

3

1 - 10 LCD Panel Open - Model B
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LED Indicators
The LED indicators display helpful information about the current status of the computer.

Table 1 - 3 - LED Indicators

Icon Color Description Icon Color Description

Green
Number Lock is Activated

Orange The Battery is Charging

Green
Caps Lock is Activated

Blinking Orange
The Battery has Reached Critically Low 

Power Status

Green
Scroll Lock is Activated

 
Green The Battery is Fully Charged

Green Hard Disk Activity Orange AC/DC Power is Plugged In

Green
Airplane Mode is ON (the WLAN, Bluetooth 

& 3G/4G Modules are OFF)
Blinking Orange*

The Powered USB Port is On 
(see “Powered USB 3.0 Port” on page 1 - 23)

Off Integrated GPU (iGPU) In Use Green The Computer is On

Green Discrete GPU (dGPU) Is Powered Blinking Green The Computer is in Sleep Mode
LCD Panel Open - Model B 1 - 11
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Illuminated LED Keyboard
The illuminated keyboard has an embedded numerical keypad for easy numeric data
input, and features function keys to allow you to change operational features instant-
ly. See Table 1 - 5, on page 1 - 17 for full function key combination details.

Figure 1 - 5 - Illuminated LED Keyboard


Other Keyboards

If your keyboard is dam-
aged or you just want to
make a change, you can
use any standard USB
keyboard. The system will
detect and enable it auto-
matically. However spe-
cial functions/hot-keys
unique to the system’s
regular keyboard may not
work.

Scr Lk

Hold down the Fn Key
and Scr Lk to enable
scroll lock/number lock,
and check the LED indi-
cator for status. 

Numerical 

Play/Pause Key

Function Keys

Scr Lk Key

Fn Key

Game Control Keys

Num Lk Key

Windows Logo Key

Menu/Application Key
Numerical 
 Keypad



Special Characters

Some software applications allow the number-keys to be used with Alt to produce special characters.
These special characters can only be produced by using the numeric keypad. Regular number keys (in
the upper row of the keyboard) will not work. Make sure that NumLk is on.
1 - 12 Illuminated LED Keyboard
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Control Center
When in the Windows Desktop application (not in the Start screen) press the Fn + Esc key combination, or
double-click the icon  in the notification area of the taskbar to toggle the Control Center on/off. The Con-
trol Center gives quick access to frequently used controls and enables you to quickly turn the camera/Touch
Pad on/off (see Appendix B for full details). 

Figure 1 - 6 - Control Center


Control Center Access

To run the Control Center press the Fn + Esc key
combination, or double-click
the icon  in the notification
area of the taskbar. 

Close the Control Center by
clicking the  close icon in
the top right of the panel
(move the cursor onto the top
right corner of the panel to
highlight it).
Control Center 1 - 13



Quick Start Guide1
Flexikey® Application
The Flexikey® application is a quick hotkey configuration application, which allows you to assign a single key
to launch multiple key combinations, or to launch programs and applications, to create text macros and to
disable certain keys. The application can also be used to configure the mouse buttons to create hotkeys for
gaming etc. All the configuration settings are retained under (up to12) profiles to which the settings are applied.
Click Flexikey® in the Gaming section of the Control Center, or the click the icon   in the notification
area of the taskbar, to launch the application (see Appendix B for full details).

Figure 1 - 7 - Flexikey® Hotkey Application

Flexikey® Enabled

Flexikey® Disabled
1 - 14 Flexikey® Application
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Flexikey® Application Features:
For full details see “Flexikey® Application” on page B - 11.

• EXPRESS KEY - This feature allows you to configure a single key (or mouse click) to send multiple key 
combinations, or to create more useful shortcut keys This is useful in gaming or when using applications 
which have a complex set of keyboard shortcuts.

• LAUNCH APP - This simply assigns single keys (or mouse clicks) to launch any program’s or applica-
tion’s executable file.

• EXPRESS TEXT - With this you can assign single keys (or mouse clicks) to send commonly used strings 
of text.

• DISABLE - Use this function to disable any keyboard keys or mouse buttons.

• STATISTICS - Use this to quickly record keys in use in any application, and to disable unused keys.
Flexikey® Application 1 - 15
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Keyboard Shortcuts
The following Windows Logo Key (Winkey) keyboard shortcuts are useful for navi-
gation/operation in Windows 8.1.

Table 1 - 4 - Keyboard Shortcuts

Windows Logo 

 Key + 
Description

Tap Winkey
Toggle between the Start screen and the foremost running app or the 

Windows Desktop

C Display Charms menu

D Switch to the Windows Desktop and toggle show Desktop 

E
 Switch to the Windows desktop and launch Windows Explorer with 

Computer displayed

F Display file Search

I Open the Settings charm

K Open the Connect charm

L Lock the computer and display the Lock screen

P  Display the Second Screen menu (see Figure 1 - 30 on page 1 - 42)

R Switch to the Windows Desktop and display the Run dialog box

Z Access the Customize Bar (see Figure 1 - 22 on page 1 - 33)


Windows Logo 

Keyboard Shortcut

Use the Windows logo
key  + D key com-
bination to switch be-
tween the Start screen
and Windows Desktop.

Menu/Application 
Keyboard Shortcut

When the Desktop app
is running you can use
the Menu/Application
key  on the key-
board to display the
context menu as per a
mouse right-click. In
the Start screen this
function is useful to
quickly display the All
Apps icon.
1 - 16 Flexikey® Application



Quick Start Guide 1

Function Keys & Visual Indicators
The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key is held down. 

Keys Function/Visual Indicators Keys Function/Visual Indicators

Fn +
Fan Control 

Toggle Automatic / 
Full Power

Fn + Control Center Toggle (see over)

Fn + Play/Pause (in Audio/Video Programs) Fn + Display Toggle

Fn + Touchpad Toggle Fn + Brightness Decrease/Increase 

Fn + 
Turn LCD Backlight Off 

(Press a key to or use Touchpad to turn on)
Fn + PC Camera 

Power Toggle 

Fn + Mute Toggle Fn + Airplane 
Mode Toggle 

Fn + Keyboard LED Toggle Fn + Sleep Toggle

Fn + Volume Decrease/Increase Fn + Power Button Powered USB 3.0 Port Power Toggle

Table 1 - 5 - Function Keys & Visual Indicators Fn + Backspace Flexikey® Enable/Disable
Flexikey® Application 1 - 17
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Front & Rear Views - Model AFigure 1 - 8
Front & Rear Views 

Model A

1. LED Power Indica-
tors

2. Vent/Fan Intake
3. DC-In Jack
4. Combined eSATA/ 

USB 3.0 Port


USB Ports

Note that the connections to
the USB ports only fit one
way, do not force them.

Overheating

To prevent your computer
from overheating make sure
nothing blocks the vent(s)/
fan intake(s) while the com-
puter is in use.

1

3 42

1


E-SATA Cable Insertion 

E-SATA cables should be inserted as illus-
trated below (with the T-Shape inverted, the
pins at the lower half of the connector). E-
SATA cables only fit one way, do not force
them. 

Design I & Design III

Design II2
3 4

Design IV & Design V
2

3 4
1 - 18 Front & Rear Views - Model A
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Front & Rear Views - Model B Figure 1 - 9
Front & Rear Views 

Model B

1. LED Power Indica-
tors

2. Vent/Fan Intake
3. DC-In Jack
4. Combined eSATA/ 

USB 3.0 Port


USB Ports

Note that the connections to
the USB ports only fit one
way, do not force them.

Overheating

To prevent your computer
from overheating make sure
nothing blocks the vent(s)/
fan intake(s) while the com-
puter is in use.

1

3 42

1


E-SATA Cable Insertion 

E-SATA cables should be inserted as illustrated below (with the T-Shape inverted, the pins
at the lower half of the connector). E-SATA cables only fit one way, do not force them. 
Front & Rear Views - Model B 1 - 19
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Right View - Model AFigure 1 - 10
Right View 

Model A

1. S/PDIF-Out Jack
2. Microphone Jack
3. Headphone Jack
4. Multi-in-1 Card 

Reader
5. SIM Card Reader 

(for 3G/4G USIM 
Cards - see over)

6. 2 * USB 3.0 Ports
7. RJ-45 LAN Jack
8. Security Lock Slot


USB Ports

Note that the connec-
tions to the USB ports
only fit one way, do not
force them.

1 3 42 6 85


Multi-in-1 Card Reader

The card reader allows you to use the most popular digital storage card formats:

MMC (MultiMedia Card) / RSMMC
SD (Secure Digital) / Mini SD / SDHC / SDXC

6 7


Inserting Cards into the Card Reader

Note that the cards should
be inserted with the read-
able side of the card fac-
ing upwards, as
illustrated on the right.
1 - 20 Right View - Model A



Quick Start Guide 1

3G/4G Module USIM Card Installation
(For Model A Computers Only)
Insert the USIM card  as illustrated below (pay careful attention to the orientation
of the card as the gold contact side of the card should face upwards) until it clicks
fully into position. To eject the card simply press it until it ejects, but do not attempt
to eject the card while connected to a 3G/4G network (see below). 


USIM Card Orienta-

tion

Note that the USIM
card’s readable side
(with the gold-colored
contacts) should face
upwards as illustrated.

Figure 1 - 11
USIM Card Insertion

1

1


USIM Card Ejection

Simply press on the USIM card to eject it, however do not do this while a connection is in
progress.

If you do eject the card while a 3G/4G connection is ongoing, you will need to shut down
the system, reinsert the USIM card, restart the system and then reestablish the 3G/4G con-
nection.

If you wish to change USIM cards then you will need to shut the system down, reinsert the
USIM card, restart the system and then reestablish the 3G/4G connection.
Right View - Model A 1 - 21
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Right View - Model BFigure 1 - 12
Right View 

Model B

1. S/PDIF-Out Jack
2. Microphone Jack
3. Headphone Jack
4. 2 * USB 3.0 Ports
5. Multi-in-1 Card 

Reader
6. RJ-45 LAN Jack
7. Security Lock Slot


USB Ports

Note that the connec-
tions to the USB ports
only fit one way, do not
force them.

1 3 42 65


Multi-in-1 Card Reader

The card reader allows you to use the most popular digital storage card formats:

MMC (MultiMedia Card) / RSMMC
SD (Secure Digital) / Mini SD / SDHC / SDXC

7


Inserting Cards into the Card Reader

Note that the cards should
be inserted with the read-
able side of the card fac-
ing upwards, as illustrated
on the right.

4
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Left View - Model A Figure 1 - 13
Left View - Model A

1. Vent/Fan Intake
2. HDMI-Out Port
3. 1 * Powered USB 

3.0 Port
4. Mini Display Port 2
5. Mini Display Port 1

1 2 43


Powered USB 3.0 Port

USB 3.0 ports are denoted by their blue color. Note that the USB 3.0 port is not operational
under DOS and does not support wake on USB. The powered USB 3.0 (  in Figure 1 -
13 on page 1 - 23) port can supply power (for charging devices only, not for operating
devices) when the system is off but still powered by the AC/DC adapter plugged into a
working outlet, or powered by the battery with a capacity level above 20% (this may not
work with certain devices - see page 7 - 11). Toggle power to this port by using Fn + power
button.

HDMI Port / Mini Display Port

Note that the HDMI Port and Mini Display ports support video and audio signals to attached
external displays (see “HDMI Audio Configuration” on page C - 27).

Note that Sound Blaster X-Fi MB3 audio will be disabled when you are connecting to an
external display through an HDMI or Mini Display port connection.

3

5
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Quick Start Guide1
Left View - Model BFigure 1 - 14
Left View - Model B

1. Vent/Fan Intake
2. HDMI-Out Port
3. 1 * Powered USB 

3.0 Port
4. Mini Display Port 2
5. Mini Display Port 1

1 2 43


Powered USB 3.0 Port

USB 3.0 ports are denoted by their blue color. Note that the USB 3.0 port is not operational
under DOS and does not support wake on USB. The powered USB 3.0 (  in Figure 1 -
13 on page 1 - 23) port can supply power (for charging devices only, not for operating
devices) when the system is off but still powered by the AC/DC adapter plugged into a
working outlet, or powered by the battery with a capacity level above 20% (this may not
work with certain devices - see page 7 - 11). Toggle power to this port by using Fn + power
button.

HDMI Port / Mini Display Port

Note that the HDMI Port and Mini Display ports support video and audio signals to attached
external displays (see “HDMI Audio Configuration” on page C - 27).

Note that Sound Blaster X-Fi MB3 audio will be disabled when you are connecting to an
external display through an HDMI or Mini Display port connection.

3

5
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Bottom View - Model A - Design I Figure 1 - 15
Bottom View 

Model A - Design I

1. Fan Outlet/Intake


Overheating

To prevent your computer
from overheating make sure
nothing blocks the vent(s)/
fan intake(s) while the com-
puter is in use.

Bottom Cover Removal 
Warning

Do not remove any cover(s)
and /or screw(s) for the pur-
poses of device upgrade as
this may violate the terms of
your warranty.

If you need to replace/re-
move the hard disk/RAM/
optical device etc., for any
reason, please contact your
distributor/supplier for fur-
ther information.

1


Battery Information

Always completely discharge, then fully charge, a new battery before using it. Completely
discharge and charge the battery at least once every 30 days or after about 20 partial dis-
charges. See “Battery Information” on page 3 - 14 for full instructions.

1

1 1

1

1
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Bottom View - Model A - Design II & Design IIIFigure 1 - 16
Bottom View 

Model A - Designs II & 
III

1. Fan Outlet/Intake


Overheating

To prevent your computer
from overheating make sure
nothing blocks the vent(s)/fan
intake(s) while the computer
is in use.

Bottom Cover Removal 
Warning

Do not remove any cover(s)
and /or screw(s) for the pur-
poses of device upgrade as
this may violate the terms of
your warranty.

If you need to replace/re-
move the hard disk/RAM/op-
tical device etc., for any
reason, please contact your
distributor/supplier for further
information.

1


Battery Information

Always completely discharge, then fully charge, a new battery before using it. Completely
discharge and charge the battery at least once every 30 days or after about 20 partial dis-
charges. See “Battery Information” on page 3 - 14 for full instructions.

1
1

1

1

1
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Bottom View - Model A - Design IV & Design V Figure 1 - 17
Bottom View 

Model A - Designs IV 
& V

1. Fan Outlet/Intake


Overheating

To prevent your computer
from overheating make sure
nothing blocks the vent(s)/fan
intake(s) while the computer
is in use.

Bottom Cover Removal 
Warning

Do not remove any cover(s)
and /or screw(s) for the pur-
poses of device upgrade as
this may violate the terms of
your warranty.

If you need to replace/re-
move the hard disk/RAM/op-
tical device etc., for any
reason, please contact your
distributor/supplier for further
information.

1


Battery Information

Always completely discharge, then fully charge, a new battery before using it. Completely
discharge and charge the battery at least once every 30 days or after about 20 partial dis-
charges. See “Battery Information” on page 3 - 14 for full instructions.

1 1

1

1

1
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Bottom View - Model BFigure 1 - 18
Bottom View - Model B

1. Fan Outlet/Intake
2. Subwoofer Speaker


Overheating

To prevent your computer
from overheating make sure
nothing blocks the vent(s)/
fan intake(s) while the com-
puter is in use.

Bottom Cover Removal 
Warning

Do not remove any cover(s)
and /or screw(s) for the pur-
poses of device upgrade as
this may violate the terms of
your warranty.

If you need to replace/re-
move the hard disk/RAM/
optical device etc., for any
reason, please contact your
distributor/supplier for fur-
ther information.

1


Battery Information

Always completely discharge, then fully charge, a new battery before using it. Completely
discharge and charge the battery at least once every 30 days or after about 20 partial dis-
charges. See “Battery Information” on page 3 - 14 for full instructions.

12
1

1

1
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Windows 8.1 Control Panel
Throughout this manual you will see an instruction to open the Control Panel.
Right-click the lower left hot corner to bring up the context menu (or use the Win-
dows Logo Key  + X key combination) and select Control Panel in both the
Desktop app or Start screen.

Figure 1 - 19 - Windows Context Menu


Windows Versions

Note that the informa-
tion included on the fol-
lowing pages is for the
latest updated version
of Windows 8.1 only.

Make sure you enable
Windows Update in or-
der to get all the latest
security updates etc.
(see “Windows Up-
date” on page 4 - 9).

 

   

Move the mouse to the bottom left 

   

Start Screen

Desktop app

of the screen and right-click to
access the menu. 
Windows 8.1 Control Panel 1 - 29
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The Control Panel can be accessed in a number of ways in Windows 8.1.

• Click Search in the Windows Charms Bar (see previous page) and the search pane will pop out. Type 
Control Panel and select it from the results to the left.

• Click on This PC (in Apps, or you can to pin This PC to the Start screen), click on Computer in the 
top menu and select Open Control Panel from the ribbon.

• When in the Desktop app (this does not apply to the Start screen) click on Settings in the Windows 
Charms Bar and select Control Panel from the menu.

• Click the arrow at the bottom of the Start screen and click Control Panel in Apps (Windows System).

• Right-click the Start button to bring up the menu and select Control Panel (see Figure 1 - 20 on page 1 
- 31).


Keyboard Shortcut to Control Panel

You can also use keyboard shortcuts to access the Control Panel. Press the Windows logo key  and X to bring up
the context menu, and then press P to bring up the Control Panel. Alternatively press the Windows logo key  and R
to bring up the Run dialog box, and then type “Control Panel” and press Enter to access the Control Panel.
1 - 30 Windows 8.1 Control Panel
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Right-click the Start button in the Desktop app (or use the Windows Logo Key

 + X key combination) to bring up an advanced context menu of useful features
such as Control Panel, Programs and Features, Power Options, Task Manager,
Search, File Explorer, Command Prompt, Device Manager and Network Connec-
tions etc.

Figure 1 - 20 - Advanced Context Menu (Right-Click Start Button)


Display Most 

Recently Used 
Apps

If you are in the Start
screen, Desktop or an
app you can move your
mouse to the upper left
corner of the screen to
get back to the most re-
cently used app. 

To view all the most re-
cently used Apps hover
over the top left of the
screen and then move
the mouse down along
the left side of the
screen to display the
list.

Move the mouse to the bottom left of the screen 

and right-click the Start button to access the menu.
Windows 8.1 Control Panel 1 - 31
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Windows 8.1 Start Screen & Desktop
The Apps, control panels, utilities and programs within Windows are accessed from the Start screen and/or
Windows Desktop app. The Desktop (which runs as an app within the Start screen) can be accessed by clicking
the Desktop item in the Start screen (or by using the Windows Logo Key  + D key combination). Click the
arrow at the bottom of the Start screen to access Apps.

Figure 1 - 21 - Windows Start Screen

Desktop App
1 - 32 Windows 8.1 Start Screen & Desktop
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Apps & Tiles
The Start screen will contain a number of apps, and many more will be installed as you add more applications
etc. Not all of these apps can fit on one screen so you will often need use the slider at the bottom of the screen
in order to view all the necessary Apps.

Accessing Pining/Unpinning All Apps
You can add and remove the tiles for apps and control panels in the Start screen. Right-click on an app to bring
up the context menu and you pin the App to (or unpin from) the Start screen, or to the taskbar.

Figure 1 - 22 - Apps

 
 

Click the arrow at the bottom of the 
screen to access All Apps 
Windows 8.1 Start Screen & Desktop 1 - 33
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Desktop Application
When the Desktop app is running (click the app in the Start screen or use the Windows Logo Key  + D key
combination) you can use lower left hot corner to switch between the Start screen and the Windows Desktop
app. To do so move your mouse to hover over the bottom left corner of the Desktop app and left-click.

Figure 1 - 23 - Desktop

Move the mouse to the bottom left of the screen and click to switch
back to the Start screen.
1 - 34 Windows 8.1 Start Screen & Desktop
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The Charms Bar
The right side of the screen (Start or Desktop) displays the Charms Bar. The Charms Bar contains the Search,
Share, Start, Devices and Settings menus. To access up the Charms Bar move the cursor to the upper or lower
right corners of the screen, and then hover over one of the items in the Charms Bar to activate it (the bar will
be black when it is active), or use the Windows Logo Key  + C key combination. 

Figure 1 - 24 - Start Screen with Charms Bar

 

Move the mouse over a Charms Bar icon to activate the menu 

Move the mouse to the top/lower right icons to activate the Charms Bar 

Move the mouse to the top/lower right icons to activate the Charms Bar 
Windows 8.1 Start Screen & Desktop 1 - 35
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Charms Bar Items

• Search : You can search for any file, application, Apps and control panel settings with instantaneous 
results.

• Share : This button is used to share information with people via mail or social networks.

• Start : Click to bring up the Start screen (the same function as pressing the Windows Logo Key or click-
ing the bottom left of the screen). 

• Devices : Click this button to change connected peripheral device settings e.g. an external display.

• Settings : This button gives instant access to the computer settings, such as Network, Audio, Notifica-
tions, Power and Keyboard (click Change PC Settings to activate the PC Settings menu).

Figure 1 - 25 - Settings Menu


Charms Bar - TouchPad Access

To quick access the Charms Bar using the TouchPad:

1. Place your finger off the TouchPad (slightly to the right of the 
pad resting on the computer).

2. Move your finger across to the left on to the TouchPad.
3. The Charms Bar will then pop-up.
1 - 36 Windows 8.1 Start Screen & Desktop
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Windows 8.1 Taskbar
In many instances throughout this manual you will see an instruction to access the notification area of the task-
bar (system tray). In Windows 8.1 the taskbar can be directly accessed from the Desktop application; if you
are in the Start screen you will need to move the cursor to the bottom of the screen to display the taskbar.

The taskbar is displayed at the bottom of the screen, and you can see the notification area (system tray) of the
taskbar in the bottom right of the screen. Some of the control panels and applications referred to during the
course of this manual can be accessed from here.

Figure 1 - 26 - Taskbar & Notification Area (System Tray)

You can pin/unpin apps to/from the taskbar in much the same way as you can to the Start screen (see “Accessing
Pining/Unpinning All Apps” on page 1 - 33).
Windows 8.1 Start Screen & Desktop 1 - 37
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Video Features
You can switch display devices, and configure display options, from the Display control panel (in Appearances
and Personalization) in Windows when running the Desktop app (see “Desktop Application” on page 1 - 34).

Microsoft Hybrid Graphics
Your computer will feature Microsoft Hybrid Graphics switchable graphics technology. This seamless tech-
nology is designed to get best performance from the graphics system while allowing longer battery life, without
having to manually change settings. The computer’s operating system (and some applications) will automati-
cally switch between the integrated UMA (Unified Memory Architecture) GPU (iGPU) and the discrete GPU
(dGPU) when required by the applications in use. This switch is seamless to the user (see Appendix C).

Table 1 - 6 - GPU Mode LED Indicator

The basic video features for this computer can be configured using the Intel® Iris™ Graphics Control Panel.
Further video configuration is available through the NVIDA control panel (see the information on the following
pages and Appendix C).

Icon Color Description

Off Integrated GPU (iGPU) In Use

Green Discrete GPU (dGPU) Is Powered
1 - 38 Video Features
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To access Display (Control Panel) and Screen Resolution in Windows:
1. Go to the Control Panel.
2. Click Display (icon) - In the Appearance and Personalization category.
3. Adjust resolution.

Figure 1 - 27 - Screen Resolution

3

2


Right-Click Desktop App

1. You can right-click the 
desktop and select 
Screen resolution  
(Figure 1 - 27).

2. Use the dropbox to 
select the screen 
Resolution  (Figure 
1 - 27).

3. Click Advanced 
settings  (Figure 1 - 
27) to bring up the 
Advanced properties 
tabs.

1

2

3

1
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To access the Intel(R) Iris(TM) Graphics Control Panel:
1. Click Advanced settings  (Figure 1 - 27 on page 1 - 39) in the Screen Resolution control panel in Win-

dows.
2. Click the Intel(R)... tab and click Graphics Properties (button)  (Figure 1 - 28 on page 1 - 40) .
OR
3. Right-click the desktop and select Graphics Properties from the menu.
OR
4. Click the icon  in the notification area of the Desktop taskbar and select Graphics Properties from the menu.

Figure 1 - 28 - Intel Iris Graphics Control Panel

3

4

4

1 - 40 Video Features



Quick Start Guide 1

To access the NVIDIA Control Panel:
1. Right-click the desktop and select NVIDIA Control Panel  (Figure 1 - 29).
OR
2. Double-click the icon   (Figure 1 - 29) in the Windows control panel.

Figure 1 - 29 - NVIDIA Control Panel

5

6

5

6
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Configuring External Displays
It is possible to quickly configure external displays from the Devices menu item in the Charms Bar (see “The
Charms Bar” on page 1 - 35).

To Configure Displays from Devices (Charms Bar):
1. Attach your display to the appropriate port, and turn it on.
2. Go the Charms Bar, select Devices.
3. Click Project (you may need to click Second Screen).
4. Click on any one of the options from the menu to select PC screen only, Duplicate, Extend or Second screen

only.

Figure 1 - 30- Devices (Project)
1 - 42 Video Features
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Power Options
Power Options (Hardware and Sound) can be accessed from the Control Panel. The Power Menu item in Set-
tings in the Charms Bar in Windows 8.1 may be used to Shut down or Restart (you can also add Hibernate/
Sleep to the menu - see “Adding Hibernate/Sleep to the Power Menu” on page 3 - 10). You can also use the
context menu (Shut down or sign out) shut the computer down/restart etc.

Figure 1 - 31 - Shut Down/Restart 

Charms Bar

Desktop App Start ScreenPower Button Start Screen
Power Options 1 - 43
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Running Apps
To run apps in Windows 8.1 you will need to check that the Screen Resolution and User Account Control Set-
tings are compatible with the system requirements.

Screen Resolution Settings
1. Switch to the Windows Desktop (click the app or use the Windows logo key  + D key combination).
2. Right-click a blank area of the Windows Desktop and select Screen Resolution. Adjust the Resolution to

make sure that it is at least 1024 * 768, although preferably 1366 * 768 or above (see sidebar).

Figure 1 - 32 - Screen Resolution


Screen Resolution for Apps 

(Windows 8.1)

The minimum resolution in which Apps will run is 1024x768. 

The minimum resolution required to support all the features of
Windows 8 (including multitasking with snap) is 1366x768. 

These specs are the minimum screen resolution that supports
all the features of Windows 8.1 on a useful physical size. 
1 - 44 Running Apps
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User Account Control Settings
If your computer meets the minimum screen resolution requirements, and still you can't run apps, then that you
have to check the status of User Account Control (UAC). Apps may fail to open when the UAC is turned off.
To check whether the UAC is on or off, follow the instructions below.

1. Open the Control Panel.
2. Click on User Accounts and then click on Change User Account Control settings (or click System and

Security and click Change User Account Control Settings under Action Center).
3. If the slider is in the Never notify position, then the UAC is disabled. 
4. To enable or turn on the UAC, move the slider to Always notify or Notify me when apps try to make changes

to my computer (default) position, and then click OK. 

Figure 1 - 33 - User Account Control Settings
Running Apps 1 - 45
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2
Chapter 2: Storage Devices, Mouse, & Audio

Overview
Read this chapter to learn more about the following main features and components
of the computer:

• Hard Disk Drive/Solid State Drive
• Multi-in-1 Card Reader
• Audio Features
• Touchpad and Buttons/Mouse
Overview 2 - 1
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 Hard Disk Drive/Solid State Drive
The hard disk drive (HDD) and/or solid state drive (SSD) is used to store your data
in the computer. The hard disk can be taken out to accommodate other serial (SATA)
hard disk drives (see “Storage” on page D - 3 for specification information), how-
ever you will need to contact your distributor/supplier to do this in order to avoid
violating the terms of your warranty.


Bottom Cover 

Removal Warning

Do not remove any cov-
er(s) and /or screw(s) for
the purposes of device
upgrade as this may vio-
late the terms of your
warranty.

If you need to replace/
remove the hard disk for
any reason, please con-
tact your distributor/sup-
plier for further
information.
2 - 2 Hard Disk Drive/Solid State Drive
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Multi-in-1 Card Reader
The card reader allows you to use some of the latest digital storage cards. Push the
card into the slot and it will appear as a removable device, and can be accessed in
the same way as your hard disk (s). Make sure you install the Card Reader driver
(see “Card Reader” on page 4 - 7).


Push-Push Card 

Reader

The card reader fea-
tures a push-in/push-out
card insertion and ejec-
tion mechanism. Simply
push the card to insert
and eject it, however Ms
Duo cards require an
adapter.

 Figure 2 - 1
Right Views

1. Card Reader


Inserting Cards 

into the Card 
Reader

Note that the cards
should be inserted
with the readable
side of the card fac-
ing upwards, as il-
lustrated on the right.

1

1

• MMC (MultiMedia Card) / RSMMC
• SD (Secure Digital) / Mini SD / SDHC / SDXC
*Note: Some of these cards require PC adapters that are usually supplied with the cards.
Multi-in-1 Card Reader 2 - 3
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 Audio Features
You can configure the audio options on your computer from the Sound  control
panel in Windows, or from the Realtek HD Audio Manager  icon in the notifi-
cation area/control panel (right-click the notification area icon  to bring up an au-
dio menu and select Sound Manager). The volume may also be adjusted by means
of the Fn + F5/F6 key combination (see Table 1 - 5, on page 1 - 17). 


Volume Adjustment

The sound volume level
can be set using the vol-
ume control in the Set-
tings menu in the
Charms Bar.

 Figure 2 - 2
Realtek Audio 

Manager

See “HDMI Audio Configuration” on page C - 27 for a description of the audio configuration
when connecting an HDMI supported display device. 
See “Sound Blaster Audio & HDMI/Mini Display Port” on page 6 - 58 for more information
on the THX TruStudio Pro Audio setup.

Right-click the icon  to ac-
cess the menu above, and then
select Sound Manager.
2 - 4 Audio Features
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Setup for Audio Recording
To record audio sources on your computer at optimum quality follow the instruc-
tions below:

1. Click Control Panel and make sure you are in Classic View.
2. Click Realtek HD Audio Manager (or right-click the notification area icon  and 

select Sound Manager).
3. Click Microphone Effects (tab) in Microphone (tab), and then click to select 

Noise Suppression (button), or adjust the Recording Volume level to around 60, 
to obtain the optimum recording quality.

4. Click OK to close the control panel and save the settings.


Headphone 

Configuration

It is recommended that
you set the Speaker
Configuration to Ste-
reo when listening
through headphones in
order to maximize audio
quality.

 Figure 2 - 3
Realtek Audio 

Manager - 
Recording Setup
Audio Features 2 - 5
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Setup for 5.1Surround Sound
To setup your system for 5.1 surround sound you will need to connect the audio ca-
bles to the Headphone-Out, Microphone-In jack and S/PDIF-Out jacks.

1. Click Start, and click Control Panel (or point to Settings and click Control Panel) 
and make sure you are in Classic View.

2. Click Realtek HD Audio Manager (or right-click the notification area icon  and 
select Sound Manager).

3. Click Speakers (tab) and click Speaker Configuration (tab).
4. Select 5.1 Speaker from the Speaker Configuration pull-down menu.


Sound Blaster Audio & 

HDMI

Note that the Sound
Blaster audio effects do
not apply to audio gen-
erated through an HDMI
connection (see page 6
- 50.).

 Figure 2 - 4
Speaker 

Configuration (5.1)


Auto Popup Dialog

You should enable the
auto popup dialog to au-
tomatically detect when a
device has been
plugged-in. If disabled,
double-click connector
settings  and click the
box to enable the auto
popup detection of
plugged-n devices.

Connector Settings
2 - 6 Audio Features
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5. Plug in the speaker cables (you may require an adapter to connect each cable to 

the appropriate jack e.g a stereo mini to dual RCA adapter) from your speakers 
into the jacks as follows:

• Headphone-Out Jack = Side Speaker Out
• Microphone-In Jack = Center/Subwoofer Speaker Out
• S/PDIF-Out Jack = Front Speaker Out

6. As you plug in each cable a dialog box will pop up (see “Auto Popup Dialog” on 
page 2 - 6).

7. Click to put a check in the appropriate box according to the speaker plugged-in 
(e.g. Rear Speaker Out), and then click OK to save the setting.

8. Click OK to exit Realtek HD Audio Manager. 
Audio Features 2 - 7
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 Touchpad and Buttons/Mouse
The Touchpad is an alternative to the mouse; however, you can also add a mouse to
your computer through one of the USB ports. The Touchpad buttons function in
much the same way as a two-button mouse.


Mouse Driver

If you are using an ex-
ternal mouse your op-
erating system may be
able to auto-configure
your mouse during its
installation or only en-
able its basic functions.
Be sure to check the
device’s user docu-
mentation for details.
2 - 8 Touchpad and Buttons/Mouse
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Touchpad Configuration
Once you have installed the TouchPad driver (see “Touchpad” on page 4 - 8) you
can configure the functions from the Mouse control panel in Windows, or by double-
clicking the TouchPad driver icon  in the notification area of the taskbar in the
Desktop app. You may then configure the TouchPad tapping, buttons, scrolling,
pointer motion and sensitivity options to your preferences. You will find further in-
formation at www.synaptics.com.


TouchPad Scrolling

This computer model se-
ries may feature different
TouchPad versions.

These TouchPads may
differ in their vertical
scrolling function in most
scrollable windows.

Some TouchPads require
sliding the finger up and
down on the right of the
TouchPad to scroll the
window. Other versions
require tapping/holding
down the finger at the top
right or bottom right of the
TouchPad to scroll the
window.

 Figure 2 - 5
Mouse Properties
Touchpad Configuration 2 - 9
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Gestures and Device Settings
The Synaptics Gestures Suite application allows you to use a specific gesture (ac-
tion) on the surface of the Touchpad to perform specific actions to manipulate doc-
uments, objects and applications.

You can configure the settings from the Device Settings tab in Mouse Properties:

1. Go to the Control Panel.
2. Click Mouse (Hardware and Sound).
3. Click Device Settings (tab) and click Settings.
4. Use the menu tree on the left to access the user configurable settings.


Show Video

You can get a clearer
view of the gestures in-
volved by clicking the
Show Video option for
each gesture item.

Select the gesture (Pinch
Zoom, Rotating, Three
Fingers Down and
Three Finger Flick) in the
Device Settings > Set-
tings left tree menu
and click the Show Video
button to see the demon-
stration video.

For more details on any of
the gestures see the help
in the lower part of the
right menu window.

 Figure 2 - 6
Mouse Properties - 

Device Settings
2 - 10 Touchpad Configuration
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Disabling the Touchpad
If you need to disable the Touchpad for any reason (e.g. you may find that when us-
ing the computer’s internal keyboard you accidentally trigger the Touchpad when
resting your wrists or palms on it) you can do so by using Fn + F1 key combination.

You can also set the system to automatically disable the internal Touchpad when an
external USB point device (e.g a USB mouse) is attached.

1. Go to the Mouse Properties control panel.
2. Click to select Device Settings (tab).
3. Click to place a check in the “Disable internal pointing device when external 

USB pointing device is attached” check box.
4. Click OK to save the setting.

 Figure 2 - 7
Mouse Properties 

(Disable Touchpad) 
Touchpad Configuration 2 - 11
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PalmCheck™ 
The PalmCheck™ feature (Device Settings > Settings > Pointing > Sensitivity)
helps prevent operating the Clickpad/Touchpad by accident, by recognizing when
your palm is resting on it or brushing its surface while you are typing. 


PalmCheck™

In order to improve
Clickpad/Touchpad
scrolling responsive-
ness when using one-
finger scrolling, you can
adjust the PalmCheck™
slider towards “Mini-
mum” as per your pref-
erence.

However bear in mind
that adjusting the slider
too far towards “Mini-
mum” can turn off Palm-
Check™ altogether.

 Figure 2 - 8
PalmCheck™ Slider
2 - 12 Touchpad Configuration
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Scrolling
The Two-Finger scrolling feature works in most scrollable windows and allows you
to scroll horizontally and vertically. Place two fingers, slightly separated, on the
TouchPad surface and slide both fingers in the direction required (in a straight con-
tinuous motion).

Zooming
The Pinch Zoom gesture can be used to perform the same function as a scroll wheel
in Windows applications that support CTRL + scroll wheel zoom functionality.
Place two fingers on the TouchPad (for best results use the tips of the fingers) and
slide them apart to zoom in, or closer together to zoom out.

 Figure 2 - 9
Scrolling Gesture

 Figure 2 - 10
Zooming Gesture
Touchpad Configuration 2 - 13
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Rotating
Use the Pivot Rotate gesture to rotate objects (e.g. photos) in 90 degree increments.
Place a finger down on the left “target” zone and keep it stationary. Place another
finger near the middle of the TouchPad and slide it in a circular motion around the
stationary finger (clockwise or counterclockwise) to rotate the object.

Three Finger-Flick/Three Fingers Down (Press)
The Three Finger-Flick gesture may be used to enhance navigation with a variety of
applications such as browsing the Internet or scrolling through a photo viewer. The
Three Fingers Down gesture may be used to launch user-selectable applications.

 Figure 2 - 11
Rotating Gesture

 Figure 2 - 12
Flick/Press 

Gesture
2 - 14 Touchpad Configuration
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Chapter 3: Power Management

Overview
To conserve power, especially when using the battery, your computer power man-
agement conserves power by controlling individual components of the computer
(the monitor and hard disk drive) or the whole system. This chapter covers:

• The Power Sources
• Turning On the Computer
• Power Plans
• Power-Saving States
• Configuring the Power Buttons
• Battery Information

The computer uses enhanced power saving techniques to give the operating system
(OS) direct control over the power and thermal states of devices and processors. For
example, this enables the OS to set devices into low-power states based on user set-
tings and information from applications.


OS Note

Power management
functions will vary slight-
ly depending on your
operating system. For
more information it is
best to refer to the user’s
manual of your operat-
ing system.
Overview 3 - 1
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The Power Sources
The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter
Use only the AC/DC adapter that comes with your computer. The wrong type of AC/
DC adapter will damage the computer and its components.

1. Attach the AC/DC adapter to the DC-in jack at the rear of the computer.
2. Plug the AC power cord into an outlet, and connect the AC power cord to the AC/

DC adapter (make sure you use the adapter when first setting up the
computer, as to safeguard the computer during shipping, the battery will be locked
to not power the system until first connected to the AC/DC adapter).

3. Raise the lid/LCD to a comfortable viewing angle.
4. Press the power button to turn “On”.

Battery
The battery allows you to use your computer while you are on the road or when an
electrical outlet is unavailable. Battery life varies depending on the applications and
the configuration you're using. To increase battery life, let the battery discharge
completely before recharging (see “Battery FAQ” on page 3 - 18).

We recommend that you do not remove the battery. For more information on the bat-
tery, please refer to “Battery Information” on page 3 - 14.


Forced Off

If the system “hangs”,
and the Ctrl + Alt + Del
key combination doesn’t
work, press the power
button for 4 seconds, or
longer, to force the sys-
tem to turn itself off.
3 - 2 The Power Sources
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Turning On the Computer
Now you are ready to begin using your computer. To turn it on simply press the pow-
er button on the front panel.

When the computer is on, you can use the power button as a Stand by/Hibernate/
Shutdown hot-key button when it is pressed for less than 4 seconds (pressing and
holding the power button for longer than this will shut the computer down). Use
Power Options (Hardware and Sound) in the Windows control panel to configure
this feature.


Power Button as Stand by or Hibernate Button

You can use the OS’s “Power Options” control panel to set the power button to send the
system into Stand by or Hibernate mode (see your OS’s documentation, or “Configuring
the Power Buttons” on page 3 - 9 for details).
Turning On the Computer 3 - 3
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Shutting the Computer Down
Note that you should always shut your computer down by choosing the Shut down
command as this will help prevent hard disk or system problems. Use the Shut down
or sign out item in the Context Menu (right-click the lower left corner of the screen
to bring up the menu).

You can also use the Power Menu in Settings in the Windows 8.1 Charms Bar. If
you want to add Hibernate/Sleep to the Power Menu see “Adding Hibernate/Sleep
to the Power Menu” on page 3 - 10.

Figure 3 - 1
Shut Down/Restart

Charms Bar Desktop App Start Screen
3 - 4 Shutting the Computer Down
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Power Plans
The computer can be configured to conserve power by means of power plans. You
can use (or modify) an existing power plan, or create a new one.

The settings may be adjusted to set the display to turn off after a specified time, and
to send the computer into Sleep after a period of inactivity. 

Click Change plan settings and then click Change advanced power settings to ac-
cess further configuration options in Advanced Settings.


Resuming 
Operation

See Table 3 - 1, on
page 3 - 11 for informa-
tion on how to resume
from a power-saving
state.

Password

It is recommended that
you enable a password
on system resume in or-
der to protect your data.

Figure 3 - 2
Power Plan 

Advanced Settings
Power Plans 3 - 5



Power Management

3

Each Windows power plan will also adjust the processor performance of your ma-
chine in order to save power. This is worth bearing in mind if you are experiencing
any reduced performance (especially under DC/battery power).

Choose High performance (you may need to click Show additional plans to view
the High performance plan) for maximum performance when the computer is pow-
ered from an AC power source. Choose the Power saver (bear in mind that this
scheme may slow down the overall performance of the computer in order to save
power) for maximum power saving when the computer is battery (DC power) pow-
ered.

Figure 3 - 3
Power Plans

Click to Show/Hide 
additional 
power plans
3 - 6 Power Plans
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Power-Saving States
You can use power-saving states to stop the computer’s operation and restart where
you left off. Win 8.1 uses the Sleep, Hibernate and Shut Down power-saving
states.

Sleep
In Sleep all of your work, settings and preferences are saved to memory before the
system sleeps. When you are not using your computer for a certain length of time,
which you specify in the operating system, it will enter Sleep to save power. 

The PC wakes from Sleep within seconds and will return you to where you last left
off (what was on your desktop) without reopening the application(s) and file(s) you
last used.

If your mobile PC in Sleep is running on battery power the system will use only a
minimum amount of power. After an extended period the system will save all the
information to the hard disk and shut the computer down before the battery becomes
depleted.

To add Sleep to the Power Menu see “Adding Hibernate/Sleep to the Power
Menu” on page 3 - 10.


Wake On LAN 

Support 

Wake-On-LAN is only
supported from Sleep or
Hibernate states in
Windows.

If you require your com-
puter to wake up from
network activity in Win-
dows then make sure
that the computer is ei-
ther in Sleep or Hiber-
nate.

Wake-On-LAN is not
supported from Shut-
down states in Win-
dows.
Power-Saving States 3 - 7
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Hibernate
Hibernate uses the least amount of power of all the power-saving states and saves
all of your information on a part of the hard disk before it turns the system off. If a
power failure occurs the system can restore your work from the hard disk; if a power
failure occurs when work is saved only to memory, then the work will be lost. Hi-
bernate will also return you to where you last left off within seconds. You should
put your mobile PC into Hibernate if you will not use the computer for a period of
time, and will not have the chance to charge the battery. To add Hibernate to the
Power Menu see “Adding Hibernate/Sleep to the Power Menu” on page 3 - 10.

Shut down
You should Shut down the computer if you plan to install new hardware (don’t for-
get to remove the battery and follow all the safety instructions in Chapter 6), plan
to be away from the computer for several days, or you do not need it to wake up and
run a scheduled task. Returning to full operation from Shut down takes longer than
from Sleep or Hibernate.

Figure 3 - 4
Power Menu
3 - 8 Power-Saving States
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Configuring the Power Buttons
The power/sleep button (Fn + F12 key combo) and closed lid may be set to send the
computer in to a power-saving state. Click Choose what the power buttons do on
the left menu in Power Options to bring up the menu.


Password 
Protection

It is recommended that
you enable a password
on wake up in order to
protect your data.

However you can dis-
able this setting from the
Power Options menu
by clicking Require a
password on wakeup
in the left menu, and se-
lecting the options (click
Change settings that
are currently unavail-
able).

Figure 3 - 5
Power Options 
Define Power 

Buttons
Configuring the Power Buttons 3 - 9
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Adding Hibernate/Sleep to the Power Menu
Add Hibernate/Sleep to the Power Menu as follows.

1. Go to the Power Options (Hardware and Sound) control panel (see page 1 - 43).
2. Click “Change settings that are currently unavailable” .
3. Click Choose what the power buttons do.
4. Click to put a check in the Hibernate/Sleep box under Shutdown settings.
5. Click Save Changes and close the control panel.

Figure 3 - 6
Power Options 
Define Power 

Buttons - Shutdown 
Settings
3 - 10 Configuring the Power Buttons
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Resuming Operation
You can resume operation from power-saving states by pressing the power button,
or in some cases pressing the sleep button (Fn + F12 key combo).

Power Status Icon  Color To Resume

Power Off Off Press the Power Button

Sleep Blinking Green

Press the Power Button

Press the Sleep Button (Fn + F12 Key 
Combo)

Hibernate
Off (battery)

Press the Power Button
Orange (AC/DC adapter)

Display Turned Off Green Press a Key or Move the Mouse/Touchpad

Table 3 - 1
Resuming 

Operation


Closing the Lid

If you have chosen to
send the computer to
Sleep when the lid is
closed, raising the lid
will wake the system up.


Power Button

When the computer is on, you can use the power button as a Sleep/Hibernate/Shut Down
hot key button when it is pressed for less than 4 seconds (pressing and holding the power
button for longer than this will force the computer to shut down).
Configuring the Power Buttons 3 - 11
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Power Conservation Modes
This system supports Energy Star power management features that place comput-
ers (CPU, hard drive, etc.) into a low-power sleep modes after a designated period
of inactivity. Adjust Power Conservation Modes from the Control Center:

1. Press the Fn + Esc key combination to toggle the Control Center on/off.
2. Click either the Performance, Balanced or Energy Star button.


Power Conservation 

Modes

The Energy Star setting
will result in maximum
power saving, but with
the possible loss of
some performance.

Setting the mode to Bal-
ance will give power
saving matched with
performance. 

Performance will give
optimum computer per-
formance but with less
power conservation.

Note that the Energy
Star setting will put the
display into sleep after
no more than 15 min-
utes of user inactivity.

Figure 3 - 7
Control Center
3 - 12 Configuring the Power Buttons
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Ctrl + Alt + Delete Key Combination
You can use the CTRL + ALT + DEL key combination from almost any of the Win-
dows 8 interfaces/Apps to bring up a full-screen displaying Lock, Switch User, Log
off, Change a password and Task Manager options. If you click the Power icon
in the lower right corner of the screen a power management option menu appears to
display Sleep, Shut down, and Restart.

To fully control all the power options (including Hibernate mode) go to the Power
Options control panel and configure the power button, sleep button and lid to per-
form the function selected.

Figure 3 - 8
Ctrl + Alt + Delete 

Menu
Configuring the Power Buttons 3 - 13
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Battery Information
Follow these simple guidelines to get the best use out of your battery.

Battery Power
Your computer’s battery power is dependent upon many factors, including the pro-
grams you are running, and peripheral devices attached. You can set actions to be
taken (e.g. Shut down, Hibernate etc.), and set critical and low battery levels from
power plan Change plan settings > Change advanced power settings (see Figure
3 - 3 on page 3 - 6).

Click the battery icon  in the notification area to see the current battery level and
charge status.


Low Battery 

Warning

When the battery is criti-
cally low, immediately
connect the AC/DC
adapter to the computer
or save your work, oth-
erwise, the unsaved
data will be lost when
the power is depleted.

Figure 3 - 9
Battery Icon 

(Notification Area) & 
Battery Advanced 

Settings
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Conserving Battery Power
• Use a power plan that conserves power (e.g Power saver), however note that 

this may have an affect on computer performance.

• Lower the brightness level of the LCD display. The system will decrease LCD 
brightness slightly to save power when it is not powered by the AC/DC adapter.

• Reduce the amount of time before the display is turned off.

• Close wireless, Bluetooth, modem or communication applications when they are 
not being used.

• Disconnect/remove any unnecessary external devices e.g. USB devices, 
ExpressCards etc.


Windows Mobility 

Center

The Windows Mobility
Center control panel
provides an easy point
of access for information
on battery status, power
plans used and wireless
device status etc.

Figure 3 - 10
Windows Mobility 

Center
Battery Information 3 - 15
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Battery Life
Battery life may be shortened through improper maintenance. To optimize the life
and improve its performance, fully discharge and recharge the battery at least
once every 30 days.

New Battery
Always completely discharge, then fully charge, a new battery (see “Battery FAQ”
on page 3 - 18 for instructions on how to do this).

Recharging the Battery with the AC/DC Adapter
The battery pack automatically recharges when the AC/DC adapter is attached and
plugged into an electrical outlet. If the computer is powered on, and in use, it will
take several hours to fully recharge the battery. When the computer is turned off but
plugged into an electrical outlet, battery charge time is less. Refer to “LED Indica-
tors” on page 1 - 11 for information on the battery charge status, and to “Battery
Information” on page 3 - 14 for more information on how to maintain and properly
recharge the battery pack.
3 - 16 Battery Information
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Proper handling of the Battery Pack
• DO NOT disassemble the battery pack under any circumstances
• DO NOT expose the battery to fire or high temperatures, it may explode
• DO NOT connect the metal terminals (+, -) to each other


Caution

Danger of explosion if
battery is incorrectly re-
placed.

Replace only with the
same or equivalent type
recommended by the
manufacturer. Discard
used battery according
to the manufacturer’s in-
structions.


Damaged Battery Warning

Should you notice any physical defects (e.g. the battery is bent out of shape after being
dropped), or any unusual smells emanating from the notebook battery, shut your computer
down immediately and contact your distributor/supplier. If the battery has been dropped we
do not recommend using it any further, as even if the computer continues to work with a
damaged battery in place, it may cause circuit damage, which may possibly result in fire. It
is recommended that you replace your computer battery every two years.
Battery Information 3 - 17
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Battery FAQ
How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low battery. Don’t
turn off the computer even if a message indicates the battery is critically low, just let
the computer use up all of the battery power and shut down on its own.

1. Save and close all files and applications.
2. Create a power plan for discharging the battery and set all the options to Never.

Figure 3 - 11
Power Plan Create
3 - 18 Battery Information
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3. Click Change plan settings (after creating it) and click Change plan settings > 
Change advanced power settings.

Figure 3 - 12
Change Plan 

Settings / Change 
Advanced Power 

Settings
Battery Information 3 - 19
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4. Scroll down to Battery and click + to expand the battery options.
5. Choose the options below (click Yes if a warning appears):

• Low battery levels = 0%
• Critical battery Levels = 1%
• Low battery action = Do Nothing
• Critical battery action (On battery) = Shut Down
• Critical battery action (Plugged in) = Do Nothing

Figure 3 - 13
Power Options 

Advanced Settings - 
Battery
3 - 20 Battery Information
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How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light changes
from orange to green.

How do I maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after
about 20 partial discharges.
Battery Information 3 - 21
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Chapter 4: Drivers & Utilities
This chapter deals with installing the drivers and utilities essential to the operation or
improvement of some of the computer’s subsystems. The system takes advantage of
some newer hardware components for which the latest versions of most available op-
erating systems haven’t built in drivers and utilities. Thus, some of the system com-
ponents won’t be auto-configured with an appropriate driver or utility during
operating system installation. Instead, you need to manually install some system-re-
quired drivers and utilities.

What to Install
You will need to attach an external optical CD/DVD device drive to install the
drivers from the Device Drivers & Utilities + User’s Manual disc. The disc con-
tains the drivers and utilities necessary for the proper operation of the computer. Ta-
ble 4 - 1, on page 4 - 4 lists what you need to install and it is very important that
the drivers are installed by the method outlined in this chapter, and in the order
indicated. Note that the information on the following pages is for Windows 8.1 (64-
bit) only. For Windows 10 driver installation see “Windows 10 Drivers & Utilities”
on page E - 15.

Module Driver Installation
The procedures for installing drivers for the Wireless LAN, Bluetooth & WLAN
Combo, Intel Technology, Sound Blaster Cinema and 4G modules are provided
in “Modules” on page 6 - 1.


Driver Installation & 

Power

When installing driv-
ers make sure your
computer is powered
by the AC/DC adapter
connected to a work-
ing power source.
Some drivers draw a
significant amount of
power during the instal-
lation procedure, and if
the remaining battery
capacity is not adequate
this may cause the sys-
tem to shut down and
cause system problems
(note that there is no
safety issue involved
here, and the battery will
be rechargeable within 1
minute).
What to Install 4 - 1
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Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into an attached DVD drive.
2. Click the message “Tap to choose what happens with this disc.”
3. Click Run autorun.exe.
4. Click Install Drivers (button), or Option Drivers (button) to access the Optional driver menu.

Figure 4 - 1 - Drivers Installer Screen 1
4 - 2 Driver Installation
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5. Check the driver installation order from Table 4 - 1, on page 4 - 4 (the drivers must be installed in this order) 
which is the same as that listed in the Drivers Installer menu below.

6. Click to select the driver you wish to install, (you should note down the drivers as you install them).
7. Follow the instructions for each individual driver installation procedure as listed on the following pages.

Figure 4 - 2 - Install Drivers
Driver Installation 4 - 3
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Table 4 - 1 - Driver Installation

Note that you need to install both the WLAN & Bluetooth drivers for the WLAN & Bluetooth Combo modules.

Win 8.1 (64-bit) Driver Page # Win 8.1 (64-bit) - Optional Items Page #

Chipset Page 4 - 7 Setting Up SATA RAID or AHCI Mode Page 6 - 2

Video (VGA) Page 4 - 7 PC Camera Module (no driver installation required) Page 6 - 11

NVIDIA Video (VGA) Page 4 - 7 Wireless LAN Module Page 6 - 20

LAN Page 4 - 7 Bluetooth & WLAN Combo Module Page 6 - 26

Card Reader Page 4 - 7
Intel® Rapid Storage Technology
(required for hard disks in AHCI & RAID modes)

Page 6 - 32

Touchpad Page 4 - 8 Intel® Rapid Start Technology Driver Page 6 - 42

Hot Key Page 4 - 8 Sound Blaster Audio Page 6 - 50

Airplane Page 4 - 8 Fingerprint Reader Module Page 6 - 60

MEI Driver Page 4 - 8 Trusted Platform Module (no driver installation required) Page 6 - 64

Audio Page 4 - 8 3G/4G Module (no driver installation required) Page 6 - 70

Wireless Display (no driver installation required) Page 6 - 75

All drivers provided are for the Windows 8.1 (64-bit) operating system.
4 - 4 Driver Installation
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Manual Driver Installation
Click Browse CD/DVD (button) in the Drivers Install-
er application and browse to the executable file in the
appropriate driver folder.

Windows Update
After installing all the drivers make sure you enable
Windows Update in order to get all the latest security
updates etc. (all updates will include the latest hotfixes
from Microsoft). See “Windows Update” on page 4 -
9 for instructions.

Updating/Reinstalling Individual Drivers
If you wish to update/reinstall individual drivers it
may be necessary to uninstall the original driver.To do
this go to the Control Panel in the Windows OS and
double-click the Programs and Features icon (Pro-
grams > Uninstall a program). Click to select the
driver (if it is not listed see below) and click Uninstall,
and then follow the on screen prompts (it may be nec-
essary to restart the computer). Reinstall the driver as
outlined in this chapter.

If the driver is not listed in the Programs and Fea-
tures menu:

1. Go to the Control Panel).
2. Double-click Device Manager (Hardware and 

Sound > Devices and Printers > Device 
Manager).

3. Double-click the device you wish to update/reinstall 
the driver for (you may need to click “+” to expand 
the selection).

4. Click Driver (tab) and click the Update Driver or 
Uninstall button and follow the on screen prompts.
Driver Installation 4 - 5



Drivers & Utilities

4

User Account Control
If a User Account Control prompt appears as part of
the driver installation procedure, click Continue or
Allow, and follow the installation procedure as direct-
ed.

Windows Security Message
If you receive a Windows security message as part of
the driver installation process. Just click “Install this
driver software anyway” or “Install” to continue the
installation procedure.

You will receive this message in cases where the driv-
er has been released after the version of Windows you
are currently using. All the drivers provided will have
already received certification for Windows.

New Hardware Found
If you see the message “New Hardware Found” dur-
ing the installation procedure (other than when out-
lined in the driver install procedure), click Cancel
to close the window, and follow the installation proce-
dure.


Driver Installation General Guidelines

The driver installation procedure outlined in this Chapter
(and in Chapter 7 Options & Modules), are accurate at
the time of going to press.

Drivers are always subject to upgrade and revision so
the exact procedure for certain drivers may differ slight-
ly. As a general guide follow the default on screen in-
structions for each driver (e.g. Next > Next > Finish)
unless you are an advanced user. In many cases a re-
start is required to install the driver.

Make sure any modules (e.g. WLAN or Bluetooth) are
ON (i.e. the system is not in Airplane Mode) before
installing the appropriate driver.
4 - 6 Driver Installation
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Driver Installation Procedure
Insert the Device Drivers & Utilities + User’s Manual
disc and click Install Drivers (button).

Chipset
1. Click 1.Install Chipset Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

Video (VGA)
1. Click 2.Install VGA Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

NVIDIA Video (VGA)
1. Click 3.Install NVIDIA VGA Driver > Yes.
2. Click AGREE AND CONTINUE (button) to 

accept the terms of the license agreement.
3. Click Next.
4. Click the Close to complete the installation.

Note: After installing the video driver go to the Dis-
play/Display Settings control panel to adjust the vid-
eo settings to the highest resolution.

LAN
Note: If the computer enters a deep sleep mode during
installation, you will be prompted to plug in a network
cable, and click OK, to continue installation. If a net-
work cable is not available, restart the system and re-
install the LAN driver.

1. Click 4.Install LAN Driver > Yes.
2. Click Next > Install.
3. Click Finish.

Card Reader
1. Click 5.Install Cardreader Driver > Yes.
2. Click Finish.
Driver Installation 4 - 7
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Touchpad
1. Click 6.Install Touchpad Driver > Yes.
2. Click Next.
3. Click the button to accept the license agreement 

and click Next.
4. Click Finish > Restart Now to restart the com-

puter.

Hot Key
1. Click 7.Install Hotkey AP > Yes.
2. Click Next.
3. Click Finish to restart your computer.
4. After restart a control panel will pop-up to allow 

you to select the type of keyboard for your system 
(see “Flexikey® Application” on page 1 - 14 
and Appendix B).

Airplane
Note: Do not use Update Driver in Device Manager to
install the Airplane mode driver.

1. Click 8.Install Airplane Driver > Yes. 
2. Click Next.
3. Click Finish to restart the computer.

MEI Driver
1. Click 9.Install MEI Driver > Yes.
2. Click Next.
3. Click the check box to accept the license and 

then click Next.
4. Click Next.
5. Click Finish.

Audio
1. Click 10. Install Audio Driver > Yes.
2. Click Next > Next.
3. Click Finish to restart the computer.

See overleaf.
4 - 8 Driver Installation
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After installing the audio driver the system will not re-
turn to the Drivers Installer screen. To install any of
the optional drivers, eject the Device Drivers & Utili-
ties + User’s Manual disc and then reinsert it (or dou-
ble-click the disc icon in My Computer), and click
Option Drivers (button) to access the optional driver
menu.

It is recommended that you install the Sound Blaster
Audio application (see “Sound Blaster Audio” on
page 6 - 50) and Intel Rapid Storage Technology
driver (see “Intel® Rapid Storage Technology” on
page 6 - 32 - required for AHCI & RAID mode).


Windows Update

After installing all the drivers make sure you enable Win-
dows Update in order to get all the latest security up-
dates etc. (all updates will include the latest hotfixes
from Microsoft).

To enable Windows Update make sure you are con-
nected to the internet:

1. Go to the Control Panel.
2. Click Windows Update (System and Security/

Security).
3. Click Check for updates (button).
4. The computer will now check for updates (you 

need to be connected to the internet).
5. Click Install now (button) to begin checking for the 

updates.
6. Click Install updates (button) to install the 

updates.
Driver Installation 4 - 9
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Optional Drivers
See the pages indicated in Table 4 - 1, on page 4 - 4 for the driver installation procedures for any modules in-
cluded in your purchase option.

Figure 4 - 3 - Optional Drivers Installer Screen

Note that you need to install both the WLAN & Bluetooth drivers for the WLAN & Bluetooth Combo modules.

Models A & B
4 - 10 Driver Installation
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Chapter 5: BIOS Utilities

Overview
This chapter gives a brief introduction to the computer’s built-in software: 

Diagnostics: The POST (Power-On Self Test)

Configuration: The Setup utility 
If your computer has never been set up, or you are making important changes to the
system (e.g. hard disk setup), then you should review this chapter first and note the
original settings found in Setup. Even if you are a beginner, keep a record of the set-
tings you find and any changes you make. This information could be useful if your
system ever needs servicing.

There is one general rule: Don’t make any changes unless you are sure of what you
are doing. Many of the settings are required by the system, and changing them could
cause it to become unstable or worse. If you have any doubts, consult your service
representative.


BIOS Screens

Note that the BIOS
screens pictured on
these pages are intend-
ed for guidance in set-
ting up your system’s
BIOS.

BIOS versions are sub-
ject to constant change
and revision, therefore
your computer’s actual
screens may appear
slightly different from
those pictured on these
pages. 
Overview 5 - 1
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The Power-On Self Test (POST)
If you enable the Boot-time Diagnostic Screen in the Setup Utility, each time you
turn on the computer the system takes a few seconds to conduct a POST, including
a quick test of the on-board RAM (memory).

As the POST proceeds, the computer will tell you if there is anything wrong. If there
is a problem that prevents the system from booting, it will display a system summary
and prompt you to run Setup. 

If there are no problems, the Setup prompt will disappear and the system will load
the operating system. Once that starts, you can’t get into Setup without rebooting.


BIOS Settings 

Warning

Incorrect settings can
cause your system to
malfunction. To correct
mistakes, return to Set-
up and restore the Opti-
mized Defaults with
<F3>.

UEFI Boot & POST

When UEFI Boot is en-
abled, then the prompts
to press F2 or F7 will
not appear. However
you can still press F2 to
enter the setup, or F7 to
choose the preferred
boot device, if you press
the key immediately the
system boots up.
5 - 2 The Power-On Self Test (POST)
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Failing the POST
Errors can be detected during the POST. There are two categories, “fatal” and “non-
fatal”.

Fatal Errors
These stop the boot process and usually indicate there is something seriously wrong
with your system. Take the computer to your service representative or authorized
distributor/supplier as soon as possible.

Non-Fatal Errors
This kind of error still allows you to boot. You will get a message identifying the
problem (make a note of this message!) and you can then press F7 (the F7 on screen
will be highlighted to illustrate that the system is processing the request) for boot op-
tions.

Press F2 (give the system a few seconds to enter Setup; the F2 on screen will be
highlighted to illustrate that the system is processing the request) to run the Setup
program and try to correct the problem. If you still get an error message after you
change the setting, or if the “cure” seems even worse, call for help.
The Power-On Self Test (POST) 5 - 3
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The Setup Utility
The Aptio Setup Utility tells the system how to configure itself and manage basic
features and subsystems (e.g. port configuration).

Entering Setup
To enter Setup, turn on the computer and press F2 (give the system a few seconds
to enter Setup; the F2 on screen will be highlighted to illustrate that the system is
processing the request) during the POST (or press F7 for boot options). If you get a
“Keyboard Error”, (usually because you pressed F2 too quickly) just press F2 again. 

If the computer is already on, reboot using the Ctrl + Alt + Delete combination and
then hold down F2 when prompted. The Setup main menu will appear.

To see the boot options press F7.


BIOS Settings 

Warning

Incorrect settings can
cause your system to
malfunction. To correct
mistakes, return to Set-
up and restore the Opti-
mized Defaults with
<F3>.
5 - 4 The Setup Utility
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Setup Screens
The following pages contain additional advice on portions of the Setup. Along the
top of the screen is a menu bar with menu headings. When you select a heading, a
new screen appears. Scroll through the features listed on each screen to make chang-
es to Setup.

Instructions on how to navigate each screen are in the box at the bottom right side of
the screen.

If these tools are confusing, press F1 to call up a General Help screen, and then use
the arrow keys to scroll up or down the page.

The Item Specific Help on the upper right side of each screen explains the highlight-
ed item and has useful messages about its options.

If you see an arrow  next to an item, press Enter to go to a sub-menu on that sub-
ject. The sub-menu screen that appears has a similar layout, but the Enter key may
execute a command.


Setup Menus

The Setup menus
shown in this section are
for reference only. Your
computer’s menus will
indicate the configura-
tion appropriate for your
model and options.

Figure 5 - 1
Navigation Menu
The Setup Utility 5 - 5
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Main Menu

System Time & Date (Main Menu)
The hour setting uses the 24-hour system (i.e., ØØ = midnight; 13 = 1 pm). If you
can change the date and time settings in your operating system, you will also change
these settings. Some applications may also alter data files to reflect these changes.

Figure 5 - 2
Main Menu
5 - 6 Main Menu
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SATA Port # (Main Menu)
Pressing Enter opens the sub-menu to show the configuration of a optical Device/
HDD on the computer’s SATA Ports.

OffBoard SATA Controller Configuration (Main Menu)
Pressing Enter opens the sub-menu to show the configuration of any devices on the
off board SATA Controller if applicable.

System/Extended Memory (Main Menu)
This item contains information on the system memory, and is not user configurable.
The system will auto detect the amount of memory installed.

MB Series / BIOS Revision / KBC/EC firmware Revision/Mac Address (Main
Menu)
This item contains information on the BIOS version, and the identifier address for
the device on a network, and is not user configurable.
Main Menu 5 - 7



BIOS Utilities

5

Advanced Menu

Advanced Chipset Control (Advanced Menu)
The sub-menu here allows you to change the device installed in the Combo Slot.

Figure 5 - 3
Advanced Menu
5 - 8 Advanced Menu
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Combo Slot 
(Advanced Menu > Advanced Chipset Control)
Select which device is installed in the Combo slot from this menu option. Select the
appropriate device installed in the slot from the menu, and then save the changed
BIOS settings. You will then need to shutdown the system and remove the AC/
DC adapter. You should then plug the AC/DC adapter back in again and restart the
computer to have the system recognize the changes made.


Combo Slot Support

Note that 3G device will
only be available as a
selectable option if you
have included it in your
purchase configuration.

Figure 5 - 4
Advanced Chipset 

Control
(Advanced Menu)
Advanced Menu 5 - 9
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Intel(R) Rapid Start Technology (Advanced Menu)
Enable/disable Intel(R) Rapid Start Technology from this menu. The rapid start
hibernation mode can resume power within 7 to 9 seconds and can remember your
computer's state with zero power. Note that Intel(R) Rapid Start Technology is not
supported in Windows 10.

Intel(R) Rapid Storage Technology (Advanced Menu)
Enable/disable Intel(R) Rapid Storage Technology from this menu to provide
high-performance SATA RAID capabilities for Windows, however note that this
menu will only appear if you have set the SATA mode to RAID. For instructions
on setting set up your HDDs/SSDs in a RAID see “SATA RAID Setup Procedure
(Windows 8.1)” on page 6 - 4.

SATA Mode (Advanced Menu)
You can configure SATA (Serial ATA) control to operate in AHCI (Advanced Host
Controller Interface) or RAID (Redundant Array of Independent disks) modes from
this menu. The SATA Mode should be set BEFORE installing an operating sys-
tem, and after you have backed up all necessary files and data (see sidebar). See
“Setting Up SATA RAID or AHCI Mode” on page 6 - 2 for details. Make sure you
install the Intel Rapid Storage Technology application if you have set the SATA
Mode to RAID, or to AHCI “IRST Driver Installation” on page 6 - 9.

If you wish to change your SATA mode to/from AHCI/RAID mode you will receive
a message (see overleaf) to notify you that doing so may prevent your operating sys-


SATA Mode 

Selection

If you have installed the
Windows OS with ei-
ther AHCI or RAID
mode enabled, DO NOT
disable the set mode (if
you wish to disable the
set mode you will need
to reinstall the Windows
OS).
5 - 10 Advanced Menu
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tem from booting, and may require a reinstall of the OS. If you do wish to change
the SATA mode then backup any necessary data on your hard disk(s) as you will
need wipe the disks clean in order to prevent system problems.

Boot Logo (Advanced Menu)
Use this menu item to enable/disable the Boot Logo screen at system startup if you
have not enabled UEFI Boot. If you disable the Boot Logo you will not see the F2
Enter Setup or F7 Boot Options prompts on the screen, however you can still press
these keys, while the boot screen is displayed, to perform the Enter Setup or Boot
Option functions. 

Power On Boot Beep (Advanced Menu)
Use this menu item to enable/disable the beep as the computer starts up.

Battery Low Alarm Beep (Advanced Menu)
Use this menu item to enable/disable the battery low alarm beep.

Figure 5 - 5
SATA Mode Change 

Notification
Advanced Menu 5 - 11
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Security Menu

Set Supervisor Password (Security Menu)
You can set a password for access to the Aptio Setup Utility. This will not affect
access to the computer OS (only the Aptio Setup Utility).


Security Menu

The changes you make
here affect the access
to the Setup utility itself,
and also access to your
machine as it boots up
after you turn it on.
These settings do not
affect your machine or
network passwords
which will be set in your
software OS.

Figure 5 - 6
Security Menu
5 - 12 Security Menu
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Note: To clear existing passwords press Enter and type the existing password, then
press Enter for the new password (without typing any password entry) and Enter
again to confirm the password clearance.

Note: You can only set the user password after you have set the supervisor pass-
word.

Set User Password (Security Menu)
You can set a password for user mode access to the Aptio Setup Utility. This will
not affect access to the computer OS, (only the Setup utility) unless you choose to
set a Password on Boot (see below). Many menu items in the Aptio Setup Utility
cannot be modified in user mode. 

Note: You can only set the user password after you have set the supervisor pass-
word.

Password on boot: (Security Menu)
Specify whether or not a password should be entered to boot the computer (you may
only set a password on boot if a supervisor password is enabled). If “Enabled”
is selected, only users who enter a correct password can boot the system (see the
warning in the sidebar). The default setting is “Disabled”. 


Password Warning

If you set a boot pass-
word (Password on boot
is “Enabled“), NEVER
forget your password. 

The consequences of
this could be serious. If
you cannot remember
your boot password you
must contact your ven-
dor and you may lose all
of the information on
your hard disk.
Security Menu 5 - 13
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Secure Boot Control (Security Menu)
Secure Boot Control prevents unauthorized operating systems and software from
loading during the startup process. Secure Boot is available as a menu option if you
have enabled UEFI Boot (see “Boot Menu” on page 5 - 16). Enabling Secure Boot
will bring up the Secure Boot Mode menu to enable you to configure Secure Boot
as Standard (with a fixed secure boot policy), or Custom (which enables you to
make changes to the Key Management database). 
5 - 14 Security Menu
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TPM Configuration (Security Menu)
This sub-menu will allow you to enable/disable Trusted Platform Module (TPM)
support, and to configure the TPM State. Select TPM Configuration and press En-
ter to access the sub-menu. Press Enter to access the Security Device Support menu
and select Enable to support TPM.

Figure 5 - 7
Security Device 

Support
Security Menu 5 - 15
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Boot Menu

When you turn the computer on it will look for an operating system (e.g. Windows
7) from the devices listed in this menu, and in this priority order. If it cannot find
the operating system on that device, it will try to load it from the next device in the
order specified in the Boot Option Priorities.

Figure 5 - 8
Boot Menu


BIOS Screens

Note that the BIOS
screens pictured on
these pages are intend-
ed for guidance in set-
ting up your system’s
BIOS.

BIOS versions are sub-
ject to constant change
and revision, therefore
your computer’s actual
screens may appear
slightly different from
those pictured on these
pages. 
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Boot Option Priorities (Boot Menu)
Press Enter to select the Boot Option # and use the arrow keys to select any device
in order to move its boot priority up and down the list (the selected device will be
highlighted in white).

UEFI Boot (Boot Menu)
Enable/disable UEFI Boot from this menu. The Unified Extensible Firmware Inter-
face (UEFI) specification provides a clean interface between operating systems and
platform firmware at boot time. In contrast to BIOS, UEFI defines a set of standard
boot and runtime services. The Network Stack item will be enabled as an option un-
der UEFI Boot.

Launch CSM (Boot Menu)
Launching CSM allows for traditional operating systems, which do not support UE-
FI, to load. Do not Enable this item for Windows 8.1 operating systems. When
Secure Boot (“Secure Boot Control (Security Menu)” on page 5 - 14) is Enabled
this item will not be selectable. 
Boot Menu 5 - 17
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Exit Menu

Click Save Changes and Reset to save all changes made. Choosing to Discard
Changes, or Exit Discarding Changes, will wipe out any changes you have made
to the Setup. You can also choose to restore the original Setup defaults that will re-
turn the Setup to its original state, and erase any previous changes you have made in
a previous session.

Figure 5 - 9
Exit Menu
5 - 18 Exit Menu
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Chapter 6: Modules

Overview
This chapter contains the information on the various modules (some of which are
optional) which may come with your computer, depending on the configuration
purchased. If you are unsure please contact your service representative.

The chapter includes information on the following:

Note that the information on the following pages is for Windows 8.1 (64-bit) only.
For Windows 10 driver installation see “Windows 10 Drivers & Utilities” on page E
- 15.

• Setting Up SATA RAID or AHCI 
Mode

• PC Camera Module
• Wireless LAN Module
• Bluetooth & WLAN Combo Module
• Intel® Rapid Storage Technology
• Intel® Smart Response Technology

• Intel® Rapid Start Technology 
Driver

• Sound Blaster Audio
• Fingerprint Reader Module
• Trusted Platform Module
• 3G/4G Module
• Wireless Display
Overview 6 - 1
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Setting Up SATA RAID or AHCI Mode
AHCI Mode
Advanced Host Controller Interface (AHCI) is an interface specification that allows
the storage driver to enable advanced serial ATA features such as Native Command
Queuing (for maximum hard disk efficiency and performance). AHCI mode can be
supported by one or two hard disks/solid state drives. Make sure you install the In-
tel® Rapid Storage Technology application if you have set up your HDDs/SSDs
in AHCI mode (see “Intel® Rapid Storage Technology” on page 6 - 32)

RAID
To configure your RAID (Redundant Array of Independent Disks) system in Strip-
ing (RAID 0), Mirroring (RAID 1) or Recovery modes (see Table 6 - 1, on page 6 -
3) you will require at least two identical (see sidebar) HDDs/SSDs.

Intel® Rapid Storage Technology Application
Make sure you install the Intel® Rapid Storage Technology application if you
have set up your HDDs/SSDs in RAID mode (see “Intel® Rapid Storage Technol-
ogy” on page 6 - 32).


RAID Hard Disks/
Solid State Drives

All HDDS/SSDs in a
RAID should be identi-
cal (the same size and
brand) in order to pre-
vent unexpected system
behavior.

SATA Mode 
Selection

The SATA mode selec-
tion should be made be-
fore installing your
operating system. 

DO NOT change your
selected SATA mode
unless you intend to re-
install your operating
system. Make sure you
have backed up all your
data before doing so.
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RAID Level Description

RAID 0
Identical drives reading and writing data in parallel to increase performance. RAID 0 
implements a striped disk array and the data is broken into blocks and each block is 
written to a separate disk drive.

RAID 1

Identical drives in a mirrored configuration used to protect data. Should a drive that is 
part of a mirrored array fail, the mirrored drive (which contains identical data) will 
handle all the data. When a new replacement drive is installed, data to the new drive is 
rebuilt from the mirrored drive to restore fault tolerance.

Recovery
Two Identical drives copying data between a master and a recovery disk. This provides 
more control over how data is copied between the master and recovery drives, fast 
volume updates and the ability to view the data in Windows Explorer.

Table 6 - 1
RAID Levels


Array Types

A Mirrored Array
(RAID 1) provides full
data protection, as
data can simply be
copied from a healthy
disk to a replacement
for any failed disk.

A Striped Array
(RAID 0) is NOT fault-
tolerant. The failure of
one drive will result in
the loss of all data in
the array. It is de-
signed to increase disk
performance by
spreading the I/O load
across the channels
and drives.


SATA Mode Selection

The SATA mode selection should be made before installing your operating system. 

DO NOT change your selected SATA mode unless you intend to reinstall your operating
system. Make sure you have backed up all your data before doing so.

RAID Hard Disks/Solid State Drives

All hard disks/solid state drives in a RAID should be identical (the same size and brand) in
order to prevent unexpected system behavior.
Setting Up SATA RAID or AHCI Mode 6 - 3
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SATA RAID Setup Procedure (Windows 8.1)
To configure your RAID (Redundant Array of Independent Disks) system in Strip-
ing (RAID 0) or Mirroring (RAID 1) modes (see Table 6 - 1, on page 6 - 3) you will
require two identical (see sidebar) hard disks or solid state drives.

You need to setup a RAID before installing your Windows 8.1 operating system, and
you will need to prepare the following in order to do so.
==========================================================
• The Microsoft Windows 8.1 OS DVD.
• An attached external DVD drive.
• A hard disk installed in the Primary HDD bay and a second (identical) hard disk 

installed in the Secondary HDD bay.
OR
Two Identical solid state drives.

• The Device Drivers & Utilities + User’s Manual disc.
==========================================================
1. Start-up your notebook computer and press <F2> to enter the BIOS.
2. Go to the Boot menu, select UEFI Setting and press <Enter> (see page 5 - 16).
3. Set UEFI Boot to “Enabled”.
4. Press <Esc> to exit the menu and go to the Advanced menu.
5. Select SATA Mode (see page 5 - 10), press <Enter> and select “RAID Mode”.
6. Press <F4> and <Yes> to “Save Changes and Reset”.
7. After computer restarts press <F2> to enter the BIOS again.
8. Go to Intel(R) Rapid Storage Technology (Advanced menu) and press <Enter>.
6 - 4 Setting Up SATA RAID or AHCI Mode
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9. Select Create RAID Volume and press <Enter>.

10. You can now setup your RAID volume using any two installed disks.
11. Go to Name: and press <Enter>.
12. Type a name of your choice for your RAID volume and press <Enter>.

Figure 6 - 1
Create RAID Volume 
(Advanced > Intel(R) 

Rapid Storage 
Technology

Figure 6 - 2
Name the RAID 

Volume (Advanced 
> Intel(R) Rapid 

Storage 
Technology)
Setting Up SATA RAID or AHCI Mode 6 - 5
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13. Go to RAID Level: and press <Enter>.
14. Choose the RAID Level required (see Table 6 - 1, on page 6 - 3 for details) and 

press <Enter>.

• RAID0 (Stripe)
• RAID1 (Mirror)
• Recovery

15. Go to any of the disks listed under Select Disks: and select a disk name and 
press <Enter>.

16. Move the cursor down (use the arrow keys) onto to X (o select the disk required 
and press <Enter>.

• If you have selected a Recovery level RAID then you need to select one disk to 
be Master disk (M) and one disk to be the Recovery disk (R)

Figure 6 - 3
Select Disks 

(Advanced > Intel(R) 
Rapid Storage 
Technology)

For Recovery 

For Stripe or Mirror 
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17. You should select two identical disks/SSDs to form your RAID volume.
18. If you have selected RAID0 (Stripe) then you can adjust the “Strip Size” to your 

requirements.
19. If you have selected Recovery then you can adjust the Synchronization to “On 

Request” or “Continuous”.
20. Go to Create Volume and press <Enter>.
21. The RAID volume will then be created and the RAID information will be displayed 

under Intel(R) Rapid Storage Technology (in the Advanced menu).

Figure 6 - 4
Created RAID 
Information 

(Advanced > Intel(R) 
Rapid Storage 
Technology)
Setting Up SATA RAID or AHCI Mode 6 - 7
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22. Press <Esc> to exit the menu.
23. Press <F4> and <Yes> to “Save Changes and Reset”, however ensure that the 

condition in the bulleted point below is met before doing so.

• Make sure the Windows 8.1 OS DVD is in the attached DVD drive. and as the 
computer starts up it will automatically boot from the Windows 8.1 OS DVD 
(you will be prompted to press a key to boot from the DVD).

24. Press <F7> as the computer starts up to bring up the boot device menu.
25. Select the DVD drive containing the Windows 8.1 OS DVD and press <Enter>.
26. Press a key at system startup to begin installing Windows from your Microsoft 

Windows 8.1 disc. 
27.  Click Next > Install Now to continue installing the operating system as normal 

(see your Windows documentation if you need help on installing the Windows 
OS).

28. Follow the on-screen instructions to install the Windows 8.1 operating system.
29. Install the Windows drivers from the Device Drivers & Utilities + User’s Manual 

disc as per Table 4 - 1, on page 4 - 4 (make sure you install the Intel Rapid 
Storage Technology driver - see overleaf).

30. Run the Intel® Rapid Storage Technology application to manage your RAID 
volume as instructed in “Intel® Rapid Storage Technology for RAID Systems” 
on page 6 - 33.
6 - 8 Setting Up SATA RAID or AHCI Mode
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IRST Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc an attached 

DVD drive.
2. Click Option Drivers (button).
3. Click 3.Install IRST Driver > Yes.
4. Click Next > Next.
5. Click the check box to accept the license and click Next.
6. Click Next > Next > Next.
7. Click Finish to restart the computer.
8. See “Intel® Rapid Storage Technology for RAID Systems” on page 6 - 33.
Setting Up SATA RAID or AHCI Mode 6 - 9
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Deleting a RAID (Windows 8.1)
If you wish to delete an existing RAID then follow the procedure below to do so. How-
ever backup up any necessary files and data before deleting a RAID, as doing so
will result in the loss of all data on the RAID volumes.

1. Start-up your notebook computer and press <F2> to enter the BIOS.
2. Go to Intel(R) Rapid Storage Technology (in the Advanced menu) and press 

<Enter>.
3. Go to the RAID (listed under RAID Volumes:) and press <Enter>.
4. Select Delete and press <Enter>.
5. Select “Yes” (note that al the data on the volumes will be lost) and press <Enter>.

Figure 6 - 5
Delete RAID 

(Advanced > Intel(R) 
Rapid Storage 
Technology)
6 - 10 Setting Up SATA RAID or AHCI Mode
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PC Camera Module
When the PC Camera application is run the LED indicator to the left of the camera
will be illuminated in red. Note that you need to use the Camera app in Windows to
take pictures and capture video. Use the Fn + F10 key combination (see “- Func-
tion Keys & Visual Indicators” on page 1 - 17) to toggle power to the PC Camera
module.
PC Camera Module 6 - 11
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PC Camera Audio Setup
If you want to capture video & audio with your camera, it is necessary to setup the
audio recording options in Windows.

1. Go to the Control Panel.
2. Click Sound  (Hardware and Sound) and click Recording (tab).
3. Right-click hold and release Microphone (Realtek High Definition Audio) and 

make sure the item is not disabled.
4. Double-click Microphone (or select Properties from the right-click menu).
5. Click Levels (tab), and adjust the Microphone and Microphone Boost sliders to 

the level required.
6. Click OK and close the control panels.

Figure 6 - 6
Audio Setup for PC 

Camera

Right-click
6 - 12 PC Camera Module
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Camera App
1. Run the Camera app from the Start screen by clicking on the Camera app icon 

.
2. The camera interface will display two buttons on the right side of the screen.

3. The upper button  is used to record video, and the lower button  is used 
to take still pictures.

4. Right-click on the screen to bring up menu buttons at the bottom of the screen.
5. These buttons enable you to access the camera roll (where captured pictures and 

video are displayed), set the timer (the time period before capture begins; 3 
seconds, 10 seconds or Off) and set the exposure level using the slider to obtain 
the best results.

Figure 6 - 7
Camera App 

Buttons


Exposure

Use the slider to adjust
the Exposure level.

Figure 6 - 8
Camera Options
PC Camera Module 6 - 13
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Camera Options
The Camera Options settings may be accessed as follows:

1. Run the Camera app from the Start screen by clicking on the Camera app icon 
.

2. While the camera app is running access the Charms Bar (e.g. click Use the 
Windows logo key  + C key combination).

3. Click Settings and then click Options.
4. You can adjust the Photo Aspect Ratio, select the Microphone, Hide/Show grid 

lines and turn Location Info on or off from the Options panel.

Figure 6 - 9
Camera Options
6 - 14 PC Camera Module
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Taking Pictures/Capturing Video
1. Run the Camera app from the Start screen by clicking on the Camera app icon 

.
2. Right-click the screen and select the timer if you require a countdown before 

capture.
3. Click the appropriate icon to take a picture or start video capture (if video capture 

begins a timer will appear in the bottom corner of the screen).
4. To stop video capture click the main window again (or click the stop icon ).
5. Captured photos and videos will be saved to a Camera Roll folder within the 

Pictures folder.

Figure 6 - 10
Pictures - Camera 

Roll
PC Camera Module 6 - 15
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Camera Roll
1. Run the Camera app from the Start screen by clicking on the Camera app icon 

.
2. Right-click on the screen to bring up menu buttons at the bottom of the screen.
3. Click Camera Roll.
4. Click the arrows  / (on either side of the screen) to browse through the 

captured photos/video, and back to the Camera app.

Editing Photos
1. Clicking on a captured photo will bring up an app bar with a series of buttons.

2. The Camera Button will take you back to the home screen of the camera app.
3. Click Delete to remove any photo from the camera roll (you will be asked to click 

Delete again to confirm the deletion).
4. The Open With button will allow you to select a program with which to open the 

photo.
5. You can click Set as Lock screen to set the photo as the lock screen picture.
6. Clicking Slide Show will create a slide show of photos/video in the camera roll.
7. Click Rotate to rotate the picture through 90 degrees.
8. Use the handles to Crop any captured picture, and click Apply to make the 

changes (you can change the Aspect ratio by clicking the button and selecting an 
aspect ratio from the menu). You can Save a copy (create another copy of the 

Figure 6 - 11
Edit Buttons 

(for Still Photos)
6 - 16 PC Camera Module
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photo with the edited changes), Update original (which changes the original 
picture permanently) or Undo any changes.

9. Click the Edit button to bring up a full suite of tools to edit the photo.
10. Click on the menu headings on the left, and then click on the tool on the right to 

edit the photo as required.

11. After the editing process is completed right-click on the photo to Save a copy 
(create another copy of the photo with the edited changes), Update original 
(which changes the original picture permanently), Undo any changes or Cancel 
the editing.

Figure 6 - 12
Editing Tools

Basic Fixes Light Color EffectsEdit Menu
PC Camera Module 6 - 17
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Editing Videos
1. Clicking on a captured video will bring up an app bar with a series of buttons.

2. Click Delete to remove any video from the camera roll (you will be asked to click 
Delete again to confirm the deletion).

3. The Open With button will allow you to select a program with which to run the 
Video.

4. Clicking Slide Show will create a slide show of photos/video in the camera roll.
5. Click Trim to edit the video. Use the round buttons at either end of the slider to 

adjust the video length and click Save a copy to save the changes made.

Figure 6 - 13
Edit Buttons 
(for Video)

Figure 6 - 14
Trim Video 

(for Video Files)

Click to select and move the rounded buttons to edit the video.
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Video File Size
Note that capturing high resolution video files requires a substantial amount of disk
space for each file. After recording video, check the video file size (right-click the
file and select Properties) and the remaining free space on your hard disk (go to My
Computer, right-click the hard disk, and select Properties). If necessary you can
remove the recorded video file to a removable medium e.g. CD, DVD or USB Flash
drive.

Note that the Windows 8.1 system requires a minimum of 16GB (32-bit) or 20GB
(64-bit) of free space on the C: drive system partition. In order to prevent system
problems it is recommended that you move any large sized captured video file to a
location other than the C: drive.
PC Camera Module 6 - 19
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Wireless LAN Module
If you have included an Intel® or 3rd Party 802.11b/g/n (Combo) module is on
(i.e. the system is not in Airplane Mode) before installing the driver.

Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 4.

Note that you need to install both the WLAN & Bluetooth drivers for the WLAN
& Bluetooth Combo modules.

See the appropriate driver installation instructions on the page indicated below:

• See “3rd Party 802.11b/g/n Driver Installation” on page 6 - 21.
• See “Intel® WLAN Driver Installation” on page 6 - 21.
• See “Qualcomm Atheros WLAN Combo Driver Installation” on page 6 - 22.


Wireless Device 

Operation Aboard 
Aircraft

The use of any portable
electronic transmission
devices aboard aircraft
is usually prohibited.
Make sure the WLAN &
Bluetooth module(s)
are OFF if you are using
the computer aboard
aircraft by putting the
system in to Airplane
Mode (see Table 1 - 5,
on page 1 - 17).
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3rd Party 802.11b/g/n Driver Installation
1. Make sure the system is not in Airplane Mode, and then insert the Device 

Drivers & Utilities + User’s Manual disc into an attached DVD drive. 
2. Click Option Drivers (button).
3. Click 1.Install WLAN Driver > Yes.
4. Click Next.
5. Click Finish to restart the computer.
6. The operating system is the default setting for Wireless LAN control in 

Windows (see page 6 - 23).

Intel® WLAN Driver Installation
1. Make sure the system is not in Airplane Mode, and then insert the Device 

Drivers & Utilities + User’s Manual disc into an attached DVD drive. 
2. Click Option Drivers (button).
3. Click 1.Install WLAN Driver > Yes.
4. Click in the check box to agree to the End User License Agreement and click 

Install.
5. Click Finish.
6. The operating system is the default setting for Wireless LAN control in 

Windows (see page 6 - 23).
Wireless LAN Module 6 - 21
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Qualcomm Atheros WLAN Combo Driver Installation
1. Make sure the system is not in Airplane Mode, and then insert the Device 

Drivers & Utilities + User’s Manual disc into an attached DVD drive. 
2. Click Option Drivers (button).
3. Click 1.Install WLAN Driver > Yes.
4. Select the language preferred and click Next.
5. Click Next > Next.
6. Click in the check box to accept to the License Agreement and click Next.
7. Click Finish.
8. Click Yes to restart the computer.
9. The operating system is the default setting for Wireless LAN control in 

Windows (see page 6 - 23).
6 - 22 Wireless LAN Module
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WLAN Configuration in Windows
You can configure a wireless connection using one of the following options, how-
ever make sure the Wireless LAN module is turned on (and not in Airplane Mode)
before configuration begins.

Charms Bar
1. Go to the Charms Bar.
2. Select Settings and then click the WiFi icon (it should read Available under the 

icon and Airplane mode should be Off).
3. A list of available access points will appear.

Figure 6 - 15
WiFi Settings 

(Charms Bar) & 
Networks
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4. Double-click an access point to connect to it (or click it and click Connect).
5. Enter a network security key (password) if required, and click Next.
6. You can choose to find other devices or not.
7. When you are connected to the network access point it will display Connected 

.
8. Select any connected network and click Disconnect  to disconnect from a 

connected access point.

9. You can click the Airplane Mode button to turn the mode (including Bluetooth) On 
or Off.

10. Alternatively you can click the WiFi button to turn just the WiFi On or Off.

Figure 6 - 16
Networks 

Connected / 
Disconnect
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Desktop Mode
1. Switch to the Windows Desktop (click the app or use the Windows logo key  + 

D key combination).
2. Click the wireless icon  in the notification area of the taskbar.
3. A list of available access points will appear.
4. Double-click an access point to connect to it (or click it and click Connect).
5. Enter a network security key (password) if required, and click Next.
6. You can choose to find other devices or not.
7. Select any connected network and click Disconnect to disconnect from a 

connected access point.

Figure 6 - 17
Windows Desktop 

Taskbar Notification 
Area WLAN 
Connection
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Bluetooth & WLAN Combo Module
If your purchase option includes the Combination Wireless LAN & Bluetooth
module (either Intel® or 3rd Party) then install the driver as instructed overleaf.

Make sure that the module is on (i.e. the system is not in Airplane Mode) before in-
stalling the driver.

Note that you need to install both the WLAN & Bluetooth drivers for the WLAN
& Bluetooth Combo modules.


Wireless Device 

Operation Aboard 
Aircraft

The use of any portable
electronic transmission
devices aboard aircraft
is usually prohibited.
Make sure the WLAN &
Bluetooth module(s)
are OFF if you are using
the computer aboard
aircraft by putting the
system in to Airplane
Mode (see Table 1 - 5,
on page 1 - 17).


Bluetooth Data Transfer

Note that the transfer of data between the computer and a Bluetooth enabled device is supported
in one direction only (simultaneous data transfer is not supported). Therefore if you are copying
a file from your computer to a Bluetooth enabled device, you will not be able to copy a file from
the Bluetooth enabled device to your computer until the file transfer process from the computer
has been completed.
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3rd Party Bluetooth (V4.0) Combo Driver Installation
1. Make sure the system is not in Airplane Mode, and then insert the Device 

Drivers & Utilities + User’s Manual disc into an attached DVD drive. 
2. Click Option Drivers (button).
3. Click 2.Install Combo BT Driver > Yes.
4. Click Next.
5. Click Finish to restart the computer.
6. See “Bluetooth Configuration in Windows” on page 6 - 29 for configura-

tion instructions.

Intel Bluetooth Combo Driver Installation
1. Make sure the system is not in Airplane Mode, and then insert the Device 

Drivers & Utilities + User’s Manual disc into an attached DVD drive. 
2. Click Option Drivers (button).
3. Click 2.Install Combo BT Driver > Yes.
4. Click Next > Next.
5. Click in the check box to accept the license and click Next.
6. Click Next > Finish.
7. Click Yes to restart the computer.
8. See “Bluetooth Configuration in Windows” on page 6 - 29 for configura-

tion instructions.


High Speed Bluetooth 

Data Transfer

The Combination Wire-
less LAN & Bluetooth
module supports high
speed data transfer. How-
ever to achieve such
transfer speeds, both de-
vices must support
high speed data trans-
fer.

To obtain high speed
data transfer make sure
that both the WLAN and
Bluetooth modules are
powered on.

Check your Bluetooth
compatible device’s doc-
umentation to confirm it
supports high speed data
transfer.
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Qualcomm Atheros Bluetooth Combo Driver Installation
1. Make sure the system is not in Airplane Mode, and then insert the Device 

Drivers & Utilities + User’s Manual disc into an attached DVD drive. 
2. Click Option Drivers (button).
3. Click 2.Install Combo BT Driver > Yes.
4. Click Next > Next.
5. Click Install.
6. Click Finish.
7. Click Yes to restart the computer.
8. See “Bluetooth Configuration in Windows” on page 6 - 29 for configura-

tion instructions.
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Bluetooth Configuration in Windows
You can configure a Bluetooth connection as below, however make sure the Blue-
tooth module is on (or the system is not in Airplane Mode) before configuration.

Desktop Mode
1. Switch to the Windows Desktop (click the App or use the Windows logo key  + 

D key combination).
2. Click the notification area of the taskbar and double-click the Bluetooth icon  (or

click and select Show Bluetooth Devices).
3. The Bluetooth item in PC and Devices will appear.

OR
Charms Bar
1. Go to the Charms Bar.
2. Select Settings and then click Change PC Settings.
3. Select the Bluetooth item in PC and Devices.


Bluetooth Headset 

Stereo Setup

To setup a Bluetooth
headset to support ste-
reo audio see page 7 -
14.

Figure 6 - 18
Bluetooth Taskbar 
Icon & Change PC 
Settings (Charms 

Bar -Settings)
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4. Make sure that Bluetooth is turned on and a list of discovered devices will appear.
5. Double-click the device you want to pair with the computer and click Pair.

6. On first connection the computer will provide you with a pairing code to be entered 
onto the device.

7. Enter the code into your Bluetooth enabled device and click Yes on the computer 
to complete the pairing.

8. Select a device and click Remove Device to disconnect from any device.

Figure 6 - 19
PC and Devices - 

Bluetooth

Figure 6 - 20
Enter the Passcode
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To Make your Computer Discoverable to Bluetooth Devices
1. Switch to the Windows Desktop (click the app or use the Windows logo key  + 

D key combination).
2. Click the notification area of the taskbar, click the Bluetooth icon  and click

Open Settings.
3. Click Options, and make sure that Allow Bluetooth devices to find this 

computer check box (Discovery) has a check inside it.
4. Make sure that the Alert me when a new Bluetooth device wants to connect 

check box (Connections) has a check inside it, if you want to be notified when a 
Bluetooth device wants to connect.

Figure 6 - 21
Bluetooth Settings
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Intel® Rapid Storage Technology
The Intel Rapid Storage Technology application provides high-performance
SATA and SATA RAID capabilities. Install the Intel Rapid Storage Technology
application (after installing all necessary drivers in the correct order) to support
your RAID system or SATA drive if set up in AHCI mode in the BIOS (see “SATA
Mode (Advanced Menu)” on page 5 - 10).

IRST Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into an attached 

DVD drive.
2. Click Option Drivers (button).
3. Click 3.Install IRST Driver > Yes.
4. Click Next > Next.
5. Click the check box to accept the license and click Next.
6. Click Next > Next > Next.
7. Click Finish to restart the computer.

See the following pages for more information if you have set your hard disks up in
a RAID configuration.


IRST and M.2 PCI-e 

SSDs

Note that Intel® Rapid
Storage Technology
does not support M.2
SSDs with a PCI-e In-
terface (M.2 SSDs with
a SATA Interface are
supported).
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Intel® Rapid Storage Technology for RAID Systems
Intel® Rapid Storage Technology application displays status information on your
RAID configuration. Run the Intel® Rapid Storage Technology application from
the item in the Start menu.

When the Intel® Rapid Storage Technology application is launched the system
will open the Status window. Here you can view the general health of the storage
system. Various volume creation and management options are available depending
on the system’s status.


IRST and M.2 PCI-e 

SSDs

Note that Intel® Rapid
Storage Technology
does not support M.2
SSDs with a PCI-e In-
terface (M.2 SSDs with
a SATA Interface are
supported).

Figure 6 - 22
Intel® Rapid 

Storage Technology
 Status
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Intel® Rapid Storage Technology Help
If a hard drive member of a RAID volume is reported as “Degraded” or “Failed” it
may be possible to recover the volume. If the volume cannot be restored then you
will need to recreate the RAID volume and restore the data from a back up. Click the
Help menu (or press F1) for instructions on how to recover or recreate RAID Vol-
umes.


Help

Click the Help (or press
F1) menu button at the
top of the Intel® Rapid
Storage Technology
application.

Click Contents to view
the general list of sub-
jects covered, click In-
dex or Search for a
more specific help top-
ics on a particular item.

Click More help on this
page at the bottom of
any page for page spe-
cific help.

Figure 6 - 23
Intel® Rapid 

Storage 
Technology

 Help
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RAID Volume Data Verification and Repair
The RAID volume data verification process identifies any inconsistencies or bad
data on a RAID 0 or RAID 1 volume. The table outlines what occurs for each RAID
level:

Replacing and Reverting Recovery and Master Volumes
If a master or recovery drive fails you will need to add a new identical drive and re-
build the recovery volume to the drive. You can also revert the master drive to the
state of the previous volume update. For details on how to do this see the help file
“Intel® Rapid Storage Technology Help” on page 6 - 34.

See over for details on how to verify and repair RAID volume data. Verification will
identify and repair data inconsistencies on the volume.

RAID 
Level

Verify Verify & Repair

RAID 0 Bad blocks are identified. N/A

RAID 1

Bad blocks are identified.

Data on the mirrored drive is compared to 
data on the source drive.

Bad blocks are reassigned.

If the data on the mirrored drive does not 
match the data on the source drive, the 
data on the mirrored drive is overwritten by 
the data on the source.

Table 6 - 2
RAID Level 

Verification & 

Repair Status
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Verifying and Repairing RAID Volume Data
8. Run the Intel® Rapid Storage Technology application.
9. Click to select the RAID in the pane on the right side of the window.
10. Click Manage and click Advanced.
11. Click Verify and click Verify (button) to begin the process (in some cases you may 

be required to initialize a volume before verification).

Figure 6 - 24
Intel® Rapid 

Storage 
Technology

 Verify
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12. The completion percentage will be listed under Status (verifying and repairing).
13. Click Close in the Verify Volume Data Results window. 

Scheduling Verify & 
Repair

You can schedule verifi-
cation and repair by
clicking Preferences >
Scheduler and en-
abling a set time for ver-
ification and repair.

Figure 6 - 25
Intel® Rapid 

Storage 
Technology

 Verify
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Intel® Smart Response Technology
Intel® Smart Response Technology is an Intel® Rapid Storage Technology
(RST) caching feature that accelerates computer system performance by using the
SSD as cache memory between the hard disk drive and system memory.

System Requirements to support Intel® Smart Response Technology:
• System BIOS with SATA mode set to RAID (see ““SATA Mode (Advanced 

Menu)” on page 5 - 10).
• Intel Rapid Storage Technology software installed. 
• A Solid State Drive (SSD) with a minimum capacity of 18.6GB (or with a parti-

tion on the drive formatted to more than 18.6GB e.g a 20GB partition set on the 
SSD). Note that the SSD requires at least 5MB of free unpartitioned and unallo-
cated space (if you have used all the disk space for the partition you will need to 
shrink some of space for the cache memory’s use).

See overleaf for instructions on enabling Intel® Smart Response Technology.


Intel® Smart 

Response and M.2 
PCI-e SSDs

Note that Intel® Smart
Response Technology
does not support M.2
SSDs with a PCI-e In-
terface (M.2 SSDs with
a SATA Interface are
supported).

Figure 6 - 26
Computer 

Management - Disk 
Management - 

Unallocated SSD 
Space 
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Enabling Intel Smart Response Technology
1. Run the Intel® Rapid Storage Technology application.
2. Click Enable acceleration under Performance > Smart Response Technology 

(note that you will at least 5MB of free unpartitioned and unallocated space on the SSD 
otherwise the Smart Response Technology item will not appear).

3. Select the SSD to be used as a cache device.
4. Select the size from the SSD to be allocated for the cache memory (any remaining 

space on the SSD can be used for data storage using the simple data single-disk 
RAID 0 volume that is automatically created).

Figure 6 - 27
Intel® Rapid 

Storage 
Technology - 
Performance 

Enable 
Acceleration
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5. Select the HDD (or RAID volume) to be accelerated (it is highly recommended that 
you accelerate the system volume or system disk for maximum performance).

6. Select the acceleration mode, and then click OK (Enhanced mode is selected by 
default).

Note: Enhanced mode (default): Acceleration optimized for data protection.
Maximized mode: Acceleration optimized for input/output performance.

Figure 6 - 28
Enable 

Acceleration 
Options
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7. The page will refresh and report the new configuration in under Performance > 
Smart Response Technology.

Figure 6 - 29
Intel® Rapid 

Storage 
Technology - 
Performance 

(Smart Response 
Technology)
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Intel® Rapid Start Technology Driver
Intel(R) Rapid Start Technology can resume power from Hibernation within 7 to
9 seconds and can remember your computer's previous state with zero power.

System Requirements to support Intel® Rapid Start Technology:
• Rapid Start Technology should be enabled in the BIOS (see ““Advanced Chip-

set Control (Advanced Menu)” on page 5 - 8).
• Intel Rapid Storage Technology software installed. 
• A Solid State Drive (SSD) with a minimum capacity of 18.6GB.
• The Solid State Drive (not the HDD) must be configured as outlined on the fol-

lowing pages to support Rapid Start Technology.
• The Windows operating system must be installed on the system hard disk drive, 

and not on the Solid State Drive (SSD).

See overleaf for instructions on enabling Intel® Rapid Start Technology.


Intel® Rapid Start 

Technology and M.2 
PCI-e SSDs

Note that Intel® Rapid
Start Technology does
not support M.2 SSDs
with a PCI-e Interface
(M.2 SSDs with a SATA
Interface are support-
ed). 


Operating System Installation

Note that in order for Intel(R) Rapid Start Technology to function properly the Windows
operating system must be installed on the system hard disk drive (e.g. the “C:” drive), and
the SSD should be configured as outlined on the following pages. Rapid Start will not func-
tion if the operating system is installed on the SSD.
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Intel® Rapid Start Technology Configuration
1. Enable/disable Intel(R) Rapid Start Technology from the BIOS (see “Advanced 

Chipset Control (Advanced Menu)” on page 5 - 8).
2. Go the Windows control panel and double-click Administrative Tools (System 

and Security)> Computer Management > Storage > Disk Management
3. Right-click the SSD and select Shrink Volume from the menu.

Figure 6 - 30
Computer 

Management 
(Shrink SSD 

Volume)

Shrink Volume
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4. Enter the figure, which should be equal to amount of system memory (RAM) 
in your computer, in “Enter the amount of space to shrink in MB”.

5. Click Shrink (any unallocated file space may be formatted for storage use).

Figure 6 - 31
Shrink Volume 

Size


Memory Size (Amount of Space to Shrink)

The figure entered in the “Enter the amount of space to shrink in MB” field above should be equal
to the amount of system memory in your computer. In the example above the system memory is 4GB
(1024MB * 4 = 4096GB). If you are unsure of your total system memory (RAM) then go to System
control panel (System and Security) and check Installed memory (RAM). The memory size will be dis-
played in GB so convert by multiplying the GB figure by 1024 to get the total in MB (e.g. 8GB =
8192MB).
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6. Run the Desktop app and right-click the lower left hot corner (or use the Windows 
Logo Key  + X key combination) and select Command Prompt (Admin).

7. Type “DISKPART”.
8. At the DISKPART command type “list disk”.

Figure 6 - 32
Search for CMD 

Prompt

Figure 6 - 33
Diskpart - List Disk
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9. Type “select disk #” (# is disk number where you want to create the store partition, 
so refer to the results obtained from "list disk" for exact disk number).

10. The message “Disk # is now the selected disk.” will appear.

11. Type “create partition primary”.
12. A “DiskPart succeeded in creating the specified partition.” message should 

appear.

Figure 6 - 34
Diskpart - Select 

Disk #

Figure 6 - 35
Diskpart - Create 

Partition
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13. Type “detail disk”.

14. Type “select Volume #” (# is volume of your storage partition so refer to results 
obtained from "detail disk" for the exact volume number).

15. The message “Volume # is now the selected volume.” will appear.

Figure 6 - 36
Diskpart - Detail 

Disk

Figure 6 - 37
Diskpart - Select 

Volume #
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16. Type the following, depending on the format of the SSD.

• For MBR formatted SSDs: “set id=84 override” (the id must be set to 84).
• For GPT formatted SSDs: “set id=D3BFE2DE-3DAF-11DF-BA40-E3A556D89593”.

17. The message “DiskPart successfully set the partition ID.” will appear.
18. Close the CMD window.

Figure 6 - 38
Diskpart - Set id=
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19. Go the Windows control panel and double-click Administrative Tools (System 
and Security)> Computer Management > Storage > Disk Management.

20. The disk partition should read Healthy Hibernation Partition.

21. Restart the computer.
22. Install the driver (see below).

Intel® Rapid Start Technology Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc an attached 

DVD drive.
2. Click Option Drivers (button).
3. Click 4.Install Rapid Start Driver > Yes.
4. Click Next > Next > Yes > Next > Next.
5. Click Finish to restart the computer.

Figure 6 - 39
Computer 

Management 
(Healthy 

Hibernation 
Partition)

Healthy (Hibernation Partition)
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Sound Blaster Audio
Install the Sound Blaster AP to allow you to configure the audio settings to your
requirements for the best performance in games, music and movies.

Sound Blaster X-Fi MB-3 Audio AP Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc an attached 

DVD drive.
2. Click Option Drivers (button).
3. Click 5.Install SBX-Fi MB 3 AP > Yes.
4. Click Next > Yes to accept the license.
5. Click Next > Full Installation (button).
6. Click Next > Finish to restart the computer.

Run the Sound Blaster X-Fi 3 control panel from the notification area of the taskbar
(or from the item in the Start menu). Click on the tabs to access the any of the control
panel menus.

Figure 6 - 40
Sound Blaster X-Fi 

MB 3 
(Taskbar 

Notification Area 
Icon)
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Volume Controls
You can click on the volume dials to adjust the level for either the microphone or
master volume. You can choose to save the settings for Music, Movie or Game, and
these settings can be exported or imported as required.

Figure 6 - 41
Sound Blaster X-Fi 3 

Volume Controls
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SBX Pro Studio
Click the check box to enable/disable the control, and use the slider to adjust the lev-
els. Press the play  button to test settings.

• Crystalizer: Enhances audio to make it sound livelier. 
• Surround: Provides virtual sound channels to control the level of immersion.
• Bass: Enhances the bass level of the sound system.
• Dialog Plus: Enhances dialogue levels for movies etc.
• Smart Volume: Minimizes sudden volume changes to avoid the need for con-

stant adjustment. It is recommended that this is set to Loud (see sidebar).


Smart Volume 

Setting

The default setting for
Smart Volume in SBX
Pro Studio is set to
Normal. 

To get the full effect of
this setting it is recom-
mended that you set it to
Loud.

Figure 6 - 42
Sound Blaster X-Fi 3 

SBX Pro Studio
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Scout Mode
Click in the box to enable Scout Mode to enhance your ability to hear enemies in
games from a further distance away than would normally be possible.

Figure 6 - 43
Sound Blaster X-Fi 3 

Scout Mode
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Voice FX
Click in the box to enable Voice FX and click on the sliders to adjust the settings.
Select the mode required from the dropbox, and click on Test to hear the playback
of the effect.

Figure 6 - 44
Sound Blaster X-Fi 3 

Voice FX
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EAX Effects & EQ
Click to select either/or EAX Effects or EQ, select the mode required from the drop-
box and click on the sliders to adjust the settings. Click on Save to save any custom
changes to the set levels and effects.

Figure 6 - 45
Sound Blaster X-Fi 3 

EAX Effects & EQ
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Advanced Settings
Select the speaker/headphone configuration from the dropbox, and click on Test to
hear the effect. You can also adjust the Bass Management by clicking the Bass Re-
direction and Subwoofer Gain, and click on the slider to adjust the Crossover Fre-
quency.

Figure 6 - 46
Sound Blaster X-Fi 3 
Advanced Settings
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Hot Key Configuration
Click Configure Hot Keys in Scout Mode or Advanced Settings menus to access
the Hot Key Configuration menu. Click Enable All Hot Keys, and then click on
the task and press the key sequence required. Any hotkeys chosen will be locked by
the application, and therefore will not be able to be used in other applications.

Figure 6 - 47
Sound Blaster X-Fi 3 

Hot Key 
Configuration
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Creative ALchemy
The Creative ALchemy application can be run from the shortcut in the Start menu.
Use the left menu to select any installed games and click the button to move them to
the right column to enable ALchemy support for the game. Creative ALchemy re-
stores hardware accelerated audio to enable EAX effects and 3D Audio when play-
ing Direct Sound3D games.

Creative Software AutoUpdate
Run the application from the shortcut in the Start menu and make sure you are con-
nected to the internet, then click Next and follow the on screen instructions to update
the software.

Sound Blaster Audio & HDMI/Mini Display Port
1. When you connect a display to the HDMI-Out port, or Mini Display port the Sound 

Blaster Cinema controls will be disabled.
2. A warning box will pop-up and will prompt “...Do you want to select another 

audio device now?”.
3. Click No to continue using the audio output from your external display attached to 

the HDMI-Out port, or Mini Display port (do not attempt to select another audio 
device when connected to the external isplay).
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Testing 5.1 Surround Sound (Advanced Settings)
If you are using the Sound Blaster X-Fi 3 control panel (Advanced Settings) to test
your headphones/speakers, set up as a 5.1 surround sound system with the micro-
phone jack enabled as the "Center/Subwoofer" (see Figure  on page 2 - 6) in the Re-
altek HD Audio Manager, you may not hear the low Subwoofer test tone as some
headphones/speakers do not support low frequencies. 

If your headphones/speakers do not support low frequencies then follow the instruc-
tions below to obtain an effective sound test.

1. Attach your headphones/speakers to the headphone out jack.
2. Run the Sound Blaster X-Fi 3 control panel from the notification area of the 

taskbar (or from the item in the Start screen).
3. Click Advanced Settings (see Figure 6 - 46 on page 6 - 56).
4. Select 5.1 Surround under Speaker/Headphones Configuration.
5. Click to place a check in the BASS REDIRECTION check box.
6. Click to place a check in the SUBWOOFER GAIN check box.
7. Move the slider for CROSSOVER FREQUENCY to its maximum setting.
8. Click TEST to hear the sound.
9. Your headphones/speakers will now be configured for 5.1 Surround.

Figure 6 - 48
Bass Management 

Sound Blaster X-Fi 3 
Advanced Settings
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Fingerprint Reader Module
The fingerprint reader module provides a high level of security for your computer.
Make sure you have administrator’s rights to your computer, and have a Windows
password enabled for full security protection.

There are two different fingerprint modules supplied with this model. Install the
driver from the Device Drivers & Utilities + User’s Manual disc by following
the appropriate instructions on the page overleaf.

The fingerprint reader module uses the Sign-in options configuration of the Win-
dows Account.


Fingerprint Reader 
and Power Saving 

States

If your computer is in a
power saving state (e.g.
Hibernate or Sleep) you
should keep your finger
clear of the fingerprint
sensor.

Allow the system to fully
resume before swiping
your finger across the
sensor.
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Fingerprint Reader Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into an attached 

DVD drive.
2. Click Option Drivers.
3. Click 6.Install Fingerprint Driver > Yes.
4. Click Next > Install.
5. Click Finish to complete the installation.
6. The fingerprint reader module uses the Sign-in options configuration of the 

Windows Account (see overleaf).
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Fingerprint Module Configuration
1. Go to the Charms Bar.
2. Select Settings and then click Change PC Settings.
3. Click Accounts and then click Sign-in options.
4. You will need to add a Windows password (click Add under Password).
5. After you have added the password you will need to restart the computer and use 

your password to log on to the system.
6. Go to the Charms Bar.
7. Select Settings and then click Change PC Settings.
8. Click Accounts and then click Sign-in options.
9. Click Add under Fingerprint.

Figure 6 - 49
Accounts - Sign-in 

Options 
(Add Fingerprint)
6 - 62 Fingerprint Module Configuration



Modules

6

10. Input the Windows password and click OK.
11. You will then be instructed to swipe the same finger across the reader a number 

of times.

12. Click Finish.
13. You can choose to Add another finger (this is recommended) or Remove the 

current fingerprint reading.
14. You can now scan your fingerprint to log-on to the computer.

Figure 6 - 50
Add a Fingerprint
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Trusted Platform Module
(Optional)
The TPM security chip allows you to create and manage digital certificates for user
and platform authentication. This type of security is usually administered within
large enterprises and organizations, and therefore requires implementation by a sys-
tem administrator before users can access security features. 

Individual users can use the TPM as an authentication with the fingerprint reader.

Make sure you have administrator’s rights to your computer, and have a Windows
password enabled for full security protection. In addition Make sure you prepare
a removable media (e.g. a USB flash drive) to store passwords etc. before begin-
ning the TPM initialization process.

Before setting up the TPM functions you must initialize the security platform.
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Enabling & Managing TPM
1. Restart the computer.
2. Enter the Aptio Setup Utility pressing F2 during the POST/startup.
3. Use the arrow keys to select the Security menu.
4. Select TPM Configuration and press Enter to access the sub-menu.
5. Press Enter under Security Device Support menu and select Enable.
6. You will then need to press F4 to save the changes and restart the computer.
7. You can now manage the TPM from Windows.

Figure 6 - 51
TPM State (Enable)
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TPM Management in Windows
You can manage your TPM settings from within Windows:

1. Go to the Control Panel.
2. Click BitLocker Drive Encryption (System and Security).
3. Click TPM Administration.

Figure 6 - 52
BitLocker Drive 

Encryption 
(TPM 

Administration)
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4. The TPM Management window allows you to configure the TPM within Windows. 
As TPM is usually administered within large enterprises and organizations, your 
system administrator will need to assist you in managing the information here.

Figure 6 - 53
Trusted Platform 

Module (TPM) 
Management on 
Local Computer 
Administration
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TPM Actions
1. Click Prepare the TPM and follow the instructions in the Wizard to prepare the 

TPM (this will probably require a restart of the computer and confirmation of the 
setting changes after restart by pressing the appropriate F key).

2. After the restart the TPM will be prepared and you can then use the Actions menu 
to Turn TPM off, Change Owner Password, Clear TPM or Reset TPM Lockout.

3. A wizard will help take you through any setup steps.

Figure 6 - 54
TPM Actions Menu
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BitLocker
BitLocker Drive Encryption can be used in conjunction with the TPM to encrypt
data on the disk. Access the Microsoft BitLocker Drive Encryption control panel
applet from the Windows control panel (System and Security).

1. Click Turn on Bit Locker.
2. Follow the on-screen instructions to setup BitLocker, and make sure you have a 

removable media (e.g. a USB flash drive) to store saved recovery keys etc. 
 

Figure 6 - 55
BitLocker Drive 

Encryption
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3G/4G Module
(For Model A Computers Only)
If you have included an optional UMTS/HSPA+ based 3G Module (Universal Mo-
bile Telecommunications System or High Speed Packet Access) module or LTE
(Long Term Evolution) 4G module (see “Communication” on page D - 4 for spec-
ification details) in your purchase option, you do not require a driver/application
installation for Windows 8.1. Follow the instructions overleaf to install the USIM
card (which will be provided by your service provider), and then use the Charms
Bar Wireless icon to access the 3G/4G network in the same manner as the WLAN
(see page 6 - 72).


Wireless Device 

Operation Aboard 
Aircraft

The use of any portable
electronic transmission
devices aboard aircraft
is usually prohibited.
Make sure the WLAN,
Bluetooth and 3G/4G
module(s) are OFF (or
the system is in Air-
plane Mode) if you are
using the computer
aboard aircraft (see
Table 1 - 5, on page 1 -
17).


Important Notice

If your purchase option includes both Wireless LAN and 3G/4G modules, then the appro-
priate antennas will be installed. Note that In order to comply with FCC RF exposure com-
pliance requirements, the antenna must not be co-located or operate in conjunction with
any other antenna or transmitter.

Important Notice - 3G/4G & Bluetooth/Wireless LAN Modules

In order to comply with FCC regulations you should NOT operate the 3G/4G module and
the Bluetooth/Wireless LAN modules at the same time as this may disrupt radio frequency,
and cause interference. When the 3G/4G module is powered on, make sure that the Blue-
tooth/Wireless LAN modules are powered off.
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3G/4G Module USIM Card Installation
(For Model A Computers Only)
Insert the USIM card  as illustrated below (pay careful attention to the orientation
of the card as the gold contact side of the card should face upwards) until it clicks
fully into position. To eject the card simply press it until it ejects, but do not attempt
to eject the card while connected to a 3G/4G network (see below). 


USIM Card Orienta-

tion

Note that the USIM
card’s readable side
(with the gold-colored
contacts) should face
upwards as illustrated.

Figure 6 - 56
USIM Card Insertion

1

1


USIM Card Ejection

Simply press on the USIM card to eject it, however do not do this while a connection is in
progress.

If you do eject the card while a 3G/4G connection is ongoing, you will need to shut down
the system, reinsert the USIM card, restart the system and then reestablish the 3G/4G con-
nection.

If you wish to change USIM cards then you will need to shut the system down, reinsert the
USIM card, restart the system and then reestablish the 3G/4G connection.
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3G/4G Configuration in Windows
You can configure a 3G/4G connection as below, however make sure the system is
not in Airplane Mode before configuration begins.

Charms Bar
1. Go to the Charms Bar.
2. Select Settings and then click the WiFi icon (it should read Available under the 

icon and Airplane mode should be Off).
3. A list of available access points will appear under Mobile Broadband.


3G/4G Module PIN 

Code & Power-Saving

Note that there may be
some issues when a
PIN Code is set for 3G/
4G modules in Win-
dows, if Mobile Broad-
band has been turned
off, and the system has
resumed from a power-
saving state. See ““3G/
4G Configuration in
Windows” on page 6 -
72. 

Figure 6 - 57 
Networks 

Mobile Broadband
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4. Any 3G/4G service provider (connection information is usually stored on the USIM 
card) will appear under Mobile Broadband.

5. Double-click any connection icon under Mobile Broadband (or click and then click 
Connect).

6. The system will connect to your network.
7. A Connected will appear alongside the 3G/4G connection (click the connection to 

view the timer which indicates your connected time for the current session).

Figure 6 - 58 
Mobile Broadband 

(Connect)
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8. You can then access the internet, download e-mail etc. as per any internet 
connection.

9. To disconnect you can select the connection and click Disconnect .

10. You need to either use Airplane Mode, or to turn the Mobile Broadband module 
off aboard aircraft.


Wireless Device 

Operation Aboard 
Aircraft

The use of any portable
electronic transmission
devices aboard aircraft
is usually prohibited. 

Make sure the system is
in Airplane Mode if you
are using the computer
aboard aircraft.

Figure 6 - 59
Mobile Broadband 

(Disconnect)
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Wireless Display
Wireless Display uses your Wireless LAN module/WLAN Bluetooth Combo mod-
ule (you need to make sure that your video adapter/display device is compatible
with your particular WLAN/Combo module) in conjunction with a compatible
video adapter/display device (purchased separately) to allow you to display the
contents of the notebook display on another display (e.g. HDTV), without the need
to have cables stretching across a room. 

You can use the wireless display to play games, browse the internet, display videos
or photo slide shows on your TV/external display without using HDMI or A/V ca-
bles.

Before configuring Wireless Display you will need to set up your compatible
adapter with your display/speakers. Connect the adapter using an HDMI or A/V ca-
ble and turn on the display (or in the case of speakers connect them to the wireless
speaker adapter with the cables provided with the adapter), and then set the display
to the appropriate input channel (see the documentation supplied with your compat-
ible adapter/display for full details).

Note that no driver or application is required for wireless display in Windows 8.1.


Compatible 

Adapters

For a list of compatible
adapters check the vid-
eo adapter/display de-
vice documentation, or
with your distributor/
supplier.
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Wireless Display Configuration
1. Note that no driver or application is required for wireless display in Windows 8.1.
2. Go the Charms Bar, select Devices.
3. Click Project.
4. Click Add a wireless display.

Figure 6 - 60
Add a Wireless 

Display
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5. The system will then search for compatible display devices (this may take up to
60 seconds so allow time for this to complete).

6. Double-click any detected display device in the list.
7. You may then need to input a pin number for the device to which you are 

connecting.
8. Click Next.

Figure 6 - 61
Searching For 

Devices

Figure 6 - 62
Enter PIN
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9. The display will then connect (for specific settings for your display see the 
documentation supplied with your compatible adapter/display for full details).

10. Go to the Project menu (Charms Bar > Devices) and click Disconnect to 
temporarily disconnect from the wireless display.

11. To permanently disconnect from the display (you will need to go back through the 
connection process again) you can select it in PC and Devices > Devices and 
click Remove Device > Yes.

Figure 6 - 63
Remove Device/

Disconnect
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Chapter 7: Troubleshooting

Overview
Should you have any problems with your computer, before consulting your service representative, you may want
to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This
can’t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these
pages, make sure you have followed the instructions carefully and observed the safety precautions in the preface.
If all else fails, talk to your service representative. You should also make a record of what happened and what
remedies you tried.

Of course, if something goes wrong, it will happen at the most inconvenient time possible, so you should preview
this section just in case. If, after you’ve tried everything, and the system still won’t cooperate, try turning it off
for a few minutes and then rebooting. You will lose any unsaved data, but it may start working again. Then call
your service representative.
Overview 7 - 1
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Basic Hints and Tips
Many of the following may seem obvious but they are often the solution to a problem when your computer ap-
pears not to be working. 

• Power - Is the computer actually plugged into a working electrical outlet? If plugged into a power strip, 
make sure it is actually working. Check the LED Power Indicators (see “LCD Panel Open - Model B” on 
page 1 - 10) to see the computer’s power status.

• Connections - Check all the cables to make sure that there are no loose connections anywhere.

• Power Savings - Make sure that the system is not in Hibernate or Sleep mode by pressing the keys config-
ured in your Power Options (see “Configuring the Power Buttons” on page 3 - 9), the Fn + F12 key com-
bination, or power button to wake-up the system.

• Brightness - Check the brightness of the screen by pressing the Fn + F8 and F9 keys to adjust the bright-
ness (see Table 1 - 5, on page 1 - 17).

• Display Choice - Press Fn + F7 to make sure the system is not set to “external only” display.

• Boot Drive - Make sure there are no optical media and/or USB storage devices in any connected drive.
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Backup and General Maintenance
• Always backup your important data, and keep copies of your OS and programs safe, but close to hand. 

Don’t forget to note the serial numbers if you are storing them out of their original cases, e.g. in a CD wal-
let.

• Run maintenance programs on your hard disk and OS as often as you can. You may schedule these pro-
grams to run at times when you are not using your computer. You can use those that are provided free with 
your OS, or buy the more powerful dedicated programs to do so.

• Write down your passwords and keep them safe (away from your computer). This is especially important if 
you choose to use a Boot password for the SCU (see “Security Menu” on page 5 - 12).

• Keep copies of vital settings files such as network, dialup settings, mail settings etc. (even if just brief 
notes).


Bottom Cover Removal Warning

Users should not remove any cover(s) and /or screw(s) for the purposes of device upgrade as this may violate the terms of
your warranty. If you need to replace/remove the hard disk/RAM/optical device etc., for any reason, please contact your dis-
tributor/supplier for further information.
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Viruses
• Install an Anti-Virus program and keep the definitions file (the file which tells your program which viruses 

to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm 
your computer and cause you to lose data. Anti-Virus programs are commercially available and the defini-
tions file updates are usually downloadable directly from the internet.

• Be careful when opening e-mail from sources you don’t know. Viruses are often triggered from within e-
mail attachments so take care when opening any attached file. You can configure most Anti-Virus pro-
grams to check all e-mail attachments. Note: You should also beware of files from people you know as the 
virus may have infected an address book and been automatically forwarded without the person’s knowl-
edge.

• Keep a “Bootable CD-ROM/DVD-ROM/USB storage device” (this CD/DVD/USB device provides basic 
information which allows you to startup your computer) handy. You may refer to your OS’s documentation 
for instructions on how to make one, and many Anti-Virus programs will also provide such a disk (or at 
least instructions on how to make one).
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Upgrading and Adding New Hardware/Software
• Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are 

doing, otherwise you will risk severely damaging your system.

• Don’t open your computer or undertake any repair or upgrade work if as this may violate the terms of your 
warranty.

• Read the documentation. We can assume, since you are reading this that you are looking at the computer’s 
manual, but what about any new peripheral devices you have just purchased? Many problems are caused by 
the installation of new hardware and/or software. Always refer to the documentation of any new hardware 
and/or software, and pay particular attention to files entitled “READ ME” or “READ ME FIRST”.

• When installing a new device always make sure the device is powered on, and in many cases you will need 
to restart the computer. Always check that all the cables are correctly connected.

• Make sure you have installed the drivers for any new hardware you have installed (latest driver files are 
usually available to download from vendor’s websites).

• Thoroughly check any recent changes you made to your system as these changes may affect one or more 
system components, or software programs. If possible, go back and undo the change you just made and see 
if the problem still occurs.
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• Don’t over complicate things. The less you have to deal with then the easier the source of the problem may 
be found; Example - if your computer has many devices plugged into its ports, and a number of programs 
running, then it will be difficult to determine the cause of a problem. Try disconnecting all of the devices and 
restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and 
removing devices and restarting where necessary) will often find the source of a problem, although this may 
be time consuming.
7 - 6 Upgrading and Adding New Hardware/Software
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Problems and Possible Solutions

Problem Possible Cause - Solution

You turned on the power but it doesn’t
work.

Battery missing / incorrectly installed. Check the battery bay, make sure the
battery is present and seated properly (the design of the battery only allows it to
go in one way). Make sure there’s nothing interfering with the battery contacts.

The battery LED power indicator , is
blinking orange.

Low Battery. Plug in the DC power source. If the computer doesn’t start up
immediately, turn it off then on again.

You are losing battery power too quickly. The system is using too much power. If your OS has a Power Options scheme
(see “Power Plans” on page 3 - 5) check its settings. You may also be using a
peripheral device/USB device that is drawing a lot of power.

Actual battery operating time is shorter
than expected.

The battery has not been fully discharged before being recharged. Make sure
the battery is fully discharged and recharge it completely before reusing (see
“Battery Information” on page 3 - 14).

Power Options have been disabled. Go to the Control Panel in Windows and
re-enable the options.

A peripheral device/USB device is consuming a lot of power. Turn off/remove
the unused device to save power.
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The computer feels too hot. Make sure the computer is properly ventilated and the Vent/Fan intakes are not
blocked. If this doesn’t cool it down, put the system into Hibernate mode or turn
it off for an hour. Make sure the computer isn’t sitting on a thermal surface (see
“Overheating” on page 1 - 18 & 1 - 25). Make sure you’re using the correct
adapter. 

Make sure that your notebook is completely powered off before putting it into a
travel bag (or any such container). Putting a notebook which is powered on in a
travel bag may cause the Vent/Fan intakes to be blocked.

Nothing appears on screen. The system is in a power saving mode. Toggle the sleep/resume key
combination, Fn + F12 (see “Configuring the Power Buttons” on page 3 - 9).

The screen controls need to be adjusted. Toggle the screen control key
combinations Fn + F8/F9. If you’re connected to an external monitor, make sure
it’s plugged in and turned on. You should also check the monitor’s own
brightness and contrast controls.

The computer is set for a different display. Toggle the screen display key
combination, Fn + F7. If an external monitor is connected, turn it on.

The screen saver is activated. Press any key or touch the TouchPad.

No image appears on the external
monitor I have plugged in and powered
on.

You haven’t installed the video driver and configured it appropriately from the
Control Panel. See Appendix C for instructions on installing and configuring
the video driver.

Problem Possible Cause - Solution
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You forget the boot password. If you forget the password, you may have to discharge the battery of the CMOS.
Contact your service representative for help.

The sound cannot be heard or the volume
is very low.

The volume might be set too low. Check the volume control in the Volume
Control Panel in the Windows notification area, or use the key combination Fn
+ F5 and F6 (see “Keyboard Shortcuts” on page 1 - 16) to adjust.

Unwelcome numbers appear when typing. Num Lock is turned ON (see “LCD Panel Open - Model B” on page 1 - 10).

Problem Possible Cause - Solution


Password Warning

If you choose to set a boot password, NEVER forget your password. The consequences of this could be serious. If you cannot
remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.


Other Keyboards

If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system will
detect and enable it automatically. However special functions/hot keys unique to the system’s regular keyboard may not
work.
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The system freezes or the screen goes
dark.

The system’s power saving features have timed-out. Use the AC/DC adapter,
press the sleep (Fn + F12) key combination, or press the power button if no
LEDs are lit.

The system never goes into a power
saving mode.

Power Options features are not enabled. Go to the Windows Power Options
menu and enable the features you prefer (see “Power-Saving States” on
page 3 - 7). Make sure you have enabled Hibernate mode from the control
panel.

The Wireless LAN/Bluetooth modules
cannot be detected.

The modules are off as the computer is in Airplane Mode. Check the LED
indicator  to see if it is in Airplane Mode (see “LCD Panel Open - Model B”
on page 1 - 10). Use the Fn + F11 key combination to toggle Airplane Mode
on/off (see Table 1 - 5, on page 1 - 17).

The PC Camera module cannot be
detected.

The module is off. Press the Fn + F10 key combination in order to enable the
module (see “Function Keys & Visual Indicators” on page 1 - 17). Run the
camera application to view the camera picture.

The Wireless LAN/Bluetooth modules
cannot be configured.

The driver(s) for the module(s) have not been installed. Make sure you have
installed the driver for the appropriate module (see the instructions for the
appropriate module in “Wireless LAN Module” on page 6 - 20 and/or
“Bluetooth & WLAN Combo Module” on page 6 - 26).

Problem Possible Cause - Solution
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A file cannot be copied to/from a
connected Bluetooth device.

The transfer of data between the computer and a Bluetooth enabled device is
supported in one direction only (simultaneous data transfer is not
supported). If you are copying a file from your computer to a Bluetooth enabled
device, you will not be able to copy a file from the Bluetooth enabled device to
your computer until the file transfer process has been completed

I cannot obtain high speed Bluetooth data
transfer.

To obtain high speed Bluetooth data transfer take into account the following:

• To achieve high speed transfer speeds, both devices must support high 
speed data transfer (i.e both the computer and the Bluetooth compati-
ble device you are connecting to).

• Check your Bluetooth compatible device’s documentation to confirm it 
supports high speed data transfer, and for configuration information.

The computer is off (or in Sleep Mode) but
powered by the AC/DC adapter plugged in
to a working outlet, or by battery with a
capacity above 20%. I have plugged a
device into the powered USB port in
order to charge it, but the device is not
charging.

The port is not powered on. Toggle power to the port using the Fn + power
button combination.

This function may not work with certain external USB compliant devices (check
your device’s documentation). If this is the case, power the computer on and
connect the external USB device in order to charge it.

Note that this function is designed to help charge USB compliant devices, but
is not designed to allow their operation.

No sound can be heard through an HDMI
connected display.

You have not configured the HDMI audio output. See “HDMI Audio
Configuration” on page C - 27.

Problem Possible Cause - Solution
Problems and Possible Solutions 7 - 11



Troubleshooting

7

Audio Volume is too low when listening
through headphones.

You have set the Speaker Configuration to 5.1 Speaker. It is recommended that
you set the Speaker Configuration to Stereo (not to 5.Speaker) when listening
through headphones in order to maximize audio quality. See “Audio Features”
on page 2 - 4.

The Sound Blaster audio controls don’t
work when the system is connected to an
external display through an HDMI/Mini
Display cable.

Note that Sound Blaster Audio will be disabled when you are connecting to an
external display through an HDMI or Mini Display port connection. See “Sound
Blaster Audio & HDMI” on page C - 29.

The fingerprint reader has problems
scanning fingers.

When fingers are wet or sweaty the software application may have difficulty
reading a scanned finger. Make sure your fingers are clean and dry when
attempting to scan them across the sensor for detection.

Problem Possible Cause - Solution
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I have used Update Driver in Device
Manager (Unknown device > Other
Devices) to try and install the Airplane
Mode driver. Windows encountered a
problem in attempting to update the driver,
and a yellow exclamation mark appears
in Device Manager against the Unknown
device.

It is very important that the drivers are installed in the order indicated in Chapter
4 (which is the numbered installation order on the Device Drivers & Utilities +
User’s Manual disc). This issue can occur when drivers are manually installed,
and not in the correct order.

If you have attempted to Update Driver from the Device Manager control panel
and have encountered problems, then use the method below to correct this:

To correct this problem:

1. Go to the Programs and Features (Programs) control panel in 
Windows.

2. Select any installed Airplane Mode driver item (e.g. Insyde Airplane 
Mode HID Mini-Driver), and click Uninstall/Change to uninstall the 
current driver.

3. Restart the computer.
4. Insert the Device Drivers & Utilities + User’s Manual disc and click 

Install Drivers (button).
5. Double-click the Airplane Driver item in the menu.
6. Follow the instructions to install the correct driver (you will need to 

restart the computer as part of the installation process).

Problem Possible Cause - Solution
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When using a Bluetooth headset the
audio appears to be mono and not
stereo.

This is a common issue with Bluetooth headsets. To resolve this issue do the
following (you will need to repeat this procedure after every boot up, restart,
or when the system resumes from hibernation):

1. Go to the Devices & Printers control panel in Windows.
2. Double-click the Bluetooth headset.
3. Click Connect to complete the stereo connection.
OR
1. Go to the Sound control panel in Windows.
2. Right-click (in the Playback tab) the Bluetooth Stereo Audio device 

(the default device is Headset).
3. Click Connect to complete the stereo connection.

Problem Possible Cause - Solution
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Appendix A: Interface (Ports & Jacks)

Overview
The following chapter will give a quick description of the ports & jacks which allow your computer to commu-
nicate with external devices, connect to the internet etc.
Interface (Ports & Jacks) A - 1
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Ports and Jacks

Item Description

Card Reader The card reader allows you to use the following digital storage cards:

MMC (MultiMedia Card) / RSMMC
SD (Secure Digital) / Mini SD / SDHC / SDXC

Push the card into the slot and it will appear as a removable device.

DC-In Jack Plug the supplied AC/DC adapter into this jack to power your computer.


Inserting Cards into the Card Reader

Note that the cards should be inserted with the readable side of the card facing upwards,
as illustrated on the right.
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e-SATA / USB 3.0 
Combo Port

This e-SATA (external Serial Advanced Technology Attachment) port allows you to plug-in
external Serial ATA hard drives. This port also serves as a USB 3.0 port.

HDMI-Out Port The HDMI-Out (High-Definition Multimedia Interface) port is an audio/video connector
interface for transmitting uncompressed digital streams. This allows you to connect an external
monitor, TV or Flat Panel Display etc. as a display device (see “Attaching Other Displays” on
page C - 21) by means of a HDMI cable. Note that HDMI carries both audio and video
signals.

Item Description

/e-SATA3.0


E-SATA Cable Insertion 

E-SATA cables should be inserted as illustrated below (with the T-Shape inverted, the pins
at the lower half of the connector). E-SATA cables only fit one way, do not force them. 
Interface (Ports & Jacks) A - 3
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Headphone-Out Jack Headphones or speakers may be connected through this jack. Note: Set your system’s volume
to a reduced level before connecting to this jack.

Microphone-In Jack Plug an external microphone in to this jack to record on your computer.

Mini DisplayPort The Mini DisplayPort is a miniatuarized version of the DisplayPort, which is a digital display
interface standard that allows a digital audio/video interconnect, between the computer and its
external display or a home-theater system.

RJ-45 LAN Jack This port supports LAN (Network) functions.
Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.

S/PDIF-Out Jack This S/PDIF (Sony/Philips Digital Interface Format) Out Port allows you to connect your DVD-
capable PC to a Dolby AC-3 compatible receiver for “5.1” or ‘dts’ surround sound.

Security Lock Slot To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be
purchased at any computer store.

Item Description
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USB 3.0 Port

Powered USB 3.0 Port

These USB ports are for low-speed peripherals such as keyboards, mice or scanners, and for
high-speed peripherals such as external HDDs, digital video cameras or high-speed scanners
etc. Devices can be plugged into the computer, and unplugged from the computer, without the
need to turn the system off (if the power rating of your USB device is 500mA or above, make sure
you use the power supply which comes with the device).

The USB 3.0 ports are denoted by their blue color and are backwards-compatible with USB 2.0.

Note: The powered USB 3.0 port (see Figure 1 - 13 on page 1 - 23) may be toggled on /off by
means of the Fn + Power Button key combination. When the powered USB port is on it will supply
power (for charging devices only, not for operating devices) when the system is off but still
powered by the AC/DC adapter plugged into a working outlet, or powered by the battery with a
capacity level above 20% (this may not work with certain devices - see page 7 - 11).

Note: This function is designed to help charge USB compliant devices, but is not designed to
allow their operation.

Item Description

3.0

3.0
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Appendix B: Control Center & Flexikey®
Overview
The following chapter will give a quick description of the functions of the Control Center & Flexikey® appli-
cations.

Control Center
The Control Center gives quick access to frequently used controls, power management features and enables you
to quickly turn modules on/off. Click the Control Center icons to toggle the appropriate function, or hold the
mouse button down and move the dial control where applicable. Certain functions will automatically be adjusted
when a power mode is selected. The Control Center in Windows 8.1 works under the Desktop app and not un-
der the Start screen.

Flexikey®
The Flexikey® application is a quick hotkey configuration application, which allows you to assign a single key
to launch multiple key combinations, or to launch programs and applications, to create text macros and to
disable certain keys. The application can also be used to configure the mouse buttons to create hotkeys for
gaming etc. All the configuration settings are retained under (up to12) profiles to which the settings are applied.
Click Flexikey® in the Gaming section of the Control Center, or the click the icon   in the notification
area of the taskbar, to launch the application.
Overview B - 1
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Figure B - 1 - Control Center & Flexikey®


Control Center Access

To run the Control Center press the Fn + Esc key combination, or double-click the icon  in the
notification area of the taskbar. Close the Control Center by clicking the  close icon in the top
right of the panel (move the cursor onto the top right corner of the panel to highlight it).

Flexikey® Access

The Flexikey® is accessed from within the Control Center by clicking Flexikey® in the Gaming
section of the Control Center.
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Power Modes
You can set a Power Mode by clicking the appropriate icon at the top of the Control Center. Each power
mode will affect the Power Conservation Mode, Airplane Mode, Power Plan and PC camera power etc.

You can click a Control Center icon to set an overall power mode and then click individual icons in the
Control Center to power on/off the Touchpad and PC camera.

Table B - 1- Power Modes

Modes Quiet Power Saving Performance Entertainment

Icon

Power Plan Balanced Power Saver High Performance Balanced

Power Conservation Mode Balance Energy Star Performance Balance

PC Camera ON OFF ON ON

TouchPad ON ON ON OFF

Airplane Mode OFF ON OFF OFF
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Control Center Menus
The Control Center contains 3 menu headings (System Program, Device and Gaming) under the Power
Modes. Click the menu headings and then click any of the buttons outlined on the following pages. 

Figure B - 2 - Control Center Menus



Display Utility

The Display Utility icon 
will only appear in the Sys-
tem Program menu if your
display’s resolution is QHD
(2560 * 1440) or above.

The Display Utility allows
you to adjust text size on the
screen to make it easier to
view (see page B - 8).

The System Program will
display an arrow icon  at
the bottom right of the menu
which you can click to allow
you to access the second
page of the menu containing
the Time Zone item.
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Power Status (System Program)  

The Power Status icon will show whether you are currently powered by the battery, or by the AC/DC adapter
plugged in to a working power outlet. The power status bar will show the current battery charge state.

Brightness (System Program) 
The Brightness icon will show the current screen brightness level. You can use the slider to adjust the screen
brightness or the Fn + F8/F9 key combinations, or use the Fn+ F2 key combination to turn off the LED backlight
(press any key to turn it on again).

Volume (System Program)
The Volume icon will show the current volume level. You can use the slider to adjust the Volume or the Fn +
F5/F6 key combinations, or use the Fn+ F3 key combination to mute the volume.

Fan Speed (System Program)
You can set the fan speed to Maximum (full power), Automatic or Custom from this menu item. The fan speed
will adjust itself automatically to control the heat of the CPU. However you can adjust the setting to maximum
if you prefer. Select Custom and click on the sliders to adjust the settings to your preference, however these set-
tings can be overridden by the system, as a safety precaution, if it requires heavier use of the fan.



Custom Settings

Click Save to retain customized settings, or Reset to select default settings.
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Power Conservation (System Program)
This system supports Energy Star power     
management features that place computers (CPU, hard drive, etc.) into a low-power sleep modes after a desig-
nated period of inactivity (see “Power Conservation Modes” on page 3 - 12). Click either the Performance,
Balanced or Energy Star button.

Sleep Button (System Program) 
Click either the Hibernate or Sleep buttons to have the computer enter the selected power-saving mode (see
“Power-Saving States” on page 3 - 7).

Display Switch (System Program) 
Click the Display Switch button to access the menu (or use the  + P key combination) and select the appro-
priate attached display mode.

Display Utility (System Program for High Definition displays only) 
The Display Utility button will only appear in the menu for QHD (2560 * 1440) or above displays (see page B
- 8).

Time Zone (System Program) 
Clicking the Time Zone button will access the Date and Time Windows control panel.

Desktop Background (System Program) 
Clicking the Desktop Background button will allow you to change the desktop background picture.
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Backlight Keyboard (Device) 
Click the numbers under the Backlight Keyboard icon to 
adjust the brightness of the keyboard backlight LED. 

TouchPad/Camera (Device) 
Click either of these buttons to toggle the TouchPad or camera module’s power status. The icon will appear
dimmed when it is off. Note that the power status of the camera module is also effected by the Power Mode
selected (see Table B - 1, on page B - 3).

Caps Lock/Scroll Lock/ Number Lock/Airplane Mode
Click the button to toggle the appropriate lock mode and Airplane Mode.

Left Windows Key (Gaming) 
Click Disable to disable the Windows Key on the left side of the keyboard. This may be useful if you are using
the gaming keys (W, A, S & D) and wish to avoid accidentally triggering menus with the Windows Key.

Headphone (Gaming) 
The headphones may be set for different effects using this menu.

Flexikey® (Gaming) 
Click the button to access the Flexikey® application. 
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Display Utility (System Program for High Definition displays only)
The Display Utility icon  will only appear in the System Program menu if your display’s resolution is QHD
(2560 * 1440) or above. The Display Utility allows you to adjust text size on the screen to make it easier to view.

The initial screen will display the default Express settings as indicated below.

Figure B - 3 - Display Utility - Express Settings

Click Save to retain the settings, and you will then need to sign out of the computer, and sign back in again, to
adjust the settings. Note that you must save any open files and close open programs before signing out in
order not to lose any work.
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Click Advanced to adjust the settings to adjust the overall DPI scaling to your requirements, or you can also
click on the items (Icons, Title Bars, Message Boxes, Menus, Tool Tips & Palette Titles) in the lower half of
the screen to customize the text size.

Figure B - 4 - Display Utility - Advanced Settings

Click Save to retain the settings, and you will then need to sign out of the computer, and sign back in again, to
adjust the settings. Note that you must save any open files and close open programs before signing out in
order not to lose any work.

Any changes made to the individual text size items are linked to the overall DPI Scaling selected. If you change
the DPI scaling, the customized text size changes will become grayed out and will only become available again
after you have signed out of the computer, and signed back in again.
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The System Program will display an arrow icon  at the bottom right of the menu which you can click to allow
you to access the second page of the menu containing the Time Zone item.

Figure B - 5 - Time Zone (if Display Utility is Included)
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Flexikey® Application
Click the button  in the Control Center, or the click the icon   in the notification area of the taskbar,
to access the Flexikey® application.

Profiles
The menus on the left side of the application relate to Profiles. You can Add or Delete Profiles (you can main-
tain 12 active Profiles), Export and Import profiles from the menus. If you double-click on a Profile you can
change the Profile Name, and change an Image file (images created using PNG files).

Figure B - 6 - Flexikey® - Profiles


Windows Key  & 

P Key

Note that you can
assign actions to
any keyboard key
except the Win-
dows key  and P
key.
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Flexikey® Application Features

• EXPRESS KEY - This feature allows you to configure a single key to send multiple key combinations or to 
create more useful shortcut keys. This is useful in gaming or when using applications which have a complex 
set of keyboard shortcuts.

• LAUNCH APP - This simply assigns single keys to launch any program’s or application’s executable file.

• EXPRESS TEXT - With this you can assign single keys to send commonly used strings of text.

• DISABLE - Use this function to disable any keyboard keys.

• STATISTICS - Use this to quickly record keys in use in any application, and to disable unused keys.

Keyboard and Mouse Settings
Click Enable to create settings for the keyboard and/or mouse by clicking the button on the top left of the screen
(e.g. you may wish to create a profile with settings only for the mouse or keyboard). Clicking on the keyboard
or mouse icons will allow you to access the settings page for the either the keyboard or mouse.

Figure B - 7 - Enable Keyboard & Mouse / Language Selection

Language Interface
You can change the language interface by right-clicking the icon  in the notification area of the taskbar and
selecting the language from the menu.
B - 12 Flexikey® Application
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Enabling or Disabling Flexikey®
You can enable or disable Flexikey® (and therefore any hotkeys or mouse profile functions currently in use) by
using the Fn + Backspace key combination. Pressing this key combination will toggle you between the currently
selected keyboard or mouse profile to the standard keyboard and/or mouse settings, and back again.

Figure B - 8 - Enable/Disable Flexikey®

The icon Flexikey® icon in the notification area of the taskbar will appear grayed out  when Flexikey® is off,
and in color  when on (an on screen icon will also pop-up to display the status of the application as it is toggled
on/off).

Figure B - 9 - Taskbar Notification Area Icons

Flexikey® Enabled

Flexikey® Disabled
Flexikey® Application B - 13
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Keyboard Settings
The keyboard settings allow you to configure actions for any single key (or a combination of keys). Click the
key and then select the Action Type (Express Key, Launch App, Express Text or Disable) from the menu at
the bottom of the page. You can rename the action by clicking in the Name box, and click in Tool Tips to type
in a note to remind you of the action’s function.

Figure B - 10 - Key Configuration


Windows Key  & 

P Key

Note that you can
assign actions to
any keyboard key
except the Win-
dows key  and P
key.
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Mouse Settings
When an external mouse is attached, the mouse settings allow you to configure actions for the left , right 
and middle  buttons of the attached mouse, and also for any backward  and forward  buttons if appli-
cable (on a gaming type mouse). Click the button number and then select the Action Type (Express Key,
Launch App, Express Text or Disable) from the menu at the bottom of the page. You can rename the action
by clicking in the Name box, and click in Tool Tips to type in a note to remind you of the action’s function.

Figure B - 11 - Mouse Configuration

1 2
3 4 5
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Keyboard Settings - Express Key
To configure a single key to send multiple key combinations, or to create more useful shortcut keys, use Express
Key. 

1. Enable and select the keyboard under your chosen profile, click on a key to select it, and then click to select 
Express Key in Action Type.

2. In the following example we want to change an existing game key configuration which uses the left shift key for 
sprinting, and the W key for moving forwards, to use the left Ctrl key to combine this movement to sprint 
forward.

3. Click on the chosen key for the shortcut action.
4. Click in the Tool Tips field and type to give the key combination a name e.g. “Sprint Fwds”, then click back in 

the Name field (to avoid adding the recorded keys to the Tool Tips name).
5. Click Start Record and then press the key or keys (in this case we will press Left Shift and W) required (make 

sure you press the key(s) required and do not click on them).
6. Click Stop Record to complete the process.

Figure B - 12- Express Key Record Key Combination
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7. Click Save to save the settings within your chosen profile.
8. If you want to remove any individual key click to select it, and then click Delete.
9. If you want to clear all the settings click Restore to return to the default key setting.
10. Any assigned Express Keys will appear in orange.

Figure B - 13 - Key Combination Set


Tool Tips

The Tool Tips field allows you to type a note to remind yourself of the function you have programmed the key for under
any Profile.
Keyboard Settings - Express Key B - 17
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Enabling Time Record
If you want to create a delay between key presses within the key combination, then you can use Time Record
function to do so.

1. Enable and select the keyboard under your chosen profile, click to select a key for the shortcut action, and then 
click to select Express Key in Action Type.

2. Click in the Tool Tips field and type to give the key combination a name, then click back in the Name field (to 
avoid adding the recorded keys to the Tool Tips name).

3. Click Start Record and then press the key or keys required in the sequence and time delay between key 
presses required (make sure you press the key(s) required and do not click on them).

4. Click Stop Record.
5. Click to select a key in the sequence and click Enable Time Record , then click a 

key to view the time delay.

Figure B - 14 - Enable Time Record
B - 18 Keyboard Settings - Express Key
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6. You can edit the delay between key presses by clicking in the Delay Time (MS) field and typing a new number 
for the delay between the key presses.

Figure B - 15 - Time Record Between Key Presses

7. Click  to close the Time Record window.
8. Click Save to save the settings within your chosen profile.
9. If you want to remove any individual key click to select it, and then click Delete.
10. If you want to clear all the settings click Restore to return to the default key setting.
Keyboard Settings - Express Key B - 19
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Keyboard Settings - Launch App
You can configure keys to launch any application or program as follows:

1. Enable and select the keyboard under your chosen profile, click to select a key to launch the application, and 
then click to select Launch App in Action Type.

2. Click Browse... at the bottom right of the application window.

Figure B - 16 - Keyboard - Launch App (Browse to Executable File)
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3. Navigate to the executable file of the application and click Open.
4. The key will now be configured to open the selected application under your chosen Profile, and the key will 

appear in green.

Figure B - 17 - Key Set to Launch App

5. If you want to remove any Launch App Key, select it and click on Restore.
6. Click Save to save the settings within your chosen profile.
Keyboard Settings - Launch App B - 21
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Keyboard Settings - Express Text
A single key can be set to send a string of text within any application using Express Text.

1. Enable and select the keyboard under your chosen profile, click to select a key, and then click to select Express 
Text in Action Type.

2. Click in Start key if required (the Start key is the key used to in your target program to open a text message), or 
you can leave it blank if you prefer.

3. Click in the Click to type field and type in your message.

Figure B - 18 - Keyboard - Express Text
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4. Click in Send key if required (the Send key is the key used to in your target program to send a text message e.g 
the Enter key would be the most commonly used), or you can leave it blank if you prefer.

5. The key will now be configured to send the text message in the target program under your chosen Profile, and 
the key will appear in blue.

6. If you want to remove any Express Text key, select it and click on Restore.
7. Click Save to save the settings within your chosen profile.


Copy & Paste Text

Note that some applications and games do not support copy and pasted text. Where this is the case, any text you may have
copy and pasted in to the “Type to Text” field may not be displayed within the application. In this case you will need to type
the text into the field instead.
Keyboard Settings - Express Text B - 23
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Keyboard Settings - Disable
You can use the program to disable any keys not required.

1. Enable and select the keyboard under your chosen profile, click to select a key to disable, and then click to select 
Disable in Action Type.

2. The key will now be disabled.
3. If you want to enable the key again, select it and click on Restore.
4. Click Save to save the settings within your chosen profile.
5. The key will be disabled under your chosen Profile, and the key will appear in Gray.

Figure B - 19 - Keyboard - Disable
B - 24 Keyboard Settings - Disable
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Mouse Settings - Express Key
To assign a mouse button click to send multiple key combinations (an external mouse must be attached), or to
create more useful shortcut keys, use Express Key. 

1. Enable and select the mouse under your chosen profile, click on a mouse button to select it, and then click to 
select Express Key in Action Type.

2. In the following example we will configure the central mouse wheel to combine the actions of left shift key for 
sprinting, and the W key for moving forwards in a game program.

3. Click on the central mouse wheel for the shortcut action.

Figure B - 20 - Mouse - Express Key Record Key Combination (Mouse)
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4. Click in the Tool Tips field and type to give the key combination a name e.g. “Sprint Fwds”, then click back in 
the Name field (to avoid adding the recorded keys to the Tool Tips name).

5. Click Start Record and then press the key or keys (in this case we will press Left Shift and W) required (make 
sure you press the key(s) required and do not click on them).

6. Click Stop Record to complete the process.
7. Click Save to save the settings within your chosen profile.
8. If you want to remove any mouse setting click to select it, and then click Delete.
9. If you want to clear all the settings click Restore to return to the default mouse setting.
10. The mouse button for any assigned Express Keys will appear in orange.

Enabling Time Record for Mouse Settings
If you want to create a delay between key presses within the mouse click combination, then you can use Time
Record function to do so in the same manner as that used for keyboard settings (see “Enabling Time Record”
on page B - 18).
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Mouse Settings - Launch App
You can assign a mouse button click to launch any application or program as follows:

1. Enable and select the mouse under your chosen profile, click on a mouse button to select it, and then click to 
select Express Key in Action Type.

2. Click Browse... at the bottom right of the application window.

Figure B - 21 - Mouse - Launch App (Browse to Executable File)
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3. Navigate to the executable file of the application and click Open.
4. The mouse click will now be configured to open the selected application under your chosen Profile, and the 

button will appear in green
5. Click Save to save the settings within your chosen profile.

Figure B - 22 - Mouse Button Set to Launch App
B - 28 Mouse Settings - Launch App
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Mouse Settings - Express Text
A mouse button click can be set to send a string of text within any application using Express Text.

1. Enable and select the mouse under your chosen profile, click on a mouse button to select it, and then click to 
select Express Text in Action Type.

2. Click in Start key if required (the Start key is the key used to in your target program to open a text message), or 
you can leave it blank if you prefer.

3. Click in the Text Context field and type in your message.

Figure B - 23 - Mouse - Express Text
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4. Click in Send key if required (the Send key is the key used to in your target program to send a text message e.g 
the Enter key would be the most commonly used), or you can leave it blank if you prefer.

5. The mouse button click will now be configured to send the text message in the target program under your 
chosen Profile, and the button will appear in blue.

6. If you want to remove any Express Text mouse button, select it and click on Restore.
7. Click Save to save the settings within your chosen profile.
B - 30 Mouse Settings - Express Text
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Mouse Settings - Disable
You can use the program to disable any mouse button clicks if not required.

1. Enable and select the mouse under your chosen profile, click on a mouse button to select it, and then click to 
select Disable in Action Type.

2. The button click will now be disabled.
3. If you want to enable the button again, select it and click on Restore.
4. Click Save to save the settings within your chosen profile.
5. The button click will be disabled under your chosen Profile, and the key will appear in Gray.

Figure B - 24 - Mouse - Disable
Mouse Settings - Disable B - 31
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Statistics
The Statistics tab allows you to record keys used in any application, and to disable any infrequently, or unused,
keys to save any accidental incorrect key presses.

1. Click the Statistics Tab, and press Start Record to start recording the frequency of key presses for keys used.
2. You can then go to the application you wish to use the profile for, and use the application as normal so that a 

standard set of keys used may be recorded.
3. Return to the Flexikey® application and press Stop Record to stop recording. 
4. At the end of the recording process colors will represent the frequency of key presses, with red as the most 

frequent through to lighter blue the less frequent (the color bar at the bottom of the screen displays the color 
code against the number of key presses).

5. Under Quick Disable click the color which corresponds to the keys you wish to disable.
6. All disabled keys will then change to gray and will be disabled under this profile.

Figure B - 25 - Statistics
B - 32 Statistics
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Appendix C: Video Driver Controls

Overview
The basic settings for configuring the LCD are outlined in “Video Features” on
page 1 - 38.

The basic video features for this computer can be configured using the Intel(R)
Iris(TM) Graphics Control Panel. Further video configuration is available
through the NVIDA control panel. See the following pages for further information.

• For Intel video driver control information see pages C - 5 to C - 29.
• For NVIDA video driver control information see pages C - 30 to C - 36.


Video Card Options

Note that card types,
specifications and driv-
ers are subject to contin-
ual updates and
changes. Check with
your distributor/supplier
for the latest details on
video cards supported
(see “Video Adapter
Options” on page D -
2).
Overview C - 1
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Microsoft Hybrid Graphics
Most notebook computers come with either a discrete or integrated graphics solu-
tion.

Discrete graphics solutions feature a dedicated Graphics Processing Unit (GPU)
which are capable of playing games, watching HD video or running GPU-based ap-
plications. However computers with discrete graphics solutions tend to be heavy in
power consumption, and slightly larger in size in order to incorporate the dedicated
discrete GPU.

Integrated graphics solutions usually feature memory sharing technology to help
save power consumption and allow for longer battery life. However computers with
integrated graphics solutions will not usually run games, HD video or GPU-based
applications without severe limitations.

Microsoft Hybrid Graphics is a seamless switchable graphics technology designed
to get best performance from the graphics system while allowing longer battery life,
without having to manually change settings. Thus when an application is run that re-
quires extra performance or quality, then the operating system will run the discrete
GPU (dGPU); when the system does not require such enhanced performance it will
let the integrated (iGPU) handle it.
C - 2 Microsoft Hybrid Graphics
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How Switchable Technology works
When the system is powered up and is displaying just the desktop, the dGPU will be
powered off. In this case the system is running in the same way as a system without
a discrete graphics solution. However when an application that requires use of the
dGPU is run (e.g, a game or HD Video), the dGPu is powered on and takes over the
processing duties. If the program is closed, then the dGPU will be powered back
down again until required.

The GPU LED indicator will display which GPU is currently in use.

Make sure you install all the necessary video drivers for your system (see overleaf).

Icon Color Description

Off Integrated GPU (iGPU) In Use

Green Discrete GPU (dGPU) Is Powered

Table C - 1
GPU LED Indicator
Microsoft Hybrid Graphics C - 3
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Video Driver Installation
Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 4.
Insert the Device Drivers & Utilities + User’s Manual disc into an attached DVD
drive and click Install Drivers (button).

Video (VGA)
1. Click 2.Install VGA Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

NVIDIA Video (VGA)
1. Click 3.Install NVIDIA VGA Driver > Yes.
2. Click AGREE AND CONTINUE (button) to accept the terms of the 

license agreement.
3. Click Next.
4. Click the Close to complete the installation.


iGPU or dGPU

Note the NVIDIA control
panel refers to High-
performance NVIDIA
processor (which is the
discrete GPU) and Inte-
grated graphics (which
is the integrated GPU).
C - 4 Video Driver Installation
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Intel® Iris(TM) Graphics Control Panel
Advanced video configuration options are provided by the Intel(R) Iris(TM)
Graphics Control Panel. To access the control panel see below and overleaf:

1. Click the Intel® Iris™ Graphics Control Panel icon in the Apps screen.

(see over)


Intel® Dynamic 
Video Memory 

Technology

Intel® DVMT automati-
cally and dynamically al-
locates as much (up to
1748MB) system mem-
ory (RAM) as needed to
the integrated video sys-
tem (the video driver
must be installed).

DVMT returns whatever
memory is no longer
needed to the operating
system.

Figure C - 1
Start Screen

Intel® Iris™ 

Graphics Control 

Panel
Intel® Iris(TM) Graphics Control Panel C - 5
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OR
2. Right-click the Desktop and select Graphics Properties from the menu.
OR
3. Click Advanced settings in the Screen Resolution control panel in Windows.
4. Click the Intel® Iris™ Graphics Control Panel tab and click Graphics

Properties (button).
OR
5. Double-click Intel® Iris™ Graphics in the Windows Control Panel.
OR
6. Click the icon  in the notification area of the Desktop taskbar and select

Graphics Properties from the menu 

Figure C - 2
Intel® Iris(TM) 

Graphics Control 

Panel Access
C - 6 Intel® Iris(TM) Graphics Control Panel
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You can make changes to any of the graphics properties by clicking the appropriate
menu panel and adjusting the settings on the right.

Figure C - 3
Intel® Iris(TM) 

Graphics Control 

Panel
Intel® Iris(TM) Graphics Control Panel C - 7
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Sub-Menus
Some of the menu panels will also have sub-menus (in the top left corner of the menu
alongside the icon ) to display further configuration options.

Figure C - 4
Intel® Iris(TM) 

Graphics 

Control Panel

Sub-Menus
C - 8 Intel® Iris(TM) Graphics Control Panel
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Display
Click either Display Settings or Color to make display adjustments, including con-
figuration for any attached external displays.


Multiple Display 

At least one other dis-
play must be attached in
order to view multiple
display selection op-
tions.

Figure C - 5
Intel® Iris(TM) 

Graphics 

Control Panel 

Display Settings
Intel® Iris(TM) Graphics Control Panel C - 9
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Click the Display menu at the top of the screen to display the sub-menus. The Mul-
tiple Displays menu allows you to configure the display mode of any attached dis-
plays (see “Attaching Other Displays” on page C - 21).


Multiple Display 

At least one other dis-
play must be attached in
order to view multiple
display selection op-
tions.

Figure C - 6
Intel® Iris(TM) 

Graphics Control 

Panel Display 

Settings - Multiple 

Displays
C - 10 Intel® Iris(TM) Graphics Control Panel
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The Audio Settings sub-menu (if applicable) allows you to configure the capability
mode of any attached displays (i.e. the attached display supports audio). Enable Au-
dio Without Video to keep audio on when the display blanks out for power saving
purposes.

Figure C - 7
Intel® Iris(TM) 

Graphics 

Control Panel 

Display - Audio 

Settings
Intel® Iris(TM) Graphics Control Panel C - 11
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3D
This menu allows you to choose how 3D images are displayed. Performance dis-
plays the smoothest motion of images, Quality displays the most detail, Balanced
provides better computer performance with good quality and Custom allows you to
configure the Anisotropic Filtering and Vertical Sync features to your preferences.
Click Apply to save changes.

Figure C - 8
Intel® Iris(TM) 

Graphics

Control Panel 3D
C - 12 Intel® Iris(TM) Graphics Control Panel
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Options
Options allows you to Customize Hot Keys (for opening the application, rotating
the display, scaling etc.,) to your preferences. Click Apply to save changes.

Figure C - 9
Intel® Iris(TM)   

Graphics Control 

Panel Options & 

Support 

(Hot Key Manager)
Intel® Iris(TM) Graphics Control Panel C - 13
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Click the Options menu at the top of the screen to display the sub-menus. The In-
formation Center provides details on System Information, the Built-In Display
and any attached displays.


Preferences 

Go to the Preferences
sub-menu in Options
and Support to config-
ure preferences for the
Intel® Iris(TM) Graphics
Control Panel.

Make sure you turn Tray
Icon On to display the
icon in the notification
area of the taskbar (as
below).

Figure C - 10
Intel® Iris(TM) 

Control Panel 

Options - 

Information Center
C - 14 Intel® Iris(TM) Graphics Control Panel
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Video
The Video Profiles menu allows you to brighten or darken movies, or to switch to
vivid colors. Click Basic or Advanced to adjust the video settings based on the Ap-
plication Settings or Driver Settings. The Preview image will display a sample im-
age using the current settings. You can Save Profile and name the Profile to recall
the settings at any time. Click Apply to save changes.

Figure C - 11
Intel® Iris(TM) 

Control Panel Video 

(Basic - Application 

Settings)
Intel® Iris(TM) Graphics Control Panel C - 15
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Click the Video menu at the top of the screen to display the sub-menus.The Image
Enhancement menu allows you to adjust the Sharpness, Skin Tone Enhance-
ment, Noise Reduction etc. Click Apply to save changes.

Figure C - 12
Intel® Iris(TM) 

Control Panel Video 

Image 

Enhancement Basic
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The Image Scaling and Gamut Mapping menus allow you to adjust these items. 

Figure C - 13
Intel® Iris(TM) 

Control Panel Video 

Image Scaling & 

Gamut Mapping
Intel® Iris(TM) Graphics Control Panel C - 17
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Power
Choose a Power Plan for when the computer is Plugged in or On battery. When
turned on, the Display Power Saving Technology (which adjusts the backlight in-
tensity) battery settings may be adjusted by means of the slider towards Maximum
Quality or Maximum Battery. Click on Apply to save changes.

Figure C - 14
Intel® HD Graphics 

Control Panel Power 

(Battery Settings)
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Support
Click Support and select an item from the menus to bring up the help and support
topics. You will need to be connected to the Internet to access the key resource links.

Figure C - 15
Intel® HD Graphics 

Control Panel 

Support
Intel® Iris(TM) Graphics Control Panel C - 19
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Display Devices & Options
Note that you can use external displays connected to the HDMI-Out port and/or ex-
ternal display port/mini display port. See your display device manual to see which
formats are supported.

Display Mode Description

Single Display
One of the connected displays is used as the display device (PC 
screen only or Second screen only).

Clone/Duplicate
Both connected displays output the same view and may be 
configured independently

Extended / Extend 
Both connected displays are treated as separate devices, and act 
as a virtual desktop

Collage
A number of connected displays are combined into a single 
unified higher resolution for larger screen sizes 

Table C - 2
Display Modes


Attaching Displays

When you first attach an external display you may find that the desktop does not occupy
the full screen area. Use either the display’s auto adjust/configure controls, or the Intel(R)
HD Graphics Control Panel to configure the full screen display.
C - 20 Display Devices & Options



Video Driver Controls

C

Attaching Other Displays
To Clone Displays:
1. Attach your external display to the display port/mini display port/HDMI-Out port, and 

turn it on.
2. Go to the Intel(R) HD Graphics Control Panel control panel and click Display >

Multiple Displays (sub-menu).
3. Click Clone from the Select Multiple Display Mode menu.
4. Click Apply, and OK to confirm the settings change.
5. You can select the displays to be used from the Select Active Displays menu.


Multiple Display 

At least one other dis-
play must be attached in
order to view Multiple
Display selection op-
tions.

Figure C - 16
 Display > Multiple 

Displays (Clone)
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To Enable Extended Mode:
1. Attach your external display to the display port/mini display port/HDMI-Out port, and 

turn it on.
2. Go to the Intel(R) HD Graphics Control Panel control panel and click Display >

Multiple Displays (sub-menu).
3. Click Extended from the Select Multiple Display Mode menu.
4. Click Apply, and OK to confirm the settings change.


 Display Settings 

Extended Desktop 

You can have different
Colors, Screen Area
and Monitor Refresh
Rates for each display
device provided your
monitor can support
them.

You can drag the moni-
tor icons to match the
physical layout of your
displays. Icons and pro-
grams may also be
dragged between the
displays.

Figure C - 17 

Display > Multiple 

Displays (Extended)

Click the appropriate monitor icon and drag it to match the physical arrangement
you wish to use (e.g. the secondary display may be extended left/right/above/be-
low the primary display). Click Display Settings to make adjustments required.
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To Enable Collage Mode:
1. Attach your external displays to the external monitor port and HDMI-Out port, and turn 

them on.
2. Go to the Intel(R) HD Graphics Control Panel control panel and click Display >

Multiple Displays (sub-menu).
3. Click Collage from the Select Multiple Display Mode menu.
4. Click Enable Collage and click On.
5. Click Vertical or Horizontal to arrange and displays as required.
6. Click Apply, and OK to confirm the settings change.


 Collage Mode 

Collage mode is used to
combine a number of
displays into a single
unified higher resolution
for larger screen sizes,.

Figure C - 18 

Display > Multiple 

Displays (Collage)
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Attaching Other Displays - Devices (Charms Bar)
You can configure attached displays from Devices (in the Charms Bar).
1. Attach your external display to the display port/mini display port/HDMI-Out port, and 

turn it on.
2. Go the Charms Bar, select Devices.
3. Click Project (you may need to click Second Screen).
4. Click on any one of the options from the menu to select PC screen only,

Duplicate, Extend or Second screen only.


Windows Logo Key 

 + P Key 
Combination

You can use the  + P
key combination to
quickly bring up the Sec-
ond Screen menu.

You can also use the
Display Switch button
in the Control Center to
access the menu and
select the appropriate
attached display mode.

You can also use the Fn
+F7 key combination to
quickly access the Sec-
ond Screen menu in
Windows 8.

Figure C - 19
Second Screen 

(Devices)
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Configuring an External Display In Windows
1. Attach your external display to the display port/mini display port/HDMI-Out port, and 

turn it on.
2. Go to the Screen resolution control panel (see page 1 - 39) in the Desktop app.
3. Click the Detect button.
4. The computer will then detect any attached displays.

Figure C - 20
Screen Resolution 

Multiple Displays
Attaching Other Displays - Devices (Charms Bar) C - 25
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5. You can configure the displays from the Multiple Displays menu.

• Duplicate these displays - Shows an exact copy of the main display desktop on 
the other display(s)

• Extend these displays - Treats both connected displays as separate devices
• Show desktop only on 1/2 - Only one of your displays is used.

Figure C - 21 

Screen Resolution 

Multiple Display 

Options
C - 26 Attaching Other Displays - Devices (Charms Bar)
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HDMI Audio Configuration
HDMI (High-Definition Multimedia Interface) carries both audio and video signals.
In some cases it will be necessary to go to the Sound control panel and manually
configure the HDMI audio output as per the instructions below.

1. Go to the Control Panel.
2. Click Sound  (Hardware and Sound) and click Playback (tab)
3. Depending on your display, the playback device may be selected, however in some 

cases you may need to select the audio device and click Set Default (button).
4. Double-click the device to access the control panel tabs illustrated overleaf.


Volume Adjustment

The sound volume level
can be set using the vol-
ume control in the Set-
tings menu in the
Charms Bar.

Figure C - 22
Sound - HDMI 

Device (set Default)
HDMI Audio Configuration C - 27



Video Driver Controls

C

5. Adjust the HDMI settings from the control panel tabs.
6. Click OK to close the Sound  control panel.

Figure C - 23
HDMI Device 

Properties
C - 28 HDMI Audio Configuration
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HDMI Notes
• Connect a device with HDMI support to the HDMI-Out port BEFORE attempt-

ing to play audio/video sources through the device.
• To play audio sources through your external display’s (TV or LCD) speakers 

you will need to go to the audio configuration control panel on the display and 
configure the audio input accordingly (see your display device manual).

HDMI Video Configuration
1. Connect an HDMI cable from the HDMI-Out port to your external display.
2. Configure your external display as per the instructions in “Attaching Other

Displays” on page C - 21.
3. Set up your external display (TV or LCD) for HDMI input (see your display device

manual).
4. You can now play video/audio sources through your external display.

Sound Blaster Audio & HDMI
1. When you connect an HDMI display to the HDMI-Out port (and Mini Display port) 

the Sound Blaster Cinema EQ controls will be disabled. 
2. A warning box will pop-up and will prompt “...Do you want to select another 

audio device now?”.
3. Click No to continue using the HDMI audio output from your external display (do 

not attempt to select another audio device when connected to the external 
display).


Other Applications

If you are using a third
party application to play
DVDs etc. from any at-
tached DVD device,
you will need to consult
the application’s docu-
mentation to see the
appropriate audio con-
figuration (the applica-
tion must support
digital to analog trans-
lation).
HDMI Audio Configuration C - 29
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NVIDIA Control Panel
More advanced video configuration options are provided in the NVIDIA Control
Panel tab.

1. Go to the Control Panel.
2. Double-click NVIDIA Control Panel (click to view the control panel in either Large

icons or Small icons if you are in Category view).


NVIDIA Control 

Panel 

To access the Ge-
Force..... control panel
from the desktop; right-
click the desktop, then
click NVIDIA Control
Panel.

Figure C - 24
NVIDIA Control 

Panel
C - 30 NVIDIA Control Panel
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The NVIDIA Control Panel provides additional video configuration controls and
tools which allow quick access to features such as image settings, 3D Settings and
video configuration.


Navigating the 
Control Panel

Navigate through the
control panels in much
the same way as you
would a web page.
Click on the sub-head-
ing tasks in the left
menu (and on the high-
lighted links) for infor-
mation. Use the
buttons on the top left
to go back, forward
etc.

Figure C - 25
NVIDIA Control 

Panel
NVIDIA Control Panel C - 31
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Customization Options
One of the most important aspects of hybrid technology is that it will switch between
the integrated GPU and discrete GPU seamlessly and automatically, and does not re-
quire any input from the user. However customization options are offered for users
who prefer to set their own parameters for GPU usage.

Context Menu
One of the quickest ways to choose which GPU to use for a particular application is
by using the “Run with graphics processor” in the context menu.

1. Go to the NVIDIA Control Panel.
2. Click Desktop from the top menu and select Add “Run with graphics

processor” to Context Menu (it should have a check alongside it).


Display GPU 
Activity Icon

Click to enable Dis-
play GPU Activity
Icon in the Notifica-
tion Area to quickly
access the GPU Activ-
ity monitor from the
taskbar.

Figure C - 26
NVIDIA Control 

Panel - View
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3. Close the NVIDIA Control Panel.
4. Find the executable file icon of the application you want to run.
5. Right-click the icon and select Run with graphics processor from the context

menu.
6. Select either High-performance NVIDIA processor (dGPU) or Integrated

graphics (iGPU) to run the program with the selected GPU.


iGPU or dGPU

Note the NVIDIA con-
trol panel refers to
High-performance
NVIDIA processor
(which is the discrete
GPU) and Integrated
graphics (which is the
integrated GPU).

Figure C - 27
Context Menu with 

Run with graphics 

processor

Right-click the application executable file
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Global Settings
Global settings allows you to set the preferred graphics processor for overall use.
Ideally this would be the iGPU for battery life, but this can be set to the dGPU if pre-
ferred.

1. Go to the NVIDIA Control Panel.
2. Click Manage 3D Settings (3D Settings) and select Global Settings (tab).
3. Select either Integrated graphics (iGPU) or High performance NVIDIA

Processor (dGPU) from the drop-down menu.
4. Click the Setting menu items to select any options required.
5. Click Apply to save the settings.


Customization 

Options

Although hybrid tech-
nology is completely
seamless to the user,
there are customiza-
tion options within the
control panel (see
page C - 32).

Figure C - 28
Global Settings
C - 34 Customization Options
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Program Settings
Program settings allows you to make specific adjustments for installed applications.

1. Go to NVIDIA Control Panel.
2. Click Manage 3D Settings (3D Settings) and select Program Settings (tab).
3. Select a program to customize from the drop-down menu, or click Add to add

any program that does not appear in the menu.
4. Select the preferred graphics processor for the program from the drop-down

menu.
5. Click the Setting menu items to select any options required.
6. Click Apply to save the settings.

Figure C - 29
Program Settings
Customization Options C - 35
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Set PhysX® Configuration
NVIDIA® PhysX® is a physics engine that can use the GPU to accelerate game and
3D application performance. You can select the GeForce video card or CPU as a
PhysX® processor, or configure the computer to auto-select a PhysX® processor
(recommended default setting).

1. Go to NVIDIA Control Panel.
2. Click Set PhysX configuration.
3. Click to Select a PhysX processor from the menu; Auto-select (recommended) is

the default setting.
4. Click Apply to save the settings.

Figure C - 30
Set PhysX® 

Configuration
C - 36 Set PhysX® Configuration
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Appendix D: Specifications


Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/
speeds and CD/DVD device types) may be changed, updated or delayed due to the manufacturer's release schedule. Check
with your distributor/supplier for details.
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Processor

Intel® Core™ i7-5700HQ (2.70GHz) 
Processor
6M Smart Cache, 14nm (14 Nanometer), 
DDR3L-1866MHz, TDP 47W

Intel® Core™ i7-4870HQ (2.50GHz) 
Processor
6M L3 Cache, 22nm (22 Nanometer), 
DDR3L-1600MHz, TDP 47W

Intel® Core™ i7-4720HQ (2.60GHz) 
Processor
6M L3 Cache, 22nm (22 Nanometer), 
DDR3L-1600MHz, TDP 47W

For Model A Designs I, II & V and 
Model B Designs I & II:
Intel® Core™ i7-4980HQ (2.60GHz) 
Processor
6M L3 Cache, 22nm (22 Nanometer), 
DDR3L-1600MHz, TDP 47W

Intel® Core™ i7-4770HQ (2.10GHz) 
Processor
6M L3 Cache, 22nm (22 Nanometer), 
DDR3L-1600MHz, TDP 47W

Core Logic

Mobile Intel® HM87 Express Chipset

Display

For Model A Designs I, II & V:
15.6" (39.62cm) QFHD (3840 * 2160) / 
WQHD+ (2880 * 1620) / FHD (1920 * 
1080) 3.5mm 16:9 Backlit Panel

For Model A Designs III & IV:
15.6" (39.62cm) QFHD (3840 * 2160) / 
FHD (1920 * 1080) 3.5mm 16:9 Backlit 
Panel

For All Model B Designs:
17.3" (43.94cm) FHD (1920 * 1080) 
6.0mm 16:9 Backlit Panel

Memory

Dual Channel DDR3L

Four 204 Pin SO-DIMM Sockets 
Supporting DDR3L 1600 MHz Memory 
Modules (real operational frequency 
depends on the FSB of the processor)

Memory Expandable from 4GB 
(minimum) up to 32GB (maximum)
Compatible with 2GB/4GB/8GB Modules

Video Adapter Options

Microsoft Hybrid Graphics - GPU 
Switchable between iGPU & dGPU

For Model A Designs I & V and Model 
B Design I:
NVIDIA® GeForce GTX 970M PCIe * 16
3GB GDDR5 Video RAM 
Microsoft DirectX® 12 compatible
NVIDIA PhysX™
GeForce CUDA™ Technology

For Models A & B Design II:
NVIDIA® GeForce GTX 980M PCIe * 16
4GB GDDR5 Video RAM 
Microsoft DirectX® 12 compatible
NVIDIA PhysX™
GeForce CUDA™ Technology

For Model A Designs III & IV and Model 
B Design III:
NVIDIA® GeForce GTX 965M PCIe * 16
2GB GDDR5 Video RAM 
Microsoft DirectX® 12 compatible
NVIDIA PhysX™
GeForce CUDA™ Technology
D - 2 Specifications
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Intel® HD Graphics 5600
(Integrated with i7-5700HQ GPU)
Dynamic Frequency
Intel® Dynamic Video Memory 
Technology Supporting Shared Memory 
up to 1.7GB
Microsoft DirectX® 11.1 compatible

Intel® HD Graphics 5200
(Integrated with i7-4870HQ / i7-4980HQ 
GPU)
Dynamic Frequency
Intel® Dynamic Video Memory 
Technology Supporting Shared Memory 
up to 1.7GB
Microsoft DirectX® 11.1 compatible

Intel® HD Graphics 4600
(Integrated with i7-4720HQ GPU)
Dynamic Frequency
Intel® Dynamic Video Memory 
Technology Supporting Shared Memory 
up to 1.7GB
Microsoft DirectX® 11.1 compatible

Storage

For Model A - Design I & Design III:
Two Changeable 2.5" 7mm (h) Hard Disk 
Drives (HDD) / Solid State Drives (SSD) 
with SATA Interface (RAID 0/1)
OR
One Changeable 2.5" 9.5mm/7mm (h) 
Hard Disk Drive (HDD) / Solid State Drive 
(SSD) with SATA Interface

For Model A - Design II:
Two Changeable 2.5" Hard Disk Drives 
(HDD) / Solid State Drives (SSD) with 
SATA Interface (RAID 0/1)
- 1st Drive 7mm (h)
- 2nd Drive 7mm (h)/ 9.5mm(h)

For Model A - Designs IV & V:
One Changeable 2.5" 9.5mm/7mm (h) 
Hard Disk Drive (HDD) / Solid State Drive 
(SSD) with SATA Interface

For All Model A Computers:
Two M.2 2280 SSDs with SATA (Serial) 
Interface (RAID 0/1) (Factory Option)
OR
One M.2 2280 SSD with PCIe Gen2 x2/
x4 Interface (Factory Option)

For Model B Computers:
Two Changeable 2.5" Hard Disk Drives 
(HDD) / Solid State Drives (SSD) with 
SATA Interface (RAID 0/1)
- 1st Drive 7mm (h)
- 2nd Drive 7mm (h)/ 9.5mm(h)

Two M.2 2280 SSDs with SATA (Serial) 
Interface (RAID 0/1) (Factory Option)

Audio

High Definition Audio
S/PDIF Digital Output
Built-In Array Microphone
2 Built-In 2W Speakers
Sound Blaster® X-Fi® MB3
External 51CH Audio output supported by 
headphone, microphone & S/PDIF Jacks
ANSP™ 3D Sound Technology on 
Headphone Output

For Model B Computers:
One Built-In Subwoofer Speaker
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Keyboard & Pointing Device

Full Size Winkey Illuminated White-LED 
Keyboard with Numeric Keypad

Built-In TouchPad (with Multi Gesture & 
Scrolling Functionality)

W/A/S/D Game Key Markings

Indicators

LED Indicators - Power/Suspend, Battery, 
HDD, Airplane Mode, GPU Mode, Num 
Lock, Caps Lock, Scroll Lock, Camera

Interface

Three USB 3.0 Ports (Including one 
powered USB3.0 AC/DC port) 
One eSATA Port (SATA USB 3.0 Combo)
Two Mini Display Ports 1.2
One HDMI™ (High-Definition Multimedia 
Interface) Out Port (with HDCP)
One Microphone-In Jack
One Headphone/Speaker-Out Jack
One S/PDIF Out Jack
One RJ-45 LAN Jack
One DC-In Jack

Card Reader

Embedded Multi-In-1 Push-Push Card 
Reader 
- MMC / RSMMC
- SD / Mini SD / SDHC / SDXC
Card Reader Note: Some of the cards 
require PC adapters that are usually 
supplied with the cards.

Slots

Three M.2 Slots:
=======================================
Slot 1: for M.2 2230 WLAN Combo Module 
Card with PCIe & USB Interfaces

Slot 2: for M.2 2280 SSD Card with SATA 
/ PCIe Gen2 x2/x4 Interface 

Slot 3: for M.2 2280 SSD Card with SATA 
Interface
OR
For Model A Computers Only:
LTE/HSPA+ M.2 3042 3G or 4G Module 
Card with USB Interface

Communication

Built-In 10/100/1000Mb Base-TX Ethernet 
LAN

2.0M FHD PC Video Camera Module

Intel® Dual Band Wireless-AC 7265 (2*2
802.11 a/c) M.2 WLAN + Bluetooth Combo
M.2 2230 Module (Factory Option)

Intel® Dual Band Wireless-N 7265 (2*2
802.11 b/g/n) M.2 WLAN + Bluetooth Com-
bo M.2 2230 Module (Factory Option)

Intel® Dual Band Wireless-AC 3160 (1*1
802.11 a/c) M.2 WLAN + Bluetooth Combo
M.2 2230 Module (Factory Option)

3rd Party Combo WLAN (802.11b/g/n) 
and Bluetooth v4.0+LE Combo M.2 2230 
Module (Factory Option)

Qualcomm® Atheros Killer™ Wireless-
AC 1525 Dual Band (2*2 802.11 a/c) 
WLAN + Bluetooth Combo M.2 1630 
Module (Factory Option)

For Model A Computers Only:
3G UTMS/HSPA+ M.2 3042 Card Module 
(Factory Option)
OR
4G LTE M.2 3042 Card Module (Factory 
Option)
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Operating System

Windows® 8.1 (64-bit)
Windows® 10 (64-bit)

BIOS

One 48Mb SPI Flash ROM 
AMI BIOS

Features

Al-Alloy Plate 
Intel® Rapid Start Technology
Intel® Smart Response Technology
Shipping Mode

Security

Security (Kensington® Type) Lock Slot
BIOS Password
Fingerprint Reader Module (Factory Option)
Trusted Platform Module 2.0

Power Management

Supports Wake on LAN
Supports Wake on USB
Supports Wake on RTC Alarm

Power

Embedded 4 Cell Polymer Battery Pack 
60WH

For Model A Design II & Model B 
Designs I & II:

Full Range AC/DC Adapter – AC in 100 - 
240V, 50 - 60Hz DC Output 19.5V, 9.23A 
or 19V, 9.5A (180 Watts)

For Model A - Designs I & V:
Full Range AC/DC Adapter – AC in 100 - 
240V, 50 - 60Hz DC Output 19.5V, 9.23A 
or 19V, 9.5A (180 Watts)
OR
Full Range AC/DC Adapter - AC in 100 -
240V, 50 - 60Hz DC Output 19.5V, 7.7A
(150 Watts)

For Model A Designs III & IV and 
Model B - Design III:
Full Range AC/DC Adapter - AC in 100 -
240V, 50 - 60Hz DC Output 19.5V, 7.7A
(150 Watts)

*A barebone system does not include the HDD, 
RAM, adapter, power cord and factory option 
modules (weight tolerance within +/- 5%).

Environmental Spec

Temperature
Operating: 5°C - 35°C
Non-Operating: -20°C - 60°C
Relative Humidity
Operating: 20% - 80%
Non-Operating: 10% - 90%

Physical Dimensions & Weight

For Model A - Designs I, III:
385mm(w) * 271mm(d) * 25mm(h)
2.5kg *Barebone System with 60WH 
Battery

For Model A - Designs IV & V:
385mm(w) * 271mm(d) * 26.9mm(h)
2.5kg *Barebone System with 60WH 
Battery

For Model A - Design II:
385mm(w) * 271mm(d) * 28.8mm(h)
2.5kg *Barebone System with 60WH 
Battery

For All Model B Designs:
417mm(w) * 287mm(d) * 29.98mm(h)
3.2kg *Barebone System with 60WH 
Battery
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Appendix E: Windows 10

Overview
This Appendix contains information (including control panel information, driver installation etc.) for users of
the Windows 10 OS.

You can refer to the main manual for details of audio & video information, BIOS, modules etc. However drivers
information specific to Windows 10 will be included in this Appendix, as well as details on how to navigate the
Windows 10 user interface to access the applications, control panels, taskbar etc. Note that Windows 10 will be
subject to constant updates and revisions, and some of the screens pictured throughout this chapter may change
over the course of time and appear differently from those illustrated.


Windows 10 OS

In order to run Windows 10 (64 bit) your computer requires a minimum 2GB of system memory (RAM).
Overview E - 1
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Windows 10 Start Menu
Most of the apps, control panels, utilities and programs within Windows 10 can be accessed from the Start
Menu by clicking the icon  in the taskbar in the lower left corner of the screen (or by pressing the Windows
Logo Key  on the keyboard).

Figure E - 1 - Windows Start Menu

Desktop
E - 2 Windows 10 Start Menu
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Right-Clicking the Windows Logo In Start Menu
Right-click the Start Menu  icon (or use the Windows Logo Key  + X key combination) to bring up an
advanced Context Menu of useful features such as Control Panel, Programs and Features, Power Options, Task
Manager, Search, File Explorer, Command Prompt, Device Manager and Network Connections etc.

Figure E - 2 - Right-Click Windows Logo in Start Menu

Right-Click Icon
Windows 10 Start Menu E - 3
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Start Menu Apps & Tiles
The Windows 10 Start Menu will contain a number of apps, and many more will be installed as you add more
applications etc. Not all of these apps can fit on the screen so may need click and drag the handles at the edge of
the screen to expand the menu in order to view all the apps (you can use the scroll bar to move up and down the
screen).

Figure E - 3 - Expanding the Start Menu
E - 4 Windows 10 Start Menu
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Pining/Unpinning Apps & Programs to/from the Start Menu
To make things easy to find you can add and remove tiles for apps and programs to the Start Menu. Right-Click
on a program’s icon and select Pin to Start from the drop-down menu. To remove an app or program from the
Start Menu right-click the icon and select Unpin from Start. You can use the same method to pin apps/pro-
grams to/from the taskbar (select pin to taskbar/unpin this program from the taskbar). 

Figure E - 4 - Pin to Start/Unpin from Start
Windows 10 Start Menu E - 5
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Windows 10 Control Panel
In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel can be accessed in a number of ways in Windows 10.

Figure E - 5 - Windows 10 Control Panel Access

• Right-click the Start Menu icon 
 in the taskbar in the lower left 

corner of the screen and select 
Control Panel from the menu. 

• Press the Windows logo key  
on your keyboard and X to bring 
up the context menu, and then 
press P to bring up the Control 
Panel.

• Type Control Panel into the 
Search box in the taskbar and 
click on the icon when it pops up.
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Settings
The Settings item in the Start Menu (and also as an App) gives you quick access to a number of system settings
control panels allowing you to adjust settings for System, Devices, Network & internet, Personalization, Ac-
counts, Time & language, Ease of Access, Privacy and Update & security.

Figure E - 6 - Settings
Windows 10 Control Panel E - 7
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Windows 10 Taskbar
In many instances throughout this manual you will see an instruction to access the notification area of the task-
bar. The notification area of the taskbar in the bottom right of the screen. Some of the Control Panels and appli-
cations referred to throughout the course of this manual can be accessed from here.

Figure E - 7 - Taskbar

You can pin/unpin apps to/from the taskbar in much the same way as you can to the Start screen (see “Pining/
Unpinning Apps & Programs to/from the Start Menu” on page E - 5).

Taskbar

Taskbar - Pinned Programs and Apps Notification Area
E - 8 Windows 10 Control Panel
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Video Features
You can switch display devices, and configure display options, from the Display control panel (in Appearance
and Personalization). Click Adjust resolution to make changes to the appearance of the display and to detect
and configure any attached displays. In Windows 10 it is possible to quickly configure external displays from
the Project menu (press the Windows logo key  on your keyboard and the P key).

To Configure Displays using Project

Figure E - 8 - Project

1. Attach your display to the appropriate 
port, and turn it on.

2. Press the  + P key combination.
3. Click on any one of the options from

the menu to select PC screen only,
Duplicate, Extend or Second
screen only.

4. You can also click Connect to a
wireless display at the bottom of the
Project screen and follow the steps
to connect to any wireless enabled
display.
Video Features E - 9
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To access Display (Control Panel) and Screen Resolution in Windows:
1. Go to the Control Panel.
2. Click Display (icon) - In the Appearance and Personalization category.
3. Make and changes required from the Display, Resolution, Orientation or Multiple display menus.
4. Click Apply to save the settings.

Figure E - 9 - Screen Resolution

2

1


Screen Resolution

1. Use the dropbox to select 
the screen Resolution  
(Figure E - 9).

2. Click Advanced settings 
 (Figure E - 9) to bring up 

the Advanced properties 
tabs.

3. Click Apply to save any 
changes made.

1

2
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Display Settings:
1. You can quickly adjust the display by right-clicking the desktop and selecting Display Settings .
2. Adjust the settings using the sliders in the menu or click Advanced display settings  to change resolution.
3. Click Apply to save any changes made to resolution.

Figure E - 10 - Display Settings

1
2

2

1
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Power Options
Power Options (Hardware and Sound) can be accessed from the Control Panel. The Power button item in
Start Menu (or the context menu) may be used to Shut down or Restart (you can also add Hibernate/Sleep to
the menu - see page E - 13). To fully control all the power options (including Hibernate mode) go to the Power
Options control panel and configure the power button, sleep button and lid to perform the function selected.

Figure E - 11 - Shut Down/Restart 

Using the Power Button
1. Go to the Start Menu.
2. Click the Power button .
3. Select the power state required

from the menu.
E - 12 Power Options
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You can also use the context menu (right-click the Start Menu  icon or press the Windows logo  + X key
combination) to Sign out, Sleep, Hibernate, Shut down, and Restart.

Figure E - 12 - Context Menu Shut Down or sign out

Ctrl + Alt + Delete Key Combination
You can use the CTRL + ALT + DEL key combination to bring up a full-screen displaying Lock, Sign out,
Change a password, Task Manager and Switch User. If you click the Power icon in the lower right corner of
the screen a power management option menu appears to display Sleep, Hibernate, Shut down, and Restart.


Adding Hibernate/Sleep to the Power Men

1. Go to the Power Options (Hardware and Sound) 
control panel.

2. Click Choose what the power buttons do.
3. Click “Change settings that are currently 

unavailable” .
4. Click to put a check in the Hibernate/Sleep box 

under Shutdown settings.
5. Click Save Changes and close the control panel.
Power Options E - 13
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Minimum Screen Resolution Settings
1. Windows 10 has minimum screen resolution requirements.
2. Right-click a blank area of the Desktop and select Screen Resolution (or go to the Display control panel).
3. Adjust the Resolution to make sure that it is at least 1024 * 768, although preferably 1366 * 768 or above.

Figure E - 13 - Screen Resolution
E - 14 Power Options
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Windows 10 Drivers & Utilities
Make sure you install all the drivers and utilities for your Windows 10 system as outlined in the following pages.

Driver Installation (Windows 10)
1. Insert the Device Drivers & Utilities + User’s Manual disc into the computer’s DVD drive, or an attached DVD 

drive if applicable.
2. Click the message “Tap to choose what happens with this disc.”
3. Click Run autorun.exe.
4. Click Install Drivers (button), or Option Drivers (button) to access the Optional driver menu.
5. Check the driver installation order from Table E - 1, on page E - 16 (the drivers must be installed in this 

order) which is the same as that listed in the Drivers Installer menu below.
6. Click to select the driver you wish to install, (you should note down the drivers as you install them).
7. Follow the instructions for each individual driver installation procedure as listed on the appropriate pages.


Driver Installation

If you miss the message above you can eject the De-
vice Drivers & Utilities + User’s Manual disc and then
reinsert it.

Alternatively double-click the disc icon in Comput-
er (use the Windows logo key  + E key combina-
tion to go to Computer in Windows Explorer).
Windows 10 Drivers & Utilities E - 15
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Table E - 1 - Driver Installation

Windows 10 Drivers

 Chipset Page E - 17  Wireless LAN Module Page E - 20

 Video (VGA) Page E - 17  Bluetooth & WLAN Combo Module Page E - 23

 NVIDIA Video (VGA) Page E - 17  Intel® Rapid Storage Technology Page E - 26

 LAN Page E - 17  Sound Blaster Audio Page E - 27

 Card Reader Page E - 17  Fingerprint Reader Module Page E - 28

 Touchpad Page E - 18  PC Camera (No driver required) Page E - 30

 Control Center Page E - 18  Trusted Platform Module (No driver required) Page E - 31

 Airplane Page E - 18  3G/4G Module (No driver required) Page E - 32

 MEI Driver Page E - 18

 Audio Page E - 18
E - 16 Windows 10 Drivers & Utilities
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Driver Installation Procedure
Insert the Device Drivers & Utilities + User’s Manual
disc and click Install Drivers (button).

Chipset
1. Click 1.Install Chipset Driver > Yes.
2. Click Next > Accept > Install.
3. Click Finish.

Video (VGA)
1. Click 2.Install VGA Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

NVIDIA Video (VGA)
1. Click 3.Install NVIDIA VGA Driver > Yes.
2. Click AGREE AND CONTINUE (button) to 

accept the terms of the license agreement.
3. Click Next.
4. Click the Close to complete the installation.

Note: After installing the video driver go to the Dis-
play/Display Settings control panel to adjust the vid-
eo settings to the highest resolution.

LAN
Note: If the computer enters a deep sleep mode during
installation, you will be prompted to plug in a network
cable, and click OK, to continue installation. If a net-
work cable is not available, restart the system and re-
install the LAN driver.

1. Click 4.Install LAN Driver > Yes.
2. Click Next > Install.
3. Click Finish.

Card Reader
1. Click 5.Install Cardreader Driver > Yes.
2. Click Finish.
Windows 10 Drivers & Utilities E - 17
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Touchpad
1. Click 6.Install Touchpad Driver > Yes.
2. Click Next.
3. Click the button to accept the license agreement 

and click Next.
4. Click Finish > Restart Now to restart the com-

puter.

Control Center
1. Click 7.Install Control Center AP > Yes.
2. Click Next.
3. Click Finish to restart your computer.
4. After restart a control panel will pop-up to allow 

you to select the type of keyboard for your system 
(see “Flexikey® Application” on page 1 - 14 
and Appendix B).

Airplane
Note: Do not use Update Driver in Device Manager to
install the Airplane mode driver.

1. Click 8.Install Airplane Driver > Yes. 

2. Click Next > Install.
3. Click Finish to restart the computer.

MEI Driver
1. Click 9.Install MEI Driver > Yes.
2. Click Next.
3. Click the check box to accept the license and 

then click Next.
4. Click Next.
5. Click Finish.

Audio
1. Click 10. Install Audio Driver > Yes.
2. Click Next > Next.
3. Click Finish to restart the computer.

Note that after installing the audio driver the system
will not return to the Drivers Installer screen. To in-
stall any of the optional drivers listed overleaf, eject
the Device Drivers & Utilities + User’s Manual disc
and then reinsert it (or double-click the disc icon in My
Computer), and click Option Drivers (button) to ac-
cess the optional driver menu.
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Optional Drivers
See the following pages for the driver installation procedures for any modules included in your purchase option.

Note that you need to install both the WLAN & Bluetooth drivers for the WLAN & Bluetooth Combo modules.
Windows 10 Drivers & Utilities E - 19
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Wireless LAN Module
If you have included an Intel® or 3rd Party WLAN module in your purchase option make sure that the module
is on (i.e. the system is not in Airplane Mode) before installing the driver. Make sure you install the drivers in
the order indicated in Table E - 1, on page E - 16.

Note that you need to install both the WLAN & Bluetooth drivers for the WLAN & Bluetooth Combo modules.


Wireless Device 

Operation Aboard Aircraft

The use of any portable electronic
transmission devices aboard aircraft is
usually prohibited. 

Make sure the module is either OFF or
in Airplane mode if you are using the
computer aboard aircraft.
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3rd Party WLAN Driver Installation
1. Make sure the system is not in Airplane Mode, and then insert the Device Drivers & Utilities + 

User’s Manual disc into the DVD drive. 
2. Click Option Drivers (button).
3. Click 1.Install WLAN Driver > Yes.
4. Click Next.
5. Click Finish to restart the computer.
6. The operating system is the default setting for Wireless LAN control in Windows 10.
7. Click the Wireless icon  in the notification area of the taskbar and double-click an access point to 

connect to it (or click it and click Connect).

Intel® WLAN Driver Installation
1. Make sure the system is not in Airplane Mode, and then insert the Device Drivers & Utilities + 

User’s Manual disc into the DVD drive. 
2. Click Option Drivers (button).
3. Click 1.Install WLAN Driver > Yes.
4. Click in the check box to agree to the End User License Agreement and click Install.
5. Click Finish (click Yes if required to restart).
6. The operating system is the default setting for Wireless LAN control in Windows 10.
7. Click the Wireless icon  in the notification area of the taskbar and double-click an access point to 

connect to it (or click it and click Connect).
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Qualcomm Atheros WLAN Combo Driver Installation
1. Make sure the system is not in Airplane Mode, and then insert the Device Drivers & Utilities + 

User’s Manual disc into the DVD drive. 
2. Click Option Drivers (button).
3. Click 1.Install WLAN Driver > Yes.
4. Select the language preferred and click Next.
5. Click Next > Next.
6. Click in the check box to accept to the License Agreement and click Next.
7. Click Finish.
8. Click Yes to restart the computer.
9. The operating system is the default setting for Wireless LAN control in Windows 10.
10. Click the Wireless icon  in the notification area of the taskbar and double-click an access point to 

connect to it (or click it and click Connect).
E - 22 Wireless LAN Module
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Bluetooth & WLAN Combo Module
If your purchase option includes the Combination Wireless LAN & Bluetooth module (either Intel® or 3rd
Party) then install the driver as instructed overleaf (two drivers are provided for the 3rd party WLAN module and
one for the Intel WLAN module). Make sure you install the drivers in the order indicated in Table E - 1, on
page E - 16.

Make sure that the module is on (i.e. the system is not in Airplane Mode) before installing the driver.


Bluetooth Data Transfer

Note that the transfer of data between the computer and a Bluetooth enabled device is supported
in one direction only (simultaneous data transfer is not supported). Therefore if you are copying
a file from your computer to a Bluetooth enabled device, you will not be able to copy a file from
the Bluetooth enabled device to your computer until the file transfer process from the computer
has been completed.


Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices aboard aircraft is usually prohibit-
ed. Make sure the module is either OFF or in Airplane mode if you are using the computer
aboard aircraft.
Bluetooth & WLAN Combo Module E - 23
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3rd Party Bluetooth Combo Driver Installation
1. Make sure the system is not in Airplane Mode, and then insert the Device Drivers & Utilities + 

User’s Manual disc into the DVD drive. 
2. Click Option Drivers (button).
3. Click 2.Install Combo BT Driver > Yes.
4. Click Next.
5. Click Finish to restart the computer.
6. See “Bluetooth Configuration” on page E - 25 for instructions on configuring Bluetooth connections.

Intel Bluetooth Combo Driver Installation
1. Make sure the system is not in Airplane Mode, and then insert the Device Drivers & Utilities + 

User’s Manual disc into the DVD drive. 
2. Click Option Drivers (button).
3. Click 2.Install Combo BT Driver > Yes.
4. Click Next.
5. Click in the check box to accept the license and click Next.
6. Select the setup type (Typical is recommended) and click Install.
7. Click Finish.
8. See “Bluetooth Configuration” on page E - 25 for instructions on configuring Bluetooth connections.
E - 24 Bluetooth & WLAN Combo Module
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Qualcomm Atheros Bluetooth Combo Driver Installation
1. Make sure the system is not in Airplane Mode, and then insert the Device Drivers & Utilities + 

User’s Manual disc into the DVD drive. 
2. Click Option Drivers (button).
3. Click 2.Install Combo BT Driver > Yes.
4. Click Next > Next.
5. Click Install.
6. Click Finish.
7. Click Yes to restart the computer.
8. See below for instructions on configuring Bluetooth connections.

Bluetooth Configuration
1. Click the Settings item in the Start Menu and then click Devices.
2. Click Bluetooth and make sure Bluetooth is On and a list of discovered devices will appear.
3. Double-click the device you want to pair with the computer and click Pair.
4. On first connection the computer will provide you with a pairing code to be entered onto the device.
5. Enter the code into your Bluetooth enabled device and click Yes on the computer to complete the pairing.
6. Select a device and click Remove Device to disconnect from any device.
7. Click More Bluetooth Options, and make sure that Allow Bluetooth devices to find this computer check 

box (Discovery) has a check inside it.
8. Make sure that the Alert me when a new Bluetooth device wants to connect check box (Connections) has 

a check inside it, if you want to be notified when a Bluetooth device wants to connect.
Bluetooth & WLAN Combo Module E - 25
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Intel® Rapid Storage Technology
Install the Intel® Rapid Storage Technology to support your AHCI mode SATA drive.

IRST Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into an attached DVD drive.
2. Click Option Drivers (button).
3. Click 3.Install IRST Driver > Yes.
4. Click Next.
5. Click the check box to accept the license and click Next.
6. Click Next > Next > Next.
7. Click Finish to restart the computer.
8. Run the Intel® Rapid Storage Technology app from the All Apps screen (in the Start Menu).

See also “Intel® Rapid Storage Technology for RAID Systems” on page 6 - 33 for more information if you
have set your hard disks up in a RAID configuration, and also “Intel® Smart Response Technology” on page 6
- 38.


IRST and M.2 PCI-e SSDs

Note that Intel® Rapid Storage Technology does not support M.2 SSDs with a PCI-e In-
terface (M.2 SSDs with a SATA Interface are supported).
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Sound Blaster Audio
Install the Sound Blaster AP to allow you to configure the audio settings to your requirements for the best per-
formance in games, music and movies.

Sound Blaster X-Fi MB-3 Audio AP Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc an attached DVD drive.
2. Click Option Drivers (button).
3. Click 4.Install SBX-Fi MB 3 AP > Yes.
4. Click Next > Yes to accept the license.
5. Click Next > Full Installation (button).
6. Click Next > Finish to restart the computer.
7. Access the Sound Blaster X-Fi MB3 control panel from the Creative item in All Apps (in the Start 

Menu).
8. See “Sound Blaster Audio” on page 6 - 50 for further information
Sound Blaster Audio E - 27
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Fingerprint Reader Module
The fingerprint reader module provides a high level of security for your computer. Make sure you have admin-
istrator’s rights to your computer, and have a Windows password enabled for full security protection.

The fingerprint reader module uses the Sign-in options configuration of the Windows Account.

Fingerprint Reader Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/DVD drive. 
2. Click Option Drivers.
3. Click 5.Install Fingerprint Driver > Yes.
4. Click Next > Install.
5. Click Finish to restart the computer.
6. The fingerprint reader module uses the Sign-in options configuration of the Windows Account (see 

overleaf).


Fingerprint Reader and Power Saving States

If your computer is in a power saving state (e.g. Hibernate or Sleep) you should keep your finger clear of the fingerprint
sensor.

Allow the system to fully resume before swiping your finger across the sensor.
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Fingerprint Module Configuration
1. Click the Settings item in the Start Menu and then click Accounts and click Sign-in options.
2. You will need to add a Windows password (click Add under Password).
3. After you have added the password you will need to also add a PIN.
4. Under Windows Hello click Set up under Fingerprint.
5. The wizard will then guide you through the set up process to scan your fingerprints.
6. You will be instructed to swipe the same finger across the reader a number of times.
7. Click Close when complete.
8. You can choose to Add another finger (this is recommended) or Remove the current fingerprint reading.
9. You can now scan your fingerprint to log-on to the computer.

Figure E - 14 - Accounts - Sign-in options (Add Fingerprint)
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PC Camera
Use the Fn + F10 key combination or Control Center button to toggle power to the PC Camera module. When
the PC Camera is in use the LED indicator to the left of the camera will be illuminated in red.

Note that you need to use the Camera app  in Windows to take pictures and capture video.

1. Make sure the PC Camera is turned on by using the Fn + F10 key combination (or Control Center button).
2. Run the Camera app from the Start menu by clicking on the Camera app icon  (you can type “camera” into 

the search box to find the Camera app if it is not pinned to the Start menu).
3. Click to select either photo  or video  modes.
4. Click the photo icon to take a picture, and the camera icon will briefly turn yellow as the picture is taken.
5. Click on the video icon  to start video capture (if video capture begins a timer will appear at the bottom of the 

screen and the icon will turn yellow).
6. To stop video capture click the video icon again.
7. Captured photos and videos will be saved to a Camera Roll folder within the Pictures/Videos folder in This 

PC, and to the Photos app stored in the Start menu (type Photos into the search box if you cannot find the 
app). 
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Trusted Platform Module
(Optional)
The TPM security chip allows you to create and manage digital certificates for user and platform authentica-
tion. This type of security is usually administered within large enterprises and organizations, and therefore re-
quires implementation by a system administrator before users can access security features. 

Make sure you have administrator’s rights to your computer, and have a Windows password enabled for full se-
curity protection. In addition Make sure you prepare a removable media (e.g. a USB flash drive) to store
passwords etc. before beginning the TPM initialization process.

Before setting up the TPM functions you must enable and initialize the security platform (see “Enabling &
Managing TPM” on page 6 - 65).

TPM Management in Windows
1. Go to the Control Panel.
2. Click BitLocker Drive Encryption (System and Security).
3. Click TPM Administration.
4. The TPM Management window allows you to configure the TPM within Windows. As TPM is usually 

administered within large enterprises and organizations, your system administrator will need to assist you in 
managing the information here.

5. Click Prepare the TPM and follow the instructions in the Wizard to prepare the TPM (this will probably require a 
restart of the computer and confirmation of the setting changes after restart by pressing the appropriate F key).

6. After the restart the TPM will be prepared and you can then use the Actions menu to Turn TPM off, Change 
Owner Password, Clear TPM or Reset TPM Lockout.

7. A wizard will help take you through any setup steps.
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3G/4G Module
(For Model A Computers Only)
If you have included an optional UMTS/HSPA+ based 3G Module (Universal Mobile Telecommunications
System or High Speed Packet Access) module or LTE (Long Term Evolution) 4G module (see “Communica-
tion” on page D - 4 for specification details) in your purchase option, you do not require a driver/application
installation for Windows 10. See “3G/4G Module USIM Card Installation” on page 6 - 71 for instructions on
installing the USIM card (which will be provided by your service provider). See overleaf for connection infor-
mation.


Important Notice

If your purchase option includes both Wireless LAN and 3G/4G modules, then the appropriate antennas will be installed. Note
that In order to comply with FCC RF exposure compliance requirements, the antenna must not be co-located or operate in
conjunction with any other antenna or transmitter.

Important Notice - 3G/4G & Bluetooth/Wireless LAN Modules

In order to comply with FCC regulations you should NOT operate the 3G/4G module and the Bluetooth/Wireless LAN mod-
ules at the same time as this may disrupt radio frequency, and cause interference. When the 3G/4G module is powered on,
make sure that the Bluetooth/Wireless LAN modules are powered off.
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3G/4G Configuration in Windows 10
You can configure a 3G/4G connection as below, however make sure the system is not in Airplane Mode before
configuration begins.

1. Click the Settings item in the Start Menu and then click Network and Internet.
2. Click Cellular a list of available access points will appear.
3. Click the access point and click Connect.
4. The system will connect to your network.
5. Connected will appear under the connection.
6. You can then access the internet, download e-mail etc. as per any internet connection.
7. To disconnect you can select the connection and click Disconnect.
8. You need to use Airplane Mode aboard aircraft.
9.  You can also click the Wireless icon  in the notification area of the taskbar, click Cellular and double-click an 

access point connect to access the connection information.
3G/4G Module E - 33



Windows 10

W
in

d
o

w
s 10
E- 34


	Manual
	Preface
	Chapter 1: Quick Start Guide
	Overview
	Advanced Users
	Beginners and Not-So-Advanced Users
	Warning Boxes
	Not Included
	System Software
	System Startup
	Model Differences
	LCD Panel Open - Model A
	LCD Panel Open - Model A - Designs IV & V
	LCD Panel Open - Model B
	LED Indicators
	Illuminated LED Keyboard
	Control Center
	Flexikey® Application
	Flexikey® Application Features:
	Keyboard Shortcuts
	Function Keys & Visual Indicators
	Front & Rear Views - Model A
	Front & Rear Views - Model B
	Right View - Model A
	Right View - Model B
	Left View - Model A
	Left View - Model B
	Bottom View - Model A - Design I
	Bottom View - Model A - Design II & Design III
	Bottom View - Model A - Design IV & Design V
	Bottom View - Model B
	Windows 8.1 Control Panel
	Windows 8.1 Start Screen & Desktop
	Apps & Tiles
	Desktop Application
	The Charms Bar
	Windows 8.1 Taskbar
	Video Features
	Microsoft Hybrid Graphics
	Configuring External Displays
	Power Options
	Running Apps

	Chapter 2: Storage Devices, Mouse, & Audio
	Overview
	Hard Disk Drive/Solid State Drive
	Multi-in-1 Card Reader
	Audio Features
	Setup for Audio Recording
	Setup for 5.1Surround Sound
	Touchpad and Buttons/Mouse
	Touchpad Configuration
	Gestures and Device Settings

	Chapter 3: Power Management
	Overview
	The Power Sources
	AC/DC Adapter
	Battery
	Turning On the Computer
	Shutting the Computer Down
	Power Plans
	Power-Saving States
	Sleep
	Hibernate
	Shut down
	Configuring the Power Buttons
	Resuming Operation
	Power Conservation Modes
	Battery Information
	Battery Power
	Conserving Battery Power
	Battery Life
	New Battery
	Recharging the Battery with the AC/DC Adapter
	Proper handling of the Battery Pack
	Battery FAQ

	Chapter 4: Drivers & Utilities
	What to Install
	Module Driver Installation
	Driver Installation
	Updating/Reinstalling Individual Drivers
	User Account Control
	Windows Security Message
	New Hardware Found
	Driver Installation Procedure
	Chipset
	Video (VGA)
	NVIDIA Video (VGA)
	LAN
	Card Reader
	Touchpad
	Hot Key
	Airplane
	MEI Driver
	Audio
	Optional Drivers

	Chapter 5: BIOS Utilities
	Overview
	The Power-On Self Test (POST)
	Failing the POST
	Fatal Errors
	Non-Fatal Errors
	The Setup Utility
	Entering Setup
	Setup Screens
	Main Menu
	System Time & Date (Main Menu)
	SATA Port # (Main Menu)
	OffBoard SATA Controller Configuration (Main Menu)
	System/Extended Memory (Main Menu)
	MB Series / BIOS Revision / KBC/EC firmware Revision/Mac Address (Main Menu)
	Advanced Menu
	Advanced Chipset Control (Advanced Menu)
	Combo Slot (Advanced Menu > Advanced Chipset Control)
	Intel(R) Rapid Start Technology (Advanced Menu)
	Intel(R) Rapid Storage Technology (Advanced Menu)
	SATA Mode (Advanced Menu)
	Boot Logo (Advanced Menu)
	Power On Boot Beep (Advanced Menu)
	Battery Low Alarm Beep (Advanced Menu)
	Security Menu
	Set Supervisor Password (Security Menu)
	Set User Password (Security Menu)
	Password on boot: (Security Menu)
	Secure Boot Control (Security Menu)
	TPM Configuration (Security Menu)
	Boot Menu
	Boot Option Priorities (Boot Menu)
	UEFI Boot (Boot Menu)
	Exit Menu

	Chapter 6: Modules
	Overview
	Setting Up SATA RAID or AHCI Mode
	AHCI Mode
	RAID
	Intel® Rapid Storage Technology Application
	SATA RAID Setup Procedure (Windows 8.1)
	IRST Driver Installation
	Deleting a RAID (Windows 8.1)
	PC Camera Module
	PC Camera Audio Setup
	Camera App
	Camera Options
	Taking Pictures/Capturing Video
	Camera Roll
	Wireless LAN Module
	3rd Party 802.11b/g/n Driver Installation
	Intel® WLAN Driver Installation
	Qualcomm Atheros WLAN Combo Driver Installation
	WLAN Configuration in Windows
	Bluetooth & WLAN Combo Module
	3rd Party Bluetooth (V4.0) Combo Driver Installation
	Intel Bluetooth Combo Driver Installation
	Qualcomm Atheros Bluetooth Combo Driver Installation
	Bluetooth Configuration in Windows
	Intel® Rapid Storage Technology
	IRST Driver Installation
	Intel® Rapid Storage Technology for RAID Systems
	RAID Volume Data Verification and Repair
	Replacing and Reverting Recovery and Master Volumes
	Intel® Smart Response Technology
	Enabling Intel Smart Response Technology
	Intel® Rapid Start Technology Driver
	Intel® Rapid Start Technology Configuration
	Intel® Rapid Start Technology Driver Installation
	Sound Blaster Audio
	Sound Blaster X-Fi MB-3 Audio AP Installation
	Fingerprint Reader Module
	Fingerprint Reader Driver Installation
	Fingerprint Module Configuration
	Trusted Platform Module
	Enabling & Managing TPM
	TPM Management in Windows
	TPM Actions
	3G/4G Module
	3G/4G Configuration in Windows
	Wireless Display
	Wireless Display Configuration

	Chapter 7: Troubleshooting
	Overview
	Basic Hints and Tips
	Backup and General Maintenance
	Viruses
	Upgrading and Adding New Hardware/Software
	Problems and Possible Solutions

	Appendix A: Interface (Ports & Jacks)
	Overview
	Ports and Jacks

	Appendix B: Control Center & Flexikey®
	Overview
	Flexikey® Application
	Profiles
	Flexikey® Application Features
	Keyboard and Mouse Settings
	Enabling or Disabling Flexikey®
	Keyboard Settings
	Mouse Settings
	Keyboard Settings - Express Key
	Keyboard Settings - Launch App
	Keyboard Settings - Express Text
	Keyboard Settings - Disable
	Mouse Settings - Express Key
	Mouse Settings - Launch App
	Mouse Settings - Express Text
	Mouse Settings - Disable
	Statistics

	Appendix C: Video Driver Controls
	Overview
	Microsoft Hybrid Graphics
	Video Driver Installation
	Video (VGA)
	NVIDIA Video (VGA)
	Intel® Iris(TM) Graphics Control Panel
	Display Devices & Options
	Attaching Other Displays
	Attaching Other Displays - Devices (Charms Bar)
	Configuring an External Display In Windows
	HDMI Audio Configuration
	NVIDIA Control Panel
	Customization Options
	Set PhysX® Configuration

	Appendix D: Specifications
	Processor
	Core Logic
	Display
	Memory
	Video Adapter Options
	Storage
	Audio
	Keyboard & Pointing Device
	Indicators
	Interface
	Card Reader
	Slots
	Communication
	Operating System
	BIOS
	Features
	Security
	Power Management
	Power
	Environmental Spec
	Physical Dimensions & Weight

	Appendix E: Windows 10
	Overview
	Windows 10 Start Menu
	Right-Clicking the Windows Logo In Start Menu
	Start Menu Apps & Tiles
	Windows 10 Control Panel
	Settings
	Windows 10 Taskbar
	Video Features
	Power Options
	Windows 10 Drivers & Utilities
	Driver Installation (Windows 10)
	Driver Installation Procedure
	Chipset
	Video (VGA)
	NVIDIA Video (VGA)
	LAN
	Card Reader
	Touchpad
	Control Center
	Airplane
	MEI Driver
	Audio
	Optional Drivers
	Wireless LAN Module
	3rd Party WLAN Driver Installation
	Intel® WLAN Driver Installation
	Qualcomm Atheros WLAN Combo Driver Installation
	Bluetooth & WLAN Combo Module
	3rd Party Bluetooth Combo Driver Installation
	Intel Bluetooth Combo Driver Installation
	Qualcomm Atheros Bluetooth Combo Driver Installation
	Bluetooth Configuration
	Intel® Rapid Storage Technology
	IRST Driver Installation
	Sound Blaster Audio
	Sound Blaster X-Fi MB-3 Audio AP Installation
	Fingerprint Reader Module
	Fingerprint Reader Driver Installation
	Fingerprint Module Configuration
	PC Camera
	Trusted Platform Module
	TPM Management in Windows
	3G/4G Module
	3G/4G Configuration in Windows 10



